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1 GETTING STARTED

This topic provides information about the new features in this release as well as the
system requirements of VRED and information about the installation process.

1.1 What's New

» Data Input / Tesselation Industry-quality CAD import supporting:

» CATIA V4: *.model, *.mdl, *.session, *.exp, *.dlv, *.dIv3, *.dlv4

» CATIA V5: *.catpart, *.catproduct, *.cgr

» Autocad: *.dxf, *.dwg

» ProE/Granite: *.prt, *.asm, *.neu, *.g

» IGES: *.igs, *.iges

» STEP: *.stp, *.step

» Inventor: *.ip, *.iam

» Openlnventor: *.iv

» Studio: *.wire

» SolidWorks: *.sldprt, *.sldasm)

» NX: *.prt
» Spectral Rendering A novel and groundbreaking approach to physically-based
lighting simulation is introduced to version 2014 of VRED Professional. For Raytrac-
ing, the possibility to choose between classical rendering with tristimulus values (RGB)
and spectral rendering using radiometric quantities will be provided. For colorimetric
correctness, spectral rendering is absolutely mandatory since computing light reflec-
tions in RGB results in arbitrary color deviations for non-white light, whether direct
or indirect. The choice of mode affects the entire image generation chain: spectrally

distributed input data for light sources and materials, spectral global illumination sim-
ulation including fully spectral photon mapping, and dedicated tone reproduction to
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__ 1 GETTING STARTED

provide a reliable appearance on characterized display devices will be applied. To ben-
efit from the advantages of the innovative technique in the presence of legacy RGB
data (e.g. textures or environment maps), tristimuli are automatically converted on-
the-fly. The performance overhead for spectral rendering amounts to less than 50%
for representative exterior and interior benchmark scenes. The established color dia-
log has been extended by an intuitive spectral plot editor, providing both the artistic
freedom to define arbitrary spectral distributions to achieve creatively satisfying ren-
dering effects as well as the precision to manually fine-tune radiometrically measured
data for technical purposes.

» Rasterization Mode (CPU) VRED introduces an OpenGL like rendering mode which
has no limits in complexity and also allows to render NURBS; especially interesting
when using VRED in a cluster environment.

» Raytracing Performance Improvements Raytracing performance has been im-
proved by approximate 20%

» Raytracing Photon Mapper Automatic Photon Radius calculation

» Additional Renderpasses for offline rendering Additional passes allow even more
creative flexibility for composition

P

v
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1.1 What's New

» New Measured BRDF Material VRED Professional can now read and display the
BRDF information exported from Cl-Navigator, a software system by Office Color
Science (OCS) that calculates metallic and pearlescent paint formulations from mea-
surements of given target paint samples.

» Improved BRDF behaviour for many materials VRED 2014 supports an updated
behaviour of the BRDF model used in many of VREDs materials. This new model
improves the conservation of energy and respects the interaction between diffuse,
glossy and specular layers of a material to achieve an even more realistic rendering.

» Cluster Improvements Improved performance and stability during cluster render-
ing (cluster continues operation even if machines disconnect/crash) CPU usage statis-
tic for cluster machines.

» New Camera features New physical camera tonemapper supporting camera re-
sponse curves
New Vignetting feature

» New Light Portal Material The new light portal material allows the user to guide
photons to the those parts of a scene where they are needed.

» Conferencing Synchronize two or more instances of VRED to show the same
scene. Control of interaction can be transfer between participants. Synced virtual
mouse pointer. Communication is completely encrypted

» Usability

» Allow mathematical expressions for numerical input fields (supports mathemati-
cal operators +, -, *, /, e.g. 10*0.5 or 20+100, as well as +=, -=, *=, /=, e.g. +=50
to add 50 to the current value).

» Allow international characters in nearly all parts of the user interface.
» Multiple nodes can be transformed at once with the transform manipulator or
transform module GUI.

11



__ 1 GETTING STARTED

» Drag and drop of textures (image files from file browser) directly onto materials,
including environment materials, in the render window.

» Undo/Redo support for Animation Module

12



1.2 System Requirements

» Hardware Requirements

»

»

%

4

)

4

)

v

v

)

v

(64-bit) Intel® processor with Intel® EM64T-capable or
AMD® Athlon 64™, AMD Opteron® processor

1GB RAM

DVD drive or Internet connection

Ethernet card (required for licensing VRED uniquely to your machine)
Three-button mouse with mouse driver software

A qualified hardware-accelerated OpenGL® graphics card (overlay plane capa-
bility is recommended)

VRED takes about 580 MB for a full installation. This approximate disk space
requirement is based on the NTFS disk format. If you have a FAT disk format,
expect slightly larger file sizes.

» Software Requirements

)

v

)

v

)

v

)

v

v

)

v

Windows XP Professional 64Bit (SP1 or higher), Windows Vista 64Bit, Windows7
64Bit

TCP/IP network protocol software (for running VRED network rendering and
other features)

A graphics card driver. Driver software is available from the manufacturer’s web
site.

Appropriate driver software for optional hardware

Adobe® Acrobat® Reader is required to view the PDF documentation provided
on the VRED DVD or as online documentation. You can obtain Acrobat Reader
from www.adobe.com.

Mozilla Firefox, Apple Safari, Google Chrome and Internet Explorer 8 web browsers
have been qualified to view the VRED Help.

13



__ 1 GETTING STARTED

» Optional Hardware
» Space Mouse: Make sure you install the latest Space Mouse driver software.

14



1.3 Installation using Windows

. Download the latest version of VRED. Start the installation process by opening the
file provided. To start the file directly after downloading, select "Run”.
The VRED Installation Wizard appears. The Installation Wizard directs you through
the installation process. Click “Next” to proceed or cancel to stop the installation

process.

A Autodesk VREDPro 2014 Setup

Welcome.
Welcome to Autodesk VREDPro Setup.

2. The Autodesk Software License Agreement appears. This agreement requires your ac-
ceptance for the VRED software installation to continue. To continue, click "I Agree”.

15



1 GETTING STARTED

License
Pleass review the licenss tems before instaling Autodesk VREDPo. {\ AUTODESK.

Press Page Down to

Autodesk
LICENSE AND SERVICES AGREEMENT

READ CAREFULLY: AUTODESK LICENSES THE SOFTWARE AND OTHER
LICENSED WATERIALS ONLY ON THE CONDITION THAT LICENSEE
[ACCEPTS ALL OF THE TERMS CONTAINED OR REFERENCED IN THIS
AGREEMENT.

By selecting the I accept button or other button or mechanism designed to
acknowledge agreement to the terms of an electronic copy of this Agreement,
or by installing, downloading, accessing, or otherwise copying or using all or
any portion of the: Autodesk Materials, (i) you accept this Agreement on behalf
of the entity for which you are authorized to act e.g., an employer) and
acknowledge that such entiy is legally bound by tis Agreement (and you
agree to actin a manner consistent with this Agreement) o, ifthere is no such
entity for which you are authorized to act, you accept this Agreement on benalf

Choose License Type. {\ AUTODESK.

4. Specify the installation directory and proceed.

16



Choose.
Choose the folder in which to nstall Autodesk VREDPr.

6. Once the installation is done, click "Next” to proceed.

{\ AUTODESK.

{\ AUTODESK.

17



1 GETTING STARTED

Installation Complete
Alof of Autodesk {\ AUTODESK.

7. Select whether you want to place a shortcut to VRED on your desktop or not and
click “Close” to conclude the installation process.

- {\ AUTODESK.

Completing the Autodesk VREDPro Setup Wizard

18



1.4 Licensing using a network license

1. When VRED is starting for the first time, you are presented with the following screen.
Click on “Specify the License Server System” and proceed with “Next".

Your application was not able o obtain a license
because the FlexMet licensze server manager
could not determineg where ta find the licensing
data it needs. Pleaze chooze one of the
followina:

& Specify the License Server System
™ Specify the License Fils

Copyright [c] Flesera Software LLC

Cancel <Back Mext:

2. You will be prompted to type in the location of your network license server. Click
"Next” to proceed.

19



1 GETTING STARTED

3. When the search for the server was successfull, you will be prompted by the follow-

'FlexNet License ﬁm!g

Enter the Computer Mame of the License Server
System. [Contact your System Administrator if you
do not know thiz. )

Cancel <Back Mext>
I I |

ing screen. Click "Finish” to conclude the licensing procedure.

20
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1.5 Licensing using a standalone license

1. When VRED is starting for the first time, you are presented with the following screen.
Before you proceed, you have to agree to the Autodesk Privacy Statement first. Click
"1 Agree” to proceed.

AUTODESK.

S

"

2. If you want to evaluate VRED, please click “Try”.
"Activate”.

If you own a valid license, click

21



1) Autodesk Licensing =

£\ AUTODESK.
i! -

Thank you for trying Autodesk VRED!

You have 30 more days to use Autodesk VRED. To use after
chis tral period, you must actate your Autodesk VRED.
license. What would you ike to do?

o &=

odesk

Enter Serial Number and Product Key

Product Key

4. Please be patient while the product license is being activated.

22




Y Avtodesk icnsing - Actvating

Autodesk

Product License Activation

U Activating your product license...

5. After successfully activating your license, you will be prompted to log in into the Au-
todesk network. If you do not have an account at Autodesk, “Create User ID”.

PN ook Ueensing - ACCueBeR O] ==
g ptic

| Autodesk

Anmelden

6. Please choose an existing account to bind the license to and click “Next” to proceed.

23



N Autodesk Licensing - Actvating

Autodesk

Choose Account

Prefered Language
Engiish (en)

Frstiame Lastame

UserD
John smith

johnsmith

Poduct  Autodesk VRED
Seraumber: 123-45678901
Requestcode 1234 123412341234 1234 1234 1234 1234

Accounts
Please selecthe Accaunt 1 regster your productto
cty  sate  ZipCode

Adaress

Caltorna

F Auodesk

o

A Now Account Ciose | _text>>

Smith

7. If your license has been accepted, the following screen appears. Click “Finish” to
conclude the licensing process.

| o e e

Autodesk

fodesk VRED. actuate
s, ane or mare products ae alowd o run on
fer Uninstaling Autodesk VRED does ot remove the

License Active

i

24
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2 USING VRED

This chapter contains basic information regarding the general appearance of the
graphical user interface. It provides an overview and introductory summary of how
to navigate, select, manipulate objects, and set up the preferences.

2.1 Interface

- KMenu-bar - -

Rlcons bar

KScenegraph

KSRenderview

» Menu Bar The Menu bar includes all main functions for creating and editing con-
tentin VRED. It provides access to the different modules available in VRED and enables
basic file actions like saving or opening files.

» Icons Bar The Icons bar provides shortcuts to access common features such as
saving the scene or toggling the raytracing mode.

27



2 USING VRED

» Scenegraph The Scenegraph lists all nodes the current scene consists of.

» Renderview The Renderview displays the whole scene. It allows to change the
view as well as to select and modify objects directly.

» Quick Access Bar The Quick access bar provides easy and fast access to main
functions such as the Material Editor, the Clip Maker and the Variants.

» Statusline The Statusline provides information about the memory usage and al-
lows to change the up vector as well as near and far clip planes and the field of view.
It also integrates the Terminal.

2.2 Navigation in Renderview

The renderview visualizes all render settings according to the selected render mode.
By default, you can use the mouse to navigate through the renderview.

Rotate Pan Zoom

2.3 Selection
» Shift + Click LMB in the Renderview to select an object.

28



» Shift + Click RMB to deselect selected object.

» Shift + Drag LMB from top left to bottom right to select only objects fully en-
closed in selection frame.

» Shift + Drag LMB from bottom right to top left to select objects fully and partially
enclosed in selection frame.

» Shift + Drag RMB to deselect objects in selection frame.
» Shift + Crtl LMB to add selected object to selection.

» Shift + Click RMB into empty space to deselect all selected objects.

29



2.4 Transform Tool

Click the Transform Tool icon in the Icons bar to toggle the display of the Transform
Tool in the Renderview. A total of three transformation modes are available:

Translate
SHIFT + W

Rotate
SHIFT + E

Scale
SHIFT + R

30









This chapter provides information about the use of the Menu bar, Toolbars and the
Status bar in VRED.

3.1 Menus

The Menu bar includes all main functions for creating and editing content in VRED.
It provides access to the different modules available in VRED and enables basic file
actions like saving or opening files.

3.1.1 File
This chapter informs about loading, importing and saving data.

» New Creates a new empty scene. The current scene will be closed.

» Open Opens files. A dialogue box opens up to choose from. One or more files
can be selected.

» ASC Dental Geometry: *.asc
FHS Geometry: *.fhs

JT Scene: *.jt

PLM XML: *.plmxml
Compressed Files: *.gz, *.gzip

)

v

P

\/

)

P

M

)

\/

Cosmo3D/Optimizer Geometry: *.csb

)

T

Deltagen Geometry: *.rtx

P

T

Geomview Geometry: *.off

)

v

OpenSG ASCIl Geometry: *.0sg

P

M

OpenSG Binary Geometry: *.osb

P

M

Pro/Engineer Render Geometry: *.slp
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»

»

»

»

»

»

»

»

»

»

Python Script: *.py

StereoLithography Geometry: *.stl, *.stla, *.stlb
VRED Project Binary: *.vpb

VRED Project File: *.vpf

VRED Essentials Project Binary: *.vpe

Maya ASCII: *.ma

Maya Binary: *.mb

CATIA V4: *model, *.mdl, *.session, *.exp, *.dly, *.dlv3, *.dlv4

CATIA V5: *.catpart, *.catproduct, *.cgr
Autocad: *.dxf, *.dwg

ProE/Granite: *.prt, *.asm, *.neu, *.q
IGES: *.igs, *.iges

STEP: *.stp, *.step

Inventor: *.ip, *.iam

Openlnventor: *.iv

Studio: *.wire

SolidWorks: *.sldprt, *.sldasm)

NX: *.prt

3ds Max - *.3ds

CINEMA 4D Scene - *.c4d

FBX Scene - *.fbx

Rhinoceros - *.3dm

VRML Geometry - *.vrml, *.wrl

Wavefront Geometry - *.ob)j



3.1 Menus

» Add Adds files to the current scene. A dialogue box opens up, where the files to

add can be selected from. The file is added to the Scenegraph as child of the
currently selected node. If there is no node selected in the Scenegraph, the
objects will be added as children of the root node. All objects of any added file
are grouped in a group node. Imported files are marked green in the Scene-
graph.

When merging projects, viewpoints will be preserved.

» Save Saves the current file with a supported VRED file type.

» VRED Essentials Project Binary - .vpe

» VRED Project Binary - .vpb
» VRED Project File - .vpf

To write other file types, go to File » Export.

» Save As Saves the current file. A dialogue box opens up, allowing to select the

P

)

)

T

\/

\/

location, file type, and name of the file. If no file ending is entered, the file will
be saved in the VRED native file type VPB.
VRED supports writing the following file types by default:

VRED Essentials Project Binary - .vpe
VRED Project Binary - .vpb
VRED Project File - .vpf

To write other file types, go to File » Export.

VRED supports the storage of ICC color profiles in the project data to ensure
consistency during the whole workflow and between the devices you use re-
garding color management. This guarantees that the colors visible on your
workstation are the same as on your private computer.

» Save Selected Saves the currently selected node(s) in a new file. A dialogue box

opens up, in which location, file type and name for saving can be selected. If
no file ending is entered the file will be saved in the VRED native file type VPB.
VRED supports writing by default the following file types:

35



» VRED Essentials Project Binary - .vpe
» VRED Project Binary - .vpb
» VRED Project File - .vpf
To write other file types use File » Export.

» Publish Publishes a VRED project file (*.vpb) with validity start and expiry dates.

» Save Package Saves a VRED project file creating a subfolder that includes all tex-
tures and materials used within the project.

» Open Recent Opens recently opened/modified files.

» Import With the import function additional file types and meta information can
be added to the current scene.

Rendering Meta Data: VRED renderings - .png, .jpg, .tif. Scene settings that are
embedded as meta data in the rendering are applied to the currently loaded
scene. Please refer to Render Settings » File Output » Meta Data for detailed
information on this topic.

)

T

P

v

Cosmo Binary: Cosmo3D/Optimizer Geometry - .csb, Deltagen Geometry - .rtx,
Deltagen Animations - .wrl, Deltagen Variants - .xml

PLM XML: PLM XML - .plmxml

Sequences: XML Sequencer Description - .xml
A sequence setup for the Sequencer module can be added to the current scene.

)

T

)

x

P

v

Variants: XML Variant Description - .xml
A variant setup for the Variants and VariantSets module can be added to the
current scene.

» Export The export function allows the export of the scene geometry, images, se-
quencer batches, and variants.

» Scene: Allows to export the scene in different data types. The default setting
is *.vpb. Other supported types are:

36
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»
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»

»

e VRML Geometry - .vrml .wrl

e Wavefront Geometry - .obj

e VRED Essentials Project Binary - .vpe
e FBX Scene - .fbx

e Maya® ASCIl - .ma

e Maya® Binary - .mb

e Maya® Scene - .ma .mb .wire

e FHS Geometry - .fhs

e PovRay - .pov

e OpenSG ASCll Geometry - .0sg

e OpenSG Binary Geometry - .osb

e Pro/Engineer Render Geometry - .slp
e Python Script - .py

e Stereolithography Geometry - .stl .stla .stlb
e VRED Project Binary - .vpb

e VRED Project File - .vpf

Selected: Allows to export the selection in different data types. The default
setting is *.vpb.

Switched Geometry: Exports Switched Geometry data (*.osb).

Cubelmages: A dialogue box appears, where the location for saving the Cubelm-
age can be selected. The Cube Image render settings can be set in the Prefer-
ences Editor.

Snapshot: Exports a snapshot of the viewport to the snapshot folder previously
specified in the preferences.

Sequences: All sequences set in the Sequencer module will be saved in a sep-
arate xml file.

37



3 MENUS ANDTOOLBARS

» Variants: All variants and variants sets will be saved in a separate xml file.

» Add VRML Animation VRML animations can be added to the current scene. Pre-
condition is that the animated objects exist in the current file.

» Optimize Scene Optimizes the scene to improve the performance. Rendering
speeds up and memory usage lowers after optimization. There are three al-
gorithms available:

» Optimize Geometries: Optimizes the geometry structure.

» Optimize/Share Geometries: Optimizes the geometry structure and tries to
share duplicated geometries.

» Merge/Optimize/Share Geometries: Changes the Scenegraph structure to achieve
a maximum of optimization.

» Quit Quits the application.

3.1.2 Edit

» Script Editor Opens the Script Editor. In the Script Editor, python scripts can be
written and executed.

» Run Script Executes the current script in the Script Editor.
» Undo Undo the last action.
» Redo Redo the last action.

» Clear Undo Stack Clears the undo stack (cache for any type of undo commands).

» Selection

» Make Normals Consistent: Select with ALT + Left mouse click to make vertex
and face normals of each selected object consistent.

38



» Use Depth Selection: Allows to select all objects within the selection frame,
whether they are behind another objects or not.

» Preferences Opens the Preferences window to edit the preferred settings for VRED.

3.1.3 View
» Display This function helps to define individual display settings depending on the
selected device.
» Powerwall Settings: Opens the Editor for Powerwall settings.

e Width: Sets the width of the projection window.
e Height: Sets the height projection window.
e Distance: Sets the distance between the projection window and the viewer.
e Enable Powerwall Mode: Activates Powerwall Rendering.

» Standard Display: Encodes the rendered image to be displayed on a standard
display.
» SIM2 HDR: Encodes the rendered image to be displayed on a SIM2 HDR display.

» Toolbars
» File: Toggles the file I/0 icons in the Icons bar.
» Render Options: Toggles the rendering related icons in the Icons bar.
» View: Toggles the view related icons in the Icons bar.
» Synchronisation: Toggles the cluster and tracking related icons in the Icons bar.
» QuickAccess: Toggles the QuickAccess bar at the bottom.

» Show Annotations Toggles the display of the annotations.

» Show Clipping Toggles the display of the clipping planes.
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» Show Grid Toggles the display of the scene grid.

» Show Measurement Toggles the display of the measurements.

» Show Ruler Toggles the display of the ruler.

» Show Manipulator Toggles the display of the transform manipulator.
» Show Routes Toggles VRML animation routes.

» Show Shortcuts Opens a new window and displays all available shortcuts in VRED.

» Undo/Redo History Displays a brief history of many actions in VRED.
» Trash Displays the trash container. Rightclick » Clear to clear it.

» Terminal Displays the Terminal module.

3.1.4 Visualization

The visualization menu provides a number of visual options and provides access to
the available render modes.

» Toggle Raytracing Enables/Disables Raytracing.

» Raytracing Downscale Offers three different downscaling levels to accelerate the
interactive work process according to individual scene complexities.

» Realistic Rendering Activates the realistic rendering mode. In the raytracing mode,
a selection of different render passes is provided for interactive display. To view
the composed rendering, choose Beauty Rendering.
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» Renderpasses Rendering The Renderpasses Rendering feature allows to interac-
tively evaluate specific render passes in the viewport. This feature works in

Raytracing only. You can view the following:

» Combined Channels

Diffuse IBL

Diffuse Light
Diffuse Indirect
Glossy IBL

Glossy Light
Glossy Indirect
Specular Reflection
Translucency

Incandescence

» Material Channels:

Diffuse Color
Specular Color
Glossy Color

Translucency Color

» lllumination Channels:

Diffuse IBL lllumination
Diffuse Light lllumination
Diffuse Indirect lllumination
Glossy IBL Illumination
Glossy Light Illumination
Glossy Indirect Illlumination
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e Translucency IBL lllumination
e Translucency Light lllumination
e Translucency Indirect lllumination
e Specular Indirect Illlumination
» Auxiliary Channels:

e Occlusion
e Mask
e Depth
e Normal
e Position
o View

» Vertex/Face Normal Rendering Activates the Vertex and Face Normal rendering

mode. All objects are rendered with green, blue, gold or magenta shading.
Each color gives feedback about each normal direction.

» Green: Face and Vertex Normals are consistent and point towards the camera.

T

» Blue: Face and Vertex Normals are consistent and point away from the camera.

T

P

\/

Gold: Face and Vertex Normals are inconsistent. The Face Normals point away
from the camera, while the Vertex Normals point towards the camera.

)

T

Magenta: Face and Vertex Normals are inconsistent. The Face Normals point
towards the camera, while the Vertex Normals point away from the camera.

» Ambient Occlusion Rendering Activates the Ambient Occlusion rendering mode.
The Ambient Occlusion rendering shows a grayscale rendering, in which the
pre-calculated ambient occlusion can be evaluated.

» Indirect lllumination Rendering Activates the Indirect lllumination rendering mode.
The Indirect Illumination rendering shows pre-calculated indirect illumination,
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or with photon mapping and final gathering enabled, it shows the final gather
points.

» Surface Analysis Rendering Activates the Surface Analysis rendering mode to
analyze the quality of a surface. The options of this rendering mode are defin-
able in the corresponding SurfaceAnalysis module.

» Analytic Rendering The Analytic rendering mode uses a basic shading quality
without distracting reflections. It only uses standard lightsources and ignores
any IBL lighting.

» Non Photorealistic Rendering Activates the Non-Realistic rendering mode. The
NPR rendering is an OpenGL render mode, which allows users to render schematic
images. The NPR shading supports outline rendering.

» Stereo Includes all necessary settings to set up stereoscopic views.
Disabled: The stereo mode is set to disabled by default.

Double Buffered: Activates double buffered rendering in OpenGL mode for a
shutter stereo mode when supported by the graphics board.

)

v

P

\/

P

T

Horizontal Interlaced: Activates horizontal interlaced stereo rendering. This
produces an image with alternating lines for left and right eye like TV sets for
instance.

» Vertical Interlaced: Activates vertical interlaced stereo rendering.

\/

)

Left/Right Split: The Renderview is split into two render areas. The Renderview's
left half draws the left eye’s field of view and

P

M

Left/Right Split (Half): Half resolution mode for stereo television.

Top/Bottom Split: The Renderview is split into two render areas. The top half
of the Renderview draws the left eye’s field of view, and the bottom half draws
the right eye’s field of view of the stereo rendering.

P

v

P

M

Red/Cyan: Activates the Red/Cyan anaglyph stereo mode, can be used with
cheap glasses.
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Blue/Yellow: Activates the Blue/Yellow stereo rendering mode. The same as
above with differently colored glasses.

)

4

p)

T

Green/Magenta: Activates the Green/Magenta stereo rendering mode.

P

T

Left Eye: Activates only left eye’s stereo rendering view.

p)

4

Right Eye: Activates only right eye’s stereo rendering view.

v

Tridelity Multi-View: Activates a multi-view (five view) stereo rendering mode,
appropriate for tridelity active stereo displays and further comparable hard-
ware.

v

Stereo Settings: Opens a dialog for Stereo settings.

e Eye Separation: Sets the viewer’s eye left and right eye distance in mil-
limeters.

e Zero Parallax Distance: Sets the viewer's focus distance. This is the dis-
tance to a plane where the images for both eyes will match. E.g. if you
are 1.50 m in front of a powerwall, the value is 1500mm.

e Disable Stereo: Disables the stereo rendering.

» Backplate Helps to set up a backplate.
» Toggle Backplate: Sets the backplate to visible/invisible.

» Create Backplate: Creates a backplate. A file dialogue appears, where back-
plate images can be selected from. Creating a backplate activates the render
option 'Backplate’.

» Delete Backplate: Deletes all existing backplates in the scene.
» Realtime Antialiasing Choose from three different realtime antialiasing quality
levels.
» Off: Disables realtime antialiasing.

» Low: Enables low quality realtime antialiasing. In raytracing mode, 4 samples
per pixel are traced to improve the quality.
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»

»

Medium: Enables medium quality realtime antialiasing. In raytracing mode, 8
samples per pixel are traced to improve the quality.

High: Enables high quality realtime antialiasing. In raytracing mode, 16 samples
per pixel are traced to improve the quality.

» Advanced OpenGL Settings

»

»

»

»

»

»

»

»

»

Wireframe: The wireframe button toggles wireframe rendering to on or off. All
currently selected objects are drawn in the set render mode and an additional
wireframe mode. The wireframe colour can be set in: Edit » Preferences »
Render Options » Wireframe.

Two-Sided Lighting: Enables/Disables two sided lighting. It allows to illuminate
the backside of a polygone correctly.

Realtime shadow: Activates/deactivates real time shadows. Only available in
OpenGL mode.

Ambient Occlusion Shadows: Activates Ambient Occlusion calculation.

Geometry Light Sources: Only active if “Realtime shadow” is selected. Treats
self-illuminated geometries as light source. Only in OpenGL render mode.

Backface Culling: Activates/deactivates backface culling. Backface culling al-
lows to render only the faces with normals pointing to the camera.

Occlusion Culling: Renders visible geometries only.

Depth Only Pass: Depth Only Pass renders the scene once using only the depth
values. It can be used for optimization with complex shaders.

Postprocessing: Enables/disables postprocessing in OpenGL mode. Postpro-
cessing is enabled by default in raytracing mode. It allows to use postprocess-
ing settings in OpenGL mode (like exposure, whitepoint and saturation).

» Interactive Material Preview Toggles the interactive material preview. When ac-

tivated, you can drag a material from the Material Editor over any object in the
scene and VRED immediately applies the material to the object. When you drop
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the material on the object, it will be assigned to it. In case the material should
not be assigned, drop it to the Material Editor avoiding changes.

» Rendering Toggles rendering in the viewport.

» Simulate Toggles the VRED simulation engine. The simulation loop controls ani-
mations, interactive scripts, viewpoint interpolations, etc.

3.1.5 Scene

This chapter includes information for creating and adjusting objects like lights, cam-
eras, and geometry in VRED.

» Create Geometry With the “Create Geometry” function, it is possible to create
simple geometries in VRED. The following geometric primitives are supported:

» Line

» Plane

» Box

» Cylinder
» Cone

» Sphere

» Torus

» Create Light A selection of three different light types is available in VRED:
» Directional Light
» Point Light
» Spot Light
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3.1 Menus

» Create Camera VRED provides three different camera types. To create a new cam-
era, select the desired camera:

» Perspective Camera
» Orthographic Camera

» Viewpoint
» Scenegraph Hides/shows the Scenegraph.

» Ambient Occlusion Opens the ambient occlusion module. The ambient occlusion
module pre-calculates and pre-renders ambient occlusion and indirect illumi-
nation for use in OpenGL and raytracing precomputed render modes. Specific
parameters regarding specific geometries can be saved. Saved parameters can
easily be loaded and applied to the instances of the same geometry. It is not
required to further remember the values.

» Camera Editor Opens the Camera module. In the Camera module, all camera
settings can be defined and adjusted.

» Geometry Editor Opens the Geometry Editor module. The Geometry Editor mod-
ule carries out a range of geometry optimizations depending on the geometry
type (polygon or NURBS surface).

» Light Editor Opens the Light Editor module. The Light Editor module enables to
create and edit lights sources. All the light sources in the scene are listed in the
Scenegraph as well.

» Material Editor Opens the Material Editor module. The Material Editor module
enables to create and edit materials including environment materials for image
based lighting. It also allows to set up material libraries.

» Node Editor Opens the Node Editor. The Node Editor lists all node parameters
and allows their editing.
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» Optimize Opens the Optimize module. The Optimize module provides tools to
restructure and optimize the scene data.

» Texture Editor Opens the Texture Editor. The Texture Editor allows you to inter-
actively place textures on objects in the scene.

» Variants Opens the Variants module. In the Variants module, different states of
switch nodes and materials can be accessed quickly.

» Variant Sets Opens the Variant Sets module. In the Variant Sets module, complex
variation setups are definable. Subsequently, they are executable by a single
initiator.

3.1.6 Animation

This chapter includes information for creating, adjusting, and playing animations in
VRED.

» Animation Opens the Animation module. Using the Animation module, anima-
tions can be stored to be executed initially. Imported objects, vertex or camera
animations from other applications are listed here and can be executed with
Python scripts. They can further be attached to sensors, retimed etc.

» Curve Editor Opens the Curve Editor module. The Curve Editor can create anima-
tions for all objects. Animations can be stored in blocks, and later be rearranged
in the Clip Maker module. They can also be attached to sensors and be listed
as Variant in the VariantSets module.

» Clip Maker Opens the Clip Maker module. In the Clip Maker module, previously
created animations, which have been bound in blocks in the Curve Editor mod-
ule, can be arranged in clips. The Clip Maker also enables to retime, adjust
and export clips. VRED Professional supports the playback of sequence sets in
the Sequencer module at any time. It enables to start predefined sequences at

48



a specific frame of an animation. During playback, you have full control over
timing and focus in the presentation.

» Timeline Opens the Timeline.

» SAnimation Opens the SAnimation module. The SAnimation module lists and

executes imported RTT DeltaGen animations.

3.1.7 Interaction

The Interaction module helps for example to create annotations, clip geometries for
detailed views or measure scene elements.

» Navigation The user can switch between the navigation modes listed below. Nav-

»

»

»

»

»

»

igation may be enabled or disabled by (un)checking the item “Enabled”.

TrackBall: In trackball navigation, all camera rotation axes are unlocked. The
camera rotates freely in all directions.

TwoAxis: In two axis navigation, the camera has only two free rotation axes,
while the third one, the role axis, is locked.

Fly: Go forward by clicking left and move backward by holding the right mouse
button. You can set the movement speed with the Motion Factor. In Fly mode
you can steer by moving the mouse horizontally and vertically.

Orientation: The orientation of the virtual camera is set in the Orientation
mode. Use this mode e.g. in order to simulate the driver’s point of view in
the vehicle interior.

Auto Center: You will always rotate around the center of your image, if Auto
Center is set. When not using Auto Center, you can chose yourself around
which point you want to rotate by using double left or double right click.

Motion Factor
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e Motion Factor: In "Fly” navigation mode, the motion factor determines
the speed at which the input device navigates through the scene. The
higher the value, the faster the navigation.

» Connector Using the connector, VRED instances can be synchronized for navi-

»

»

»
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gation, even on independent computers. This mode can be useful to compare
variants, for example. Besides navigation, python commands are synchronized.
The usual workflow is to load a file separately on each VRED instance and con-
nect them together. Navigation should occur on the server. It is also possible
to navigate on the client, but it will be overridden by navigation steps on the
server.

Settings:

e Save: Connector-server settings can be stored. Press the Save Settings
button.

Connect to: Here, the connection settings can be entered, in case the current
VRED instance is a connection-slave.

e Server: Sets the server IP. If the VRED instances run on the same machine,
simply enter /ocalhost.

e Port: Sets the communication port address.
e Disconnect: Deactivates the connector.

e Connect: Activates the connector. If connecting to the server fails, check
if the port number matches and the server name is correct. Also ensure
that no firewall is blocking access.

e Take Over Control: Requests the control of the current connector session.

Server: Here, the connection settings can be entered, in case this VRED instance
is a connection-server.

e Port: Sets the communication port address.
e Stop: Stops the connection-server.
e Start: Starts the connection-server.



3.1 Menus

e Frame Sync: Syncs the viewport refresh rate for all conference participants.

» Annotation Opens the Annotation module. In the Annotation module, annota-
tions can be added to the scene.

» Clipping Opens the Clipping module. Using the Clipping module, objects can be
clipped for construction evaluation purposes. The Clipping module offers a
variety of clipping tools.

» Measurement Opens the Measurement module. With the Measurement module,
distances between objects, points, edges and more can be evaluated.

» Sequencer Opens the Sequencer module. In the Sequencer it is possible to set up
processes which can be used for specific interactions in the application or as
batch render setup.

» Touch Sensor The Touch Sensor allows to switch variants or play animations by a
single click on geometry within the viewport. You can define a new node by
simply dragging a node from the scenegraph into the Touch Sensor module.

» Tracking Opens the Tracking module. The Tracking module provides all settings
for different tracking types and setups.

» Transform Opens the Transform module. The Transform module sets any kind of
object transformations via specific entries. Object’s pivots can be adjusted.

3.1.8 Rendering

In this menu section, you can find modules that help to set up special rendering
configurations like clustering, raytracing parameters and render layers.

» Cluster Opens the Cluster module. The Cluster module provides access to all set-
tings for setting up the different clustering modes VRED offers.
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» Render Layer Opens the Render Layer module. Using the Render Layer module,
the scene can be split up into separate matching layers to be prepared for
further refining in the post process.

» Render Settings Opens the Render Settings. Here, all the settings for rendering
can be defined.

» Surface Analysis Opens the Surface Analysis module. The Surface Analysis mod-
ule allows to analyze the quality and continuity of a surface.

3.1.9 Window
This chapter contains different render window options.

» New Render Window Opens up a new render window. This feature allows you

to create multiple render windows. The render windows can be set up inde-
pendently. It is possible to individually set different cameras, viewpoints or to
view different rendering modes (see Visualization menu) at the same time.
Caution: For any additionally opened render window, the complete currently
loaded scene, since the system is running in OpenGL mode, will be loaded
again into the graphics boards Random Access Memory.
Ensure that the graphics board has enough memory available. In raytracing ren-
dering mode, the frame rate might slow down, since the frame rate depends
primarily on the amount of pixels to be rendered. If the amount of pixels of all
render windows summed up stays unchanged, the frame rate will also remain
on a stable level.

» Close Render Window Closes the active render window.
» Render Window Size Contains predefined image resolutions as well as a dynamic
resolution mode and a resolution mode that uses the resolution set in the pref-

erences. The preferences resolution mode is set as default.
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3.1 Menus

» Layout Contains options to store, select or delete layouts of the windows within
VRED. Additionally, previously stored layouts are selectable as default layout.

3.1.10 Help
Contains general information about VRED and access to the documentation.

» About The About window provides all information about the currently used VRED
version, the license request state and the license agreement.

» License Shows the Autodesk licensing terms.

» Documentation Opens an HTML-site providing the online version of this Docu-
mentation. The documentation provides detailed information regarding the
general handling of VRED.

» Python Documentation Opens the Python Documentation window which lists
and desribes commands, classes and algorithms for programming in the sup-
ported script language Python.

» Changes Opens the Changes window. The Changes windowv lists all version changes.

» GL Info Opens the GL Info window. Displays all OpenGL features supported by
the graphics board and the current memory usage.
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3.2 Toolbars

» File
» ¥ Open File
» 8 Add File
» [®] Save File

» Render Options
» 4 Toggle Stillframe Antialiasing '
» [RT] Toggle Raytracing
» @ Toggle Raytracing Downscale 2
» [ = Toggle Region Rendering 3
» [ Toggle Backplate
» @ Toggle Wireframe Selection Mode
» [_JToggle Bounding Box Selection Mode
» = Toggle Headlight
» alli Toggle Statistics

» View
» “x Show Fullscreen 4

» % Show the Complete Scene

"Keep mouse button pressed to enable downscale antialiasing or to enable raytraced antialiasing for
OpenGL.

2Keep mouse button pressed to select downscale level.

3Hold Key 'R" and drag with the left mouse button to select a region. Region rendering allows the user
to focus the calculation power on a specific region in the viewport to gain a faster preview. Only the
specified region is sampled in detail. This feature is only available in raytracing mode.

“Keep mouse button pressed to enable multi-display fullscreen.
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3.3 Status Bar

» i Zoom to Selected Object ®
<5 Toggle Grid ©
» 1t Toggle Ruler ©

¥

» 2 Toggle Transform Manipulator ©

» QuickAccess

» % Scenegraph

» [ Transform

» 3 Material Editor
. Camera Editor
» = Curve Editor
» [ Clip Maker
» W Variant Sets

» i Render Settings

3.3 Status Bar

» Status bar The Status bar provides information about the memory usage and al-
lows you to change the up vector as well as near and far clipping planes and
the field of view.

» Info: Size of the scene, id and resolution of the current renderview.

» Units: This option defines the mapping of the scene units to a physical unit of
length.

» Up: Sets the axis of the up vector.

*If no object is selected, show the initial camera view.
¢ Keep mouse button pressed for further options.
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» NCP: Defines the distance of the near clip plane.
» FCP: Defines the distance of the far clip plane.
» FOV: Sets the field of view in degree.

» ICV: Saves the current view as the initial camera view.
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This chapter provides detailed information about setting up global preferences in
VRED. The Preferences can be found in Edit » Preferences. To save all changes, close
the Preferences dialog by clicking ‘OK’".

4.1 Animation

» Base
» Time: This value determines the number of frames that make up a second.

» Keep Keys at Current Frames: When activated, all Keyframes remain in their
global position, even when changing the global time. As a result, those curves
are modified. When deactivated, keys may map to a different frame when
changing the global time value.

» Playback

» Playback Speed: This value sets the number of frames that are processed per
second.

» Playback Range: This switch determines whether the full range or the detailed
range is played.

» Evaluation Context: Defines which curves are taken into calculation. When set
to "Scene”, all active Curves and Blocks are examined. When set to " CurveEd-
itor”, only the curves currently displayed in the Curve Editor are examined.

» Loop: Switch on to loop the playback, or off to disable looping.

» Timeline
» Full Range Start: Start frame for the complete timeline.
» Full Range End: End frame for the complete timeline.
» Detailed Range Start: Start frame for the current part of the timeline.
» Detailed Range End: End frame for the current part of the timeline.

59



4.2 Camera

» Base
» Field of View: Sets the standard preset for the Field of View (FOV).

» Stereo

» Eye Separation: Sets the distance between left eye and right eye in stereoscopic
view.

» Zero Parallax Distance: Sets the focus point in stereoscopic view.

» Powerwall
» Projection Width: Physical width of the projection in millimeters.
» Projection Height: Physical height of the projection in millimeters.

» Projection Distance: Distance between the projection plane and the observer
in millimeters.

4.3 Cluster Client

» Default Config File Sets the root of the configuration file for the cluster setup.

» Daemon Port Sets the port to use for cluster communication.

4.4 Color Management

» Monitor Color Profile Defines the monitor color profile.

» Image Color Profile Defines the image color profile.
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4.5 Devices

» Space Mouse
» Enable 3D Mouse: On/Off
» View Mode: You can select to either move a camera or an object.

» Rotation Pivot: You either move around the camera, the selected object or the
focus distance.

» Enable Two-Axis Mode: On/Off

» Helicopter Mode: Enables to define a certain height and to tilt.
» Height: Defines the Helicopter Mode height in mm.

» Use Fixed Height: On/Off

» Joystick

» Use Joystick: Activates the use of a joystick devices for navigation. Enter the
device Id.

» Id: Sets the device Id.

» Sample settings for a Logitech RumblePad2

~

» Left joystick: Trackball-like navigation. Rotates around the at-point.

I~

» Left joystick + L1: Rotates the camera.

I~

» Left joystick + L2: Pans the camera.
» Right joystick: Zoom
» Button 1: Shows the whole scene.

» Button 2: Shows the ICV (Initial Camera View)
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4 PREFERENCES

4.6 Export

4.6.1 Cubelmage

» Resolution Render resolution for cube images. Supported resolutions:
» 32x32
» 64x64
» 128x128
» 256x256
» 512x512
» 1024x1024
» 2048x2048
» Supersampling Sets the supersampling quality for cube image rendering. Super-
sampling quality:
» Off
» 4X
» 16X
» 64X

» Type Defines the type of cube image rendering:
» Separate Images (6 planar images)
» Vertical Cross rendering
» Horizontal Cross rendering

» Spherical Map rendering
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4.7 FilelO

Sets the global File I/0 settings in VRED.

» Base

»

I~

)

»

»

Verify Geometry: During import, verify that the structure of the geometries is
suitable for rendering.

Optimize Geometry: Rebuilds geometry optimized for VRED Scenegraph.

Create TruelightMaterials: Activates/deactivates automatic conversion of all im-
ported materials to TruelightMaterials.

Temporary Path: Path for temporary files.

» Import Dialog

»

»

»

»

»

»

Show Dialog: If switched on, a dialog will open up once you try to import a
supported file format. Off will use the default settings defined in the prefer-
ences.

Convert Materials to TruelightMaterials: If set to on, this will cause VRED to
convert all materials into TruelightMaterials on import.

Add Skydome Environment: If switched on, VRED will add a default skydome
environment geometry to your scene, enabling you to quickly examine the ob-
jects under natural lighting conditions.

Center to Origin: If checked, places the imported objects in the origin of the
scene.

Place Objects on the Ground: If checked, the objects are placed on the ground.

Adjust Object Size: Offers you to quickly resize the imported objects, enabling
you to work with fitting scales. A wrong scaling may have a direct impact on
many settings like flakes.

» Texture Compression
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»

»

»

»

None: No texture compression at any time.
Auto: Texture compression if texture size exceeds graphics board memory limit.
Always: Texture compression for all loaded textures.

Video Memory Limit: Sets the video memory limit to use for texture compres-
sion in Megabytes.

» Texture Search Paths Specifies the folders where VRED searches for textures.

4.7.1 Base CAD

)

4

v

p)

4

P

T

p)

4

)

4

v

Enable Tesselation: Enables or disables the tesselation of CAD data.

Chord Deviation: The chord deviation is the distance from the midpoint of a
tesselated edge to the geometry.

Normal Tolerance: The Normal Tolerance is the allowed normal deviation be-
tween the normals on the ends of a tesselated edge.

Max Chord Length: The Max Chord Length is the maximum length of a tesse-
lated edge.

Merge Geometries: Allows to merge the geometry that is to be imported.
Enable Stitching: Enables the stitching of adjacent edges.

Stitching Tolerance: Sets the tolerance where two adjacent edges are consid-
ered to be touching and where they should be stitched together.

4.7.2 FHS

A proprietary file format from the Fraunhofer-IGD (Y) rendering system.

» Loader
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»

Ignore INVERTALPHA: Ignore the INVERTALPHA directive which inverts the al-
pha channel of a texture.

» Writer

»

»

»

»

»

»

Write Poly Pools: Compact format to represent the geometry structure.

Force Writing INVERTALPHA: Inverts the alpha channel of all textures while
loading the file.

Write Material: Write the material defenition to the file.
Write Geometry: Write the geometry nodes to the file.

Texture Quality High: Mark textures as high quality. High quality means 32 bit
RGB color support.

Extended Format: Supports multi texturing, shaders, and audio.
e Enable Extended Format: Enables the extended format.

e Inline Audio Data: Inline the audio data into the fhs file, no extra reference
to a external audio file.

4.7.3 JT

» Loader

»

»

Use Active Layerfilter: Usage of layer filters, i.e. disabling of inactive Nodes.

Breps Handling: Handling of objects with exact boundary representation sur-

faces (NURBS): Tesselation of all the brep objects or direct ray tracing of all the
JT and/or XT-brep objects using the NURBS data.

4.7.4 Maya

» Base

65



» Maya Directory: Sets the Maya installation path. This defines the Maya version
file type which can be loaded.
» Loader

» Force Grayscale Shadow Texture: Converts all grayscale textures from RGB to
grayscale textures.

» Use Local Material Library: Uses the local material library when checked.

» Units: Sets the units to be used for imported data.

» Writer

» Units: Sets the units to be used for exported data.

4.7.5 OSB/VPB

» Loader

» Checksum Test: The checksum test ensures the file was successfully read after
loading into VRED. The checksum test causes longer file loading times.

» Writer

» File Compression: VRED files can be saved with file compression. This helps
reducing the required disc space for the file. With the file compression option
the quality of file compression can be defined. There are three options:

e No file compression: Does not compress files, which results in larger VRED
files and short saving and loading times.

e Fast file compression: Compresses files, which results in smaller file sizes.
Saving and loading time will be longer.

e Best file compression: Compresses data into very small files, which saves
a lot of disc space. Saving and loading files takes longer.
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» Write Compatible (<6.0) Format: Allows you to save VPB/OSB data in a com-
patible format to be read with VRED versions prior to 6.0.

» Validate Written File: Validates all written data, ensuring data consistency.

» Use Inline Textures: Inlines all textures used in the scene into the file.

I~

» Texture Compression: Defines the quality in which inline textures will be em-
bedded.

e None: Keeps all textures in their native file format and quality.
e Lossless: Compresses all textures losslessly.

e Lossy: All textures will be compressed to the smallest possible size, losses
are taken into account.

» Quality: Sets the quality for the lossy texture compression.

» Incremental Save

» Enable Incremental Save: Enables the incremental save function. Before saving
a file, a clone will be placed into a subfolder. This allows you to store an in-
dividual number of scene milestones. The number of versions can be defined
under "Number of Increments”.

» Number of Increments: Defines the number of backup steps used by the incre-
mental save function.

4.7.6 Rhino

» Base
» Merge Geometry: Merges geometry when importing Rhino material.
» Import NURBS: Imports NURBS data when checked.
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4.7.7 SLP

» Loader

» Disable Display Lists: An OpenGL display list is created for rendering the im-
ported geometry. Some older graphics boards have difficulties handling these
amounts of data. To get a stable result turn off the display lists. The perfor-
mance might drop extremely.

4.7.8 STL

» Loader

» Disable Display Lists: An OpenGL display list is created for rendering the im-
ported geometry. Some older graphics boards have difficulties handling these
amounts of data. To get a stable result turn off the display lists. The perfor-
mance might drop extremely.

» Writer

» STL Export Format: There are two modes in which STL files can be written:
Ascii: Is legible in the editor. Reading and writing is very slow and requires
more hard disk space.

Binary: Is illegible in the editor (binary). Reading and writing is very fast and
consumes less hard disk space.

4.7.9 WRL

» Loader

» Optimization (Auto, Catia, Pro Engineer): These are special optimizations that
are performed during loadup. Highly complex data structures of Catia and Pro
Engineer’s VRML files make it very hard to get efficient results. These optimiza-
tions enable you to display these data sets up to 50x faster than usual and give
you a quick feedback.
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» Writer

» Inline Textures: Usually, textures are only referenced as normal files. Inline
textures allow you to embed textures directly into the VRML file.

4.8 Import

Defines the CAD data and tessellation value settings.

4.8.1 Optimizer
Imports optimizer csb files.

» Advanced

» Optimizer Rendering Compatibility Mode: Tries to render the imported geom-
etry in accordance to the optimizer renderer (disabled state sorting).

» Remove Vertex Colors: Removes the vertex color information of the geometry
nodes.

» Merge Shape Geometries: Tries to merge all geometry children of a shape node.
» Shadow Conversion: There are three options:
e Remove Shadow

e 2 Geometries / 1 Material

1 Geometry / 1 MultipassMaterial

1 Geometry / 1 MultiTextureMaterial

1 Geometry / 1 MergeMaterial
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4.8.2 PLM XML

» Base

» Load Referenced Files: Resolves external referenced files and loads these.

4.8.3 Tesselation

» Tesselation Quality

» Tolerance: Sets the maximum triangle aberration for tessellation from the b-
splines. Adding further tessellation tolerances, an LOD node is generated for
each imported file. The tolerance values define the tessellation aberration for
each LOD node’s child. The number of children is defined by the number of
tolerance values. With the Add and Remove button, tessellation values can be
added or removed.

» Offset Factor: Sets the offset for the following tessellation tolerance value de-
pending on the previously created.

» Tesselation Topology
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» Topology: Offers three different options to tessellate geometries.

e Create New: Rebuilds a completely new geometry based on the imported
b- splines.

e Reuse Existing (If Any): Refines the geometry according to the set tessella-
tion settings. The new tessellation is based on the currently set tessellation
in the imported data, if there is a tessellation already existing.

e No Topology: Does not tessellate geometries.
» Tolerance: Aberration of the tessellated geometries from the b-splines.

» Check Orientation: Ensures that normals of seamless patches are pointing in
the same direction.



4.9 Main Window

» Base

»

»

»

»

»

»

Show FPS in Statusbar: Shows the current frame rate in the lower left corner
of the Renderview.

Show Rendering Log Messages in Terminal: All log messages will be shown in
the Terminal Module during the rendering process.

Show Internal Nodes in Scenegraph: Shows internal nodes in the Scenegraph.
Show Toolbutton Text: Shows the name of the icons.
Window Opacity: Sets the opacity for all module windows.

Disable Docking: Enables/disables the docking function for module windows
in VRED.

4.10 Material Editor

» Material Library Paths

»

»

Add: Adds a new search directory where material libraries can be found.

Remove: Deletes the selected search directory for material libraries.

4.11 Navigator

» Navigation Mode

»

Fly: Sets the navigation to fly mode. This mode is suitable for space mouse
navigation. The camera’s pivot is fixed to the camera’s center. In fly mode, the
camera can be placed and orientated freely in 3D space.
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» Walk: Sets the navigation to walk mode.
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Trackball (2 Axis): Sets the navigation mode to two axis navigation. In two axis
navigation, the camera has only two free rotation axes, while the third one,
the role axis, is locked.

» Trackball (3 Axis): Sets the navigation mode to trackball navigation. In trackball
navigation, all camera rotation axes are unlocked. The camera rotates freely in
all directions.

» Auto Center: Automatically sets the rotation pivot in two axis and trackball
navigation mode to the object’s center currently placed in the Renderview’s
center.

4.12 Plugins

All checked plugins will be loaded on startup.

4.13 Render Options

This chapter provides information about setting up the Renderview parameters in
VRED.

4.13.1 Visualisation

» Render Window

» Use Fixed Resolution: Enables/disables to set a fixed resolution for the render
view.

» Pixel Resolution: Sets the width and height of the render view in pixels.

» Enable Downscale: Enables/disables downscale.
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Downscale Quality: Offers a total of three downscaling options to accelerate
the work process.

)

e Low: Uses every second pixel for the calculation.
e Medium: Uses every fourth pixel for the calculation.
e High: Uses every eighth pixel for the calculation.

)

Enable Realtime Antialiasing: Activates the realtime antialiasing for OpenGL
render mode by default.
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Antialiasing Quality: Sets the realitme antialiasing quality for OpenGL mode.
e Low: Calculates one and a half times of the original resolution.
e Medium: Calculates two times of the original resolution.
e High: Calculates four times of the original resolution.

Enable Stillframe Antialiasing: Activates still antialiasing rendering for OpenGL
and Raytracing render mode by default.
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Stillframe AA After: Sets the duration of no user input in seconds, before still
antialiasing starts calculating.
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Interactive Material Preview: Activates the interactive material preview while
dragging and dropping a material on an object in the render view by default.
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Automatic Clipping Plane Adaption: Adjusts the clipping plane automatically
to the visible object’s boundig box.
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Limit Near and Far Clipping Plane: Sets the default near and far clipping plane.
Clips all objects closer to the camera than the near clipping plane distance (not
drawn anymore). Clips all objects farther away from the camera than the far
clipping plane distance (not drawn anymore).
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Near Clipping Plane: Defines the distance of the near clip plane.
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Far Clipping Plane: Defines the distance of the far clip plane.

» Lighting
» Headlight Behaviour: Sets the default state of the headlight for new scenes.

73



e Auto: Auto leaves the headlight turned on until the first Truelight Shader
is used. Then the headlight will be switched off.

On: Switches the headlight on by default.
Off: Switches the headlight off by default.
Ignore: Retains the headlight state.

» Use Point Headlight: Uses a Point Light as headlight instead of a Directional
Light.

» Correct Two-Sided Lighting: Renders all shaders double-sided.

» Wireframe
» Enable Wireframe: Draws a wireframe of all selected objects.

» Always in Front (OpenGL Only): Draws the wireframe always on top of all ob-
jects, even if others cover the selected.

» Wireframe Color: Sets the wireframe color.

» Navigation Help

» Show Coordinate System: Renders a miniature coordinate system in the lower
right corner of the Renderview.

» Show Navigation Cube: Renders the VRED-navigation in the upper right corner
of the Renderview by default.

» Use Z-Up Coordinate System: Sets the z-axis as up-axis by default.

4.13.2 Visualisation Advanced

» Advanced Rendering

» Use Software Rendering: In OpenGL, the view is rendered by the processor
instead of being calculated by the graphics processor.
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Disable Main Thread Sleep: Prevents the system from sending the main thread
to sleep.

Use 10 Bit RGB: The 10Bit RGB feature allows a great color spectrum ideal for
a monitor able to display that data.

Disable Cluster: Disables the clustering feature. Please restart VRED for the
change to take effect.

Auto Depth Only Pass: Enables a “"Depth first” pass on full screen. If activated,
the scene is rendered without shading first to fill the depth buffer to avoid
shading calculations on hidden fragments. For scenes with complex shading,
this should be turned on. On scenes with lots of geometry settings, turning
auto depth off may result in better performance.

Use Back Buffer: High framerates often cause so called “tearings”, which can
be avoided by activating the backbuffer.

Occlusion Culling: Disables the rendering of invisible objects. Occlusion culling
can improve the performance in very complex scenes.

Cache Geometry: Caching geometries improves the application’s performance.
The caching process uses additional main memory (RAM).

Ignore GL Extensions: Comma separated list of extensions to be ignored, e.g.
"GLARBnontexturepoweroftwo, GLARBpixelbufferobject”.

» Background In the Background menu, the background color of the Renderview
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can be set. The color is defined as a gradient, which changes its color value
according to a specified color at specified positions. The color is defined in RGB
and the position from bottom to top in a value ranges from 0 to 1.

Color: The color can be set with the color chooser or by a direct entry of values
between 0 and 1 for each channel (RGB).

Position: The position value defines the position from bottom to top for each
color. Entry value must be between 0 and 1.

Add: Adds a new color value.
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» Delete: Deletes the selected color.
» Choose Color: Opens the color picker to set the color for the currently selected
entry.
» Channel Shift
» Enable Channel Shift: Enables/Disables channel shift.
» Channel (Red, Green, Blue, Alpha): Sets an offset for a whole colour channel.
» Offset X,Y: Sets the offset in pixels.

4.14 Render Settings

In the Render Settings preferences, default settings for offline and interactive render-
ing can be defined.

4.14.1 Image

» Image
» Resolution: Sets the image size in pixels in width and height.
» DPI: Dots per inch. Defines the embedded image resolution in dots per inch.
» Size: Calculates the resulting image size in mm depending on the dpi and pixel
resolution.
» Advanced

» Supersampling: Enables (On) or disables (Off) supersampling. If set to “On” all
image samples are rendered.

» Stereo Mode: Enables you to render out stereoscopic images (Mono, left eye/right
eye, multiview 5 images, multiview 9 images).
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»

»

»

»

»

»

Compression Quality: Sets the compression quality of an image in percent,
standard value is -1 for no compression. Only useful for image formats that
define a compression quality like jpeg.

Export Image with Alpha Channel: Activates alpha channel rendering. The al-
pha channel will be embedded into the resulting image, if the file type supports
alpha channels. The alpha channel colour can be selected separately.

Show Rendered Image After Saving: Opens a seperate window showing the
rendered image.

Single Image Viewer Window: Shows only one image after rendering.

Ignore Aspect Ratio: Squashes or stretches the rendered image and ignores the
aspect ratio.

Export TIFF in HDR format: Renders TIFF format with 32 Bits per channel.

» Animation

»

»

»

»

N~

>

Start Frame: Sets the start frame of the sequence to be rendered.
Stop Frame: Sets the end frame of the sequence to be rendered.

Frames per Second: Sets the frame rate for the image sequence.

Resolution: Sets the default resolution for the animation.

Export Type: Defines the default export type for the animation.

4.14.2 General Settings

» Antialiasing

»

Max Image Samples: Sets the number of samples taken during stillframe an-
tialiasing. Higher values produce a cleaner result while lower values reduce the
render time. A value of 256 is recommended as starting point in general but
may be too low for interieur scenes with full global illumination.
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» Adaptive Sampling: Adaptive sampling allows the raytracer to skip regions that
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are already smooth and focus the processing power on regions that are still
noisy. The various quality settings control a threshold for a region to be con-
sidered as smooth. Setting the control to “Highest Quality” disables adaptive
antialiasing and always samples each pixel with the number of image samples
specified. While this gives the highest render quality it may waste processing
power on regions that are already smooth.

e Preview Quality: Sets the sampling quality to a very low level, resulting in
preview render quality and very short render times.

e Low Quality: Sets the sampling quality to low level, resulting in average
render quality and short render times.

e Medium Quality: Sets the sampling quality to medium level, resulting in
good render quality and medium render times.

e High Quality: Sets the sampling quality to high quality level.
e Ultra High Quality: Sets the sampling quality to production quality level.

Use Clamping Value: Activates clamping of very bright pixels to eliminate white
spots after antialiasing. The value sets the maximum value for a white pixel.
Activating clamping and reducing the value reduces the maximum resulting
image color range.

» Pixel Filter A pixel filter weights the image samples taken per pixel and therefore

controls the antialiasing quality of the rendering. High image filter sizes may
result in blurry image results.

» Filter: VRED offers seven filter-algorithms for sampling: Box, Triangle, Gaussian,

Mitchell Netravali, Lanczos, BSpline and Catmull Rom.

» Size: The pixel filter size defines the number of neighboring pixels in width and

height taken into account for filtering.

» Features

78



» Monitor Luminance (cd/m?): This parameter is used to set up the luminance
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value of the preferred display. When using photometric parameters, the actual
monitor luminance is necessary to reproduce the rendering results with realistic
photometric values on the display device.

Enable Photometric Parameters: Use photometric parameters as preferred mode.
The setting does not apply to the current scene, only to newly generated
scenes. For a description of photometric consistent rendering, please read the
chapter on Render Settings.

Optimize for Many Light Sources: Enables the optimization for many light
sources when rendering an image.

» Sim2 HDR
» Luminance Mapping: Sets the luminance mapping for the Sim2HDR display, if

photometric parameters are enabled. A value of 1 maps a luminance value of
1 cd/m? in the rendering to a value of 1 cd/m? on the Sim2HDR display.

4.14.3 Raytracing Quality

» lllumination Mode Sets the default lighting mode for materials for interactive and
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still frame antialiasing.

Precomputed Illumination: The Precomputed lllumination mode is comparable
to VRED OpenGL rendering mode. It uses precomputed ambient occlusion
and indirect illumination for rendering and calculates specular reflections and
refractions and correct shadows from light sources.

Precomputed + Shadows: The Precomputed + Shadows Mode uses precom-
puted image based lighting and indirect illumination but doesn’t use precom-
puted Ambient Occlusion values. Instead it calculates shadows based on the
active environment.

Precomputed + IBL: The Precomputed + IBL Mode uses precomputed indirect
illumination and samples the environment. It replaces the old Fast Global Illu-
mination mode.
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»

Full Global lllumination: The Full Global lllumination Mode doesn’t use any
precomputed values but accurately samples the global lighting distribution in
a physically-based approach. Please note that other features like Photon Map-
ping require the render mode to be set to Full Global Illumination.

» Photon Tracing Photon Tracing is an approach to calculate the global illumina-
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tion in a scene. The default full global illumination mode in VRED provides
high quality results but may require longer calculation times. Photon Tracing
can reduce the time required to render a clean image by a larger margin, espe-
cially in indoor scenarios like car interieurs or architectural indoor scenes. VRED
allows different Photon mapping modes.

Mode:

e Off: Disables Photon Tracing and uses the default full global illumination
algorithm in VRED.

e Indirect Only: Uses photon tracing to calculate the indirect illumination in
a scene. This is the most common mode.

e Caustics + Indirect: Uses Photon Tracing to calculate indirect illumination
and caustics due to specular materials in a scene.

Interactive/Still Frame Count: The two photon count values specify the number
of photons being sent into the scene for each image sample. Specifying a
photon count of 100.000 photons while having set the image samples set to
256 will result in 25.600.000 photons send into the scene for a frame. More
photons result in smoother results.

Lookup Radius: The lookup radius specifies the radius around a scenes'’s hit-
point used by the raytracer to find photons around the hitpoint. A larger ra-
dius allows the raytracer to find more photons but may result in slower lookup
times.

Final Gather Quality: There are two ways to use the photon map. The first ap-
proach is always used for caustic photons. It gathers photons around a hitpoint
to calculate the incoming illumination. This approach gives very fast interactive
performance and is capable to calculate all light pathes in a scene, but it may
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require a very high photon count to get a clean image. The other approach
is to use final gathering. In final gathering a one bounce indirect illumination
is performed before evaluating the Photon Maps. This is the default Photon
Tracing approach in VRED since it generates high quality images in a very short
time. Setting the final gather quality to “"Off” enables the first approach while
setting it to any other value uses the second approach.

Final Gather Radius: Sets the lookup radius used to find the nearest final gather
point during raytracing. Using a smaller radius will increase performance but it
requires more photons to avoid dark regions.

Final Gather Refresh: Setting the Final Gather Quality to 1 or higher, the update
frequency of the Photon Map may be set. By default the Photon Maps are
updated for each image sample, sending a large number of photons into the
scene. While this is necessary if final gather quality is set to "Off”, it is often
sufficient to update the Photon Map only once per frame and use it for each
image sample to reduce the render times.

e On Each Sample: This updates the Photon Map for each image sample.
This is the default setting since it also works for scenes with animated
objects that may cause flickering otherwise.

e On Scene Change: The Photon Map is updated once per frame unless
motion blur is activated. Since caustics require many photons, the Caustic
Map will still be updated for each sample while the indirect illumination
Photon Map will only be updated once. This setting often results in the
best rendering performance but requires a much higher photon count to
receive artefact-free results, particularly when rendering scenes with ani-
mated objects, the result may flicker in regions with a low photon count.
This is why this mode should only be used for scenes with static geometry
and materials.

Use Final Gather for Glossy Reflections: If activated, glossy reflections are not
evaluated by path tracing but use the final gather map instead. This reduces
the rendertime but results in less accurate reflections.
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4 PREFERENCES

» IBL Sampling Quality

» Interactive: Sets the interactive IBL sampling quality.
» Still Frame: Sets the still frame IBL sampling quality.

» Reflection/Refraction Sampling Quality

» Interactive: Sets the interactive sampling quality of reflections and refractions.
» Still Frame: Sets the still frame sampling quality of reflections and refractions.

» Trace Depth

» Interactive: Sets the interactive trace depth settings.
» Still Frame: Sets the still frame trace depth settings.

» Photon Tracing Notes and Tips Photon Tracing has its main advantages in inte-
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rior scenes. In exterior scenes most of the light illuminates the scene directly,
the default full global illumination mode in VRED shows the best performance
in this case.

Be aware that the number of photons emitted doesn’t resemble the number of
photons actually stored. If a photon misses the scene it will not be stored. A
photon bouncing several times in a scene might be stored more than once. To
keep the number of emitted photons as low as possible, place any light emit-
ters in a way that most photons will hit the scene.

When using Final Gathering, scenes may suffer from light leaks if the photon
radius is set too large. Light leaks mainly result from bad geometry in architec-
tural scene. An example would be the interior of a room illuminated through
a window, the walls being modelled as simple planes. Any geometry near the
wall would get light from outside the room since there is no actual thickness
of the wall. The solution would be to actually model the outer walls as well.
Reducing the lookup radius may also fix the problem but may require shooting
more photons into the scene.

Final gathering may also show problems in scenes with very strong indirections
where the scene is primarly illuminated by light resulting from reflections of a
wall. In these situations disabling final gathering may give you a cleaner result.



4.14.4 Advanced

» Cluster

»

»

Enable: Enables/disables the cluster mode.

Hostnames: Defines the hosts to be used to render the scene (Default: "local-
host”).

» Snapshot

»

Path: Sets the file path where the snapshot will be saved.

» Signature

»

»

»

»

»

»

»

»

Add Signature: You can add a signature to each video or image. The format
for a signature is filename - date - time - comment.

Position x/y: The position of the signature in pixels from the lower left corner
of the image/video.

Font Size: The font size in pixels of the text in the signature.
Color: Defines the font color.

Comment: If you want to add an additional comment to your signature, just
enter the text here.

Add Filename: The filename of the image/movie will be added to the signature.

Add Date: The date the image/movie was rendered will be added to the signa-
ture.

Add Time: The time the image/movie was rendered will be added to the sig-
nature.

4.15 Script

In the Script Editor, scripts or script commands can be entered. They will be executed
on each startup. For further information, please refer to the VRED Python Documen-
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tation found in Help » Python Documentation

4.16 Selection

» Base

» Bounding Box Visualization Size: Defines a minimal bounding box size for ob-
jects of size 0.

» LOD Selection: If the geomtry is a child of a distance LOD node, selecting a
geometry node in the render window will automatically select all children of
the distance LOD node.

» Auto Scroll to Selected Node: Selecting a geometry node in the render window
will automatically scroll in the scenegraph view to the selected node.

4.17 Tracking

» Base
» Default Config File: Offers the possibility to define the default config file.

4.18 Transform

» Transform Step Sizes
» Translation Step Size: Sets the default step size for translation actions.
» Rotation Step Size: Sets the default step size for rotation actions.

» Scale Step Size: Sets the default step size for scaling actions.
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4.19 Weblinterface

» Base
» Enable Web Server: Activates the VRED Professional internal web server.

» Port: Specifies the port number the VRED Professional web server listens to.
The port number is set to 8888 by default.

» Enable Debug Mode: Activates the debug mode of the VRED Professional web
server.
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The Scenegraph shows all the nodes constituting the current scene in a tree struc-
ture. Different icons indicate the node types existing in the scene. Imported files
are marked in green. The basic node, at the same time the parent node of all other
nodes in each VRED scene, is the Root node. The Root node is a group node. The
Root group is the top node of each VRED file and cannot be deleted, renamed or
otherwise edited. All additional nodes must be children of the Root node. Use the
built-in search field at the top of the Scenegraph to find nodes. Regular expressions
are supported.

» Mouse actions in the Scenegraph

Rename: Click the selected node with the left mouse button to rename the
node.

P

T

Open node graph: Double-click the selected node with the left mouse button
to expand the tree of the respective node. All the direct children of the selected
node will be displayed.
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Move objects in Scenegraph: Click and drag a node with the left mouse button
to move nodes in the Scenegraph.
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Isolated view: Click and drag a node with the left mouse button from the
Scenegraph into the Renderview to view only the respective objects in the Ren-
derview. To view the whole scene again, drag the Root node into the Ren-
derview.
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Open Scenegraph menu: Click a node in the Scenegraph with the right mouse
button to open the Scenegraph menu.
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Selection paths: When selecting a node within the Scenegraph, all its parent
nodes will be marked light blue to simplify the navigation through the tree.
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Split Scenegraph: At the bottom of the Scenegraph window, a splitting tool
is indicated by a dotted line. Click and drag the splitter with the left mouse
button to expand or reduce the size of the split view windows. The Scene-
graph split view aids you in navigation, selection and the whole process of
data preparation. Drag the splitting tool back into the dock to close the split
view.
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5.1 Create

All functions in the "Create” menu add additional nodes to the scene. Generated
nodes are added as children to the currently selected node. If no node is selected,
the new node will be a child of the Root node.

» Create Geometry Offers you to create one of the following geometric primitives:

» Line: A line geometry will be rendered as a capsule in raytracing, this is a tube
capped with half-spheres on both ends. The radius of the tube can be speci-
fied for each material individually (see Materials Reference » General Truelight
Material Settings » Raytracing » Line Tube Radius).

» Plane
» Box
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Cylinder
» Cone
» Sphere
» Torus

» Create Light Allows you to quickly create lights. Choose from the following:

» Directional Light: Creates a directional light node. A directional light is a light
source, which casts parallel light rays.

» Point Light: Creates a point light node. A point light is a rotationally symmetric
light source, which casts light rays from a single point into all directions.

» Spot Light: Creates a spot light node. A spot light is a light source, which casts
light rays from a single point preferably into a specific lobe.

» Create Camera Allows you to quickly create a camera. Choose from the follow-
ing:
» Perspective Camera: Creates a new perspective camera.
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5.1 Create

» Orthographic Camera: Creates a new orthographic camera.
» Viewpoint: Creates a viewpoint from the current view.

» Group Creates a group node. To move, scale or rotate multiple objects as one unit
it is recommended to combine them to a group. Transformations can then be
carried out on the whole group.

» Clone Creates a clone node. Clone nodes create an exact copy of the node that is
dropped onto it.

» Matrix Transform Creates a matrix transformation node. A matrix transformation
node holds independent translation and transformation information. You can
use this kind of node to reuse positions and transformations of an object to be
applied to other structures.

» MaterialGroup Creates a MaterialGroup node. All nodes which are children of a
MaterialGroup node, receive a material override flag. Even when maintaining
their initial material assignment, they will be shaded with the material assign-
ment of the MaterialGroup as soon they are added as children to the Material-
Group node.

» Environment Creates an Environment group node. The Environment node allows
you to logically sort your environment geometries.

» Switch Creates a Switch node. Switch nodes set only one of their children visible.
The child to be set visible can be selected under Scene » Node Editor. Switches
can also be controlled in the Variants and the Variant Set Module.

» StereoSwitch Creates a StereoSwitch node. A StereoSwitch node can draw the
first two children independently of each other. While the first child is drawn
on the left eye channel, the second child is drawn on the right eye channel. To
activate the StereoSwitch, select a preferred stereo render mode.

» HostSwitch Creates a HostSwitch node. HostSwitch children can be rendered on
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5 SCENEGRAPH

any dedicated host computer. To enter the name of the host computer, select
Scene » Node Editor » hostname.

» Billboard Creates a Billboard node. A Billboard node aligns its children to the
camera.

» ClipPlane Creates a ClipPlane. A ClipPlane is a border behind which objects will
be clipped. All objects which are children of the ClipPlane will be affected by it.
To move the ClipPlane independent of its children, select Scene » Node Editor
» beacon and enter the ComponentTransform ID.

» DistanceLOD Creates a DistanceLOD node. With a DistanceLOD node, the chil-
dren to be rendered can be exchanged depending on the distance between
the object and the camera. Usually the DistancelLOD is applied to reduce the
level of detail of the geometry when the camera is far away from an object and
to increase the geometry details when the camera is close to it by switching
between different geometries. This keeps the frame rate high. To set up which
child should be drawn for which distance range, open the Scene » Node Edi-
tor and edit the range property. If the DistanceLOD node has N children, you
should specify N-1 range values (comma separated floating point values are
accepted). Each value constitutes a distance threshold between two adjacent
ranges corresponding to a specific level of detail.

» Sound Creates a Sound node. With a Sound node, sound files can be embedded
into a scene. To enter the source of a sound file, select Scene » Node Editor »
SoundFile.

» SoundObstructor Creates a SoundObstructor node. A SoundObstructor node
mutes a sound file, when the corresponding Sound node is covered by the

SoundObstructor in the Renderview.

» Custom Creates custom nodes. Enter the custom node type.
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5.2 Edit

» Rename Renames the selected node. Enter new node name. CRTL + R.
» Delete Deletes the selected nodes. DEL.

» Filter Deletes the selected node without deleting the scene structure underneath
the selected node (i.e. the subtree).

» Copy Copies the selected node and temporarily stores the node and its subtree in
the memory (i.e. the clipboard). CRTL + C

» Cut Cuts the selected objects from the Scenegraph and temporarily stores the node
and its subtree in the clipboard. CRTL + X

» Paste Pastes the nodes currently stored in the clipboard into the Scenegraph. CRTL
+V

» Paste Clone Pastes the nodes currently stored in the clipboard as clones into the
Scenegraph. The clones are also known as referenced objects. Referenced
objects are indicated by an underline. CRTL + SHIFT + V

» Copy Transformation Copies all transformation information from the selected
node to the clipboard.

» Paste Transformation Pastes all transformation information from the clipboard
to the selected node.
» Paste All: Pastes all transformation information.
» Paste Translation: Pastes only translation information.
» Paste Rotation: Pastes only rotation information.
» Paste Scale: Pastes only scaling information.
» Paste Pivots: Pastes only pivot information.
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5 SCENEGRAPH

» Copy Animations Copies the curve animations from the selected node to the clip-
board.

» Paste Animations Pastes the curve animations from the clipboard to the selected
node.

» Paste Clone Animations Pastes the curve animations from the clipboard to the
selected node as a reference. Whenever you make changes to the referenced
animation, those changes will take effect on the selected node.

» Clone Using the clone function, objects can be duplicated in the scene. A new
node structure will be created for each copy. When manipulating a clone (e.g.
transforming it or assigning a material to it) all other instances are automatically
updated. Clones are referenced objects that are indicated by an underline in
the Scenegraph.

» Clone: Generates a referenced clone from the selected node(s).
» Clone Mirror X/Y/Z: Mirrors the cloned object at the selected axis.
» Duplicate Duplicates an object. This process requires more memory than cloning

an object. Unlike a clone, a duplicated object does not reference the source
object.

» Duplicate: Duplicates the selected node(s).

» Duplicate Mirror X/Y/Z: Duplicates the selected node(s) and mirrors them at the
preferred axis.

» Duplicate Mirror X/Y/Z Flush: Duplicates the selected node(s), mirrors them at
the preferred axis and flushes the transformation information.

» Unshare Removes a referenced connection. Referenced objects are indicated by
an underline.

» Merge Geometry Merges separated geometries to a single mesh. CRTL + M
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» Preconditions for merging objects: The objects are unshared (not referenced!),
they have the same materials and lie in the same group.

To merge objects, select the parent groups.

» Split Geometry Splits the selected object into several meshes. A dialogue box
opens. Set the maximum number of triangles each resulting mesh may have.

» Split Geometry into Primitives Splits the selected objectinto triangles. This func-
tion is much faster than the split geometry function. CRTL + SHIFT + T.

» Unsplit Geometries with One Triangle Merges all triangles which are children
of the selected node. This function is much faster than the merge geometry
function. CRTL + SHIFT + T.

» Subdivide Geometry Subdivides the selected geometry into more triangles result-
ing in a finer mesh. A dialogue box opens.

» Subdivision Mode: You have the following choices:

e Standard: Each polygon is subdivided until the edge lengths fall below the
maximum edge length threshold.

e Phong Interpolation: Each edge of a polygon is subdivided right in its
center and the position of the new vertices is calculated by means of phong
interpolation. The results are smoother surfaces which also redefine the
silhouettes. Caution: In some cases, hard edges result in gaps in the
geometry.

» Iterations: This attribute describes the number of iteration used for phong in-
terpolation. The value "1’ generates 4 triangles per triangle, ‘2’ generates 16
triangles per triangle, '3’ generates 64 triangles per triangle and ‘4" generates
256 triangles per triangle.

» Max edge length: This value describes the maximum edge length threshold,
below which an edge is no longer subdivided.
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5 SCENEGRAPH

» Group by Material Groups the objects of the Scenegraph by assigned materials.
Caution: The whole Scenegraph structure will be rearranged.

» Group Selection Groups selected objects. A new group node will be created and
all selected objects will be attached as children to the new node.

» Show Optimize Module Opens the Optimize Module. The optimize functions
help to optimize the scene and thereby increase the rendering performance. All
optimization processes will be applied to the selected nodes and their children.

5.3 Convert To

» Group Converts the selected node to a Group node.

» Matrix Transform Converts the selected node to a Transform node.
» MaterialGroup Converts the selected node to a MaterialGroup node.
» Switch Converts the selected node to a Switch node.

» StereoSwitch Converts the selected node to a StereoSwitch node.

» HostSwitch Converts the selected node to a HostSwitch node.

» DistanceLOD Converts the selected node to a DistanceLOD node.

» Custom Converts the selected node to a custom node.

5.4 Additional Options
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» Reload File The external file referenced by the selected node is reloaded.

Before reloading starts you are asked whether you want to keep the current
materials. If not, the original materials from the file are applied to the reloaded
geometry. If yes, VRED transfers all material assignments of the node that is
reloaded to the new node that is created during reload. This transfer relies on a
consistent naming scheme of the nodes within the hierarchy of the loaded file.
If some material assignments could not be restored a message will be displayed
that lists all nodes for which no material assignment could be restored. Select-
ing “Show Reload Log...” in the menu also shows this message (only available
for the last reload action).

» Replace File... The external file referenced by the selected node may be replaced
by another file. After having chosen this new file the node is automatically
reloaded, as with Reload File.

» Reload All Files All external files referenced by the nodes in the Scenegraph are
reloaded.

» Hide Hides the selected nodes in the Renderview. This is also performed by uncheck-
ing the box left to the name of the node.

» Show Shows the selected nodes in the Renderview. This is also performed by
checking the box left to the name of the node.

» Hide Subtree Hides the subtree of the selected node in the Renderview.

» Show Subtree Shows the subtree of the selected node in the Renderview.
» Hide All Hides all objects in the Renderview.

» Show All Shows all objects in the Renderview.

» View Selected Opens a new Render Window to render the selected objects in an
isolated render mode.
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» Select All Selects all the children of the Root node.

» Deselect All Deselects all nodes.

» Select Subtree Selects all subtree nodes.

» Select Parent Selects the parent node of the selected object.

» Invert Selection Deselects all currently selected objects and selects all currently
deselected objects.

» Find A search process can be executed to find nodes in the Scenegraph. A dialogue
box will open.

» Expression: Enter a search expression to find a node. Regular expressions are
supported as search entry when Regular Expression is activated.

» Node Type: Sets a filter to specify the node type for the search process.
» Action: Sets the action to be executed for the objects found.
e Select: Selects all objects found.
e Add to Selection: Adds all objects found to current selection.
e Sub from Selection: Removes all objects found from current selection.

I~

» Regular Expression: Activates the use of regular expressions. Deactivate to
search for strings.

» Scroll to Selected Scroll the Scenegraph view to the selected node.

» Information A dialogue box will open containing all the information about the
node.

» Scenegraph Slider The Scenegraph slider is placed at the bottom of the Scene-
graph. Sliding the Scenegraph slider to the right expands the next tree level
of the Scenegraph structure for the selected node with every step. Sliding the
Scenegraph slider to the left closes a tree level with every step.
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Modules



6.1 Scene

6.1.1 Camera Editor

Scene » Camera Editor

In the Camera Module, all 3D camera parameters can be set.

» File
» Load: Reads stored data from disc.
e Cameras: Import stored cameras from an .xml file.
e Viewpoint: Import stored viewpoints from an .xml file.
» Save: Writes selected data to disc.

e Cameras: Export all the cameras in the scene to an .xml file.
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e Viewpoint: Export all the viewpoints in the scene to an .xml file.

e Selected: Export the seleced objects to an .xml file.

» Camera Settings
» General:

e Projection Mode: This menu sets up the projection mode of the projection
matrix for the selected camera.

- Perspective: In the perspective mode, the current scene is rendered in
perspective projection view. This mode is the most natural way of image
reception.

- Orthographic: In the orthographic mode, the current scene is rendered
in parallel projection view.

- Spherical Map, Peters Map, Vertical Cross, Horizontal Cross: Renders
the current scene with a 360° environment projection. To use one of
these modes, create a new Perspective Camera, activate it and choose
the desired projection mode. Please note that these projection modes
only take effect when raytracing is activated.

e Wireframe: Renders the selected camera view in wireframe mode.

e Depth of Field: Activates or deactivates the depth of field function. With
activated depth of field you have access to the FStop settings in the Lens
Attributes.

e Motion Blur: Activates or deactivates motion blur. With activated motion
blur you have access to the shutter settings in the Lens Attributes.

e Position: Sets the 3D coordinates for the camera position.
e Roll: Sets the roll angle for the current camera.

e Field of View: Sets the field of view angle of the camera, measured in
degrees. You can switch between horizontally and vertically defined FOV
via Lens Attributes » Field of View Mode. The Field of View parameter is
directly connected to the focal length parameter.
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» Viewing: There are two ways of defining the view. On the one hand, the
view is definable using the attributes “Position”, “At” and "Up”. On the other

"o

hand, the view can be set with the parameters “Distance”, “Height”, “Turntable
Angle” and "Distance to Center”. Both methods determine the position and
the orientation of the camera. They are interdependent and influence each
other.

Use Parent Transformation: Overrides the viewing settings. Always uses
the transformation settings of the parent node in the scenegraph.
Important: Now the camera is locked for mouse-navigation. The only way
to move your camera is by transforming the parent node. This feature is
useful for classic camera animation with regard to simple translation and
rotation.

At: Sets the coordinates for the center of interest (Col).

Up: Sets the coordinates for the up vector to define the direction that is
oriented up in the scene.

Update: Updates the render view to the entered values.

Distance: Sets the distance between the camera and the Col.

Height: Sets the height regarding Col and distance.

Turntable Angle: Defines the vertical angle related to the focus point.

Distance to Center: Defines the distance to the midpoint of the bounding
box of your currently selected object.

» Lens Attributes:

Field of View Mode: Defines whether the angular Field of View is specified
horizontally or vertically.

Focal Length: Sets the focal length of the virtual objective in millimeter
depending on the given sensor height and field of view.

Sensor Presets:
- 1/3.6" (4.000 w, 3.000 h)
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- 1/3.2" (4.536 w, 3.416 h)

- 1/3" (4.800 w, 3.600 h)

- 1/2.7" (5.371 w, 4.035 h)

- 1/2.5" (5.760 w, 4.290 h)

- 1/2.3" (6.160 w, 4.620 h)

- 1/2" (6.400 w, 4.800 h)

- 1/1.8" (7.176 w, 5.319 h)

- 1/1.7" (7.600 w, 5.700 h)

- 2/3" (8.800 w, 6.600 h)

- 1" (12.800 w, 9.600 h)

- 4/3" (18.000 w, 13.500h)

- 1.8" (23.700 w, 15.700h)

- 35mm film (36.000 w, 24.000h)

Sensor Size: Sets the sensor width and height in milimeters.
Aperture Diameter: Sets the aperture diameter in millimeters.

FStop Presets:
/1, 1/1.4, 1/2, /2.8, 1/4, 1/5.6, /8, 1/11, 1/16, /22, /32, /45, 1/64, /90,
/128

FStop: Defines the FStop in f/x.
Focus Distance: Sets the focus distance in millimeters.

Shutter Presets:
1/1000, 1/500, 1/250, 1/125, 1/62, 1/30, 1/15, 1/8, 1/4, 1/2, 1", 2", 4",
8", 16", 32", 64"

Shutter Speed: Defines the shutter speed in 1/s.

» Clipping:



e Near Plane: Sets the distance between the near ClipPlane to the camera
measured in millimeters. All objects closer to the camera than the near
ClipPlane will not be rendered.

e Far Plane: Sets the distance between the far ClipPlane to the camera mea-
sured in millimeters. All objects further away from the camera than the
far ClipPlane will not be rendered.

e Calculate Plane: Calculates near and far plane values based to the bound-
ings of the current scene.

» Image Processing

» Tonemapping: Tonemapping offers the possibility to map the high dynamic
range rendering for display on an output device with lower dynamic range.

e Tonemapper: Choose an algorithm to adjust the appearance of a 32-bit
rendering. General parameters:

- Reinhard Luminance: Uses the tone mapping methods based on Erik
Reinhard’s methods. The tone mapping takes place based on the lumi-
nance values of a pixel. This way you retain the color information of a
pixel.

- Reinhard RGB: Uses the tone mapping methods based on Erik Reinhard’s
methods. The tone mapping takes place for each channel of an RGB
pixel separately. Therefore, the bright pixels will be desaturated, as with
a digital camera sensor.

- Logarithmic Luminance: Uses a logarithmic mapping based on the lumi-
nance values. This mapping corresponds approximately to the human
perception. The color information will remain unchanged.

- Logarithmic RGB: Uses a logarithmic mapping that affects each channel
of an RGB pixel separately. Bright pixels will be desaturated.

- Filmic: Uses an s-curve mapping that reproduces the behavior of a pho-
tographic film. RGB channels will be mapped separately. Two parame-
ters control the shape of the s-curve:
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- Shoulder Strength: Controls the gradient in the area of bright pixels.
- Toe Strength: Controls the gradient in the area of the dark pixels.

- Physical Camera: Enables the option to work with physical values like
Fstop, Shutter Speed and ISO to control the tonemapping of the im-
age. Additionally, presets of response camera curves can be loaded and
edited to adjust the appearance of the rendering. Keep in mind that the
amount of motion blur and depth of field will be affected by these val-
ues, and that a change of the focal length will affect the exposure of
the rendering.

e Exposure: Scaling factor for the luminance of the image.

e Whitepoint: Sets the luminance value, which is mapped to the value 1 (i.e.
the maximum luminance of the display device).

e Whitebalance: Defines the whitebalance value that affects the image in
the post-processing procedure.

» Blending: VRED provides different modes of blending.
e Off: No blending.

e Vignette: Renders a vignette on top of the rendering. A Vignette darkens
the corners of an image.

- Amount: Sets the opacity of the vignette. The amount can be used to
control the darkness of the vignette.

- Radius: Sets the radius of the vignette.

- Roundness: Sets the shape of the vignette. A roundness of Zero indi-
cates that the ellipse will fit the render resolution

- Feather: Defines how blurry the Vignette will be.

e Image: Multiplies a texture on top of the rendering. Can be used for
texture overlays.

- Amount: Sets the opacity of the image.
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- Left and Right Eye Blending Map: Allows the use of blending textures
at pixel level. At a final pass the input image is multiplied with the
rendering. In stereo mode it is possible to define different images for
left and right eye.

» Color Correction:
e Hue-Shift: Defines the hue-shift value.
e Saturation: Sets the color saturation.
e Contrast: Sets the overall contrast.
e Brightness: Sets the overall brightness.
» Glow and Glare:
e Use Glow: Enables/disables glow.

e Glow Threshold: Determines the threshold of the brightness of a pixel
where the glow effect sets in.

e Glow Size: The glow size determines the size of the glow surrounding an
object.

e Glow Intensity: The glow intensity determines the brightness of the glow.
e Use Glare: Enables/disables glare.

e Glare Threshold: Determines the threshold of the brightness of a pixel
where the glare effect sets in.

e Glare Size: Determines the size of the glare.
e Glare Intensity: The glare intensity determines the brightness of the glare.

e Glare Streaks: Streaks determine the maximum count of streaks. Higher
values appear like stars.

e Glare Rotation: Streaks can be rotated in a specified angle.

» Advanced

» Intrinsic Parameters: Here, the intrinsic parameters are definable for the cam-
era.
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e Principal Point Offset:
- x-Offset: Sets the x-Offset. The view itself is not affected by this setting.
- y-Offset: Sets the y-Offset. The view itself is not affected by this setting.
e Skew Factor: Defines how much VRED skews the view.
» Animation:

e Animate Camera Change: Turn on/off camera change animation. Camera
parameters are smoothly interpolated when switching to a viewpoint that
has this option activated.

e Duration: Sets the duration of the animation in frames.
» Manual Projection:

e Use Manual Frustum: Activates or deactivates the custom frustum set-
tings.

e Sides (L, R, T, B): Definition of the camera projection through a frustum
based on the sides Left, Right, Top, and Bottom.

e Update: Updates the render view to the values entered.

e Use Manual Projection Matrix: Activates or deactivates the custom pro-
jection matrix.

e Update: Updates the render view to the values entered.
» Distortion Map:
e Use Distortion Map: Activates or deactivates the distortion map.

e Left and Right Eye Distortion Map: Allows the use of a distortion texture
at pixel level. The texture describes the course of the normalized XY-image
coordinates. The input texture is an EXR-image. The red channel describes
the course of the X-image coordinate. The green channel describes the
course of the Y-image coordinate. The origin (0,0) is at the bottom left
corner.



6.1.2 Light Editor

Scene » Light Editor

The Light Editor provides all the functions for creating and manipulating the light
sources available in VRED. It contains a list of all the light sources in the scene. After
selecting one of the light sources from the list, the parameters like the name, color
or intensity are editable.

The headlight is the only light source generated by default. It will be disabled auto-
matically when new light sources are created. In case the headlight is to be used in
combination with other light sources, it has to be activate in the Light Editor or with
the "Toggle headlight” button in the toolbar of the main window.

Three different basic light types are available in VRED:

» Directional Light A Directional Light is a light source whose origin is infinitely far
away from all points in the scene. Therefore, its light rays are always parallel.
This light type is often used to simulate outdoor lighting like sunlight.

107



» Spot Light A Spot Light is the most common light source to illuminate a scene. It
emits light within a cone that is described by two angles: a cone angle defining
the areas with hard light and a penumbra angle defining the areas with soft
illumination.

» Point Light A Point Light emits light from a given position uniformly to all direc-
tions.

Each light source consists of two entries in the Scenegraph: a light source node and
a light transformation node. Double-clicking on a light source in the Light Editor
selects its corresponding light source node in the Scenegraph. Its position in the
graph defines which geometries are lit by the light if Local Lighting (see below) is
activated for it. By default, the other node that stores the light transformation is a
child node of a special group node called “LightTransforms” which contains all light
transformation nodes. It is only visible in the Scenegraph if Show Internal Nodes is
activated in the Preferences: Edit » Preferences » MainWindow » Show Internal Nodes
in Scenegraph. The transformation node of a light source called “LightName” has the
name “LightNameTransformGroup”. You may reposition this node in the Scenegraph
structure.

» Properties
» Name: Sets the name for the selected light.

» Type: Changes the light source type.

» Local Lighting: Activating this feature provides light sources to function as a
local light. Only geometry inside the light source node will be lit. This enables
the user to set a more sophisticated lighting of the scene.

» Enabled: If checked, the light source is active and emits light. If unchecked,
the light source is inactive and doesn’t emit any light.

)
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Intensity: Changes the light intensity. Higher values result in brighter lighting.

» Ambient: Defines a light's ambient color. This is the color in dark areas of an
object. This is usually the color where no light is received.
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» Diffuse: Diffuse color is the color of light of a diffuse reflection (characteristic for
light reflected from a dull, non-shiny surface). A diffuse color attribute specifies
the color of the light diffusely reflected by the objects to which it is assigned.

I~

» Specular: Specular color is the color of the light on shiny surfaces.
» Use Temperature: Enables or disables the color selection by temperature.

» Temperature: Changes the color temperature.

>

» Spotlight and Pointlight specific parameters:

e Light Attenuation: Sets the falloff of the light intensity. Three values are
available:

- None: Light intensity of light is constant in relation to the distance of
light.

- Linear: Light intensity decreases linearly in relation to the distance of
light.

- Quadratic: Light intensity decreases quadraticly in relation to the dis-
tance of light.

» Spotlight specific parameters:

e Cone Angle: Light beam’s angle from one edge to the other measured in
degrees.

e Penumbra Angle: Controls the light edge’s falloff in degrees. This can be
a positive or negative value. /n case of a positive value, the falloff occurs
from the edge of the light determined by the cone angle, outward by
the penumbra angle. Therefore, if the Cone Angle is set to 30° and the
Penumbra Angle is set to 5°, the light has a total angle of 40° (30° + 5°
+ 5°, that is 5 degrees on each side). The beam’s falloff would begin at
30 degrees and would fall off to an intensity of 0 at 40 degrees.

» Shadow Intensity: Changes the intensity of casted shadows.

» Map Resolution: Sets the quality for OpenGL shadow maps. Higher values
increase the quality.
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»

»

Cast Shadow on Shadow Material: Enables/disables to casts a shadow on the
special shadow material.

llluminate Shadow Material: When activated, the light source illuminates the
shadow material. The shadow material needs to have its reflection mode set
to "Diffuse Only”, “Glossy Only” or “Diffuse + Glossy”.

» Area Light
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Enable: Enables/disables the two-dimensional extent of the light source to sim-
ulate soft shadows.

Shape: Defines the shape of an area light.

Attenuation Mode: Sets the falloff of the light intensity. “Realistic Attenuation”
is simulated by computing the view factor between the illuminated surface
and the light source, “Custom Attenuation” uses the "“Light Attenuation” mode
from the "Properties” frame.

Primary Visibility: Enables/disables the primary visibility of the light source in
the rendering.

Visible in Reflections: Enables/disables the visibility of the light source in reflec-
tions.

Interactive Quality: Sets the quality for Interactive rendering. Selecting a higher
value results in a higher number of shadow rays for this light source and thus
in a higher quality and a lower rendering performance.

Still Frame Quiality: Sets the quality for Still Frame rendering.

» Light Profile IES light profiles are standardized light emission data sets with cor-

»
»

»
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rect physical light attributes. Those profiles simulate correct light falloff and
intensities.

Use Light profile: Activates/deactivates the use of light profile.
IES Profile: Specifies the path to a IES profile.

Set Profile Shape: Automatically sets the shape of the light geometry to the
defined shape within the IES profile.



» Ray File Ray Files contain the simulated spatial and angular distribution of emitted
light from a complex light source.

» Use Ray File: Activates/deactivates the use of a ray file.
» Ray File: Specifies the path to a ray file.

» Use Random Samples: Choose rays randomly rather than in round robin order
from the ray file. This is especially helpful for files containing rays from multiple
light sources.

» Visualisation

» Show All Lights: Unhides all available light source geometries in the scene for
visual feedback and interactive transformation actions like scaling, rotation and
translation.

» Hide All Lights: Hides all available light source geometries in the scene.

» Show Light: Unhides selected light source geometry in the scene.

» Hide Light: Hides selected light source geometry in the scene.

» Scale: Scales the light source geometry in the scene for better visual feedback.

» Transform
» Position:

e Get from Camera: Sets the light position and direction to the current cam-
era position and direction.

e Apply to Camera: Sets the camera position and direction to the current
light position and direction.

e Get from Node(s): Uses the transform properties of the selected geometry
for the selected light. This way the positioning of the light is very fast.

» Flush Matrix:
e Flush: Resets light settings.

» Additional context menu
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»

»

»

Right mouse context menu » Create: Creates new light sources (directional,
point and spot light).

Ctrl + R/ Right mouse context menu » Rename: Renames the currently selected
light source.

Ctrl + D / Right mouse context menu » Duplicate: Duplicates the currently se-
lected light source.

Del / Right mouse context menu » Delete: Deletes the currently selected light
source.

Ctrl + A / Right mouse context menu » Select All: Selects all available light
sources in the stack.

Ctrl + Shift + A/ Right mouse context menu » Deselect All: Removes the selec-
tion on all light sources.

Ctrl + | / Right mouse context menu » Invert Selection: Inverts the current se-
lection.

Ctrl + F / Right mouse context menu » Find: Opens a new window for searching
specific light sources by name (REGEX are supported).

Ctrl + N / Right mouse context menu » Select Node: Selects the marked light
source in the Scenegraph.

Right mouse context menu » Switch On: Enables selected light source.
Right mouse context menu » Switch Off: Disables selected light source.

Ctrl + T/ Right mouse context menu » Toggle: Toggles the state of the selected
light source (on/off).

Right mouse context menu » Change Type: Changes the type of the selected
light source.

Right mouse context menu » Validate: Validates all lights and updates all lights
in the Scenegraph.



6.1 Scene

6.1.3 Material Editor

Scene » Material Editor

In the Material Editor material and surface shading settings for objects can be ad-
justed. To obtain detailed information about the materials provided in the VRED
package, go to the Materials Reference section.
» Material Editor Hotkeys
» Select Nodes: CTRL + N
» Add Nodes to Selection: CTRL + SHIFT + N
» Apply to Selected Nodes: CTRL + A
» Create Group: CTRL+ G
» Create Group from Selection: CTRL + SHIFT + G
» Scroll to Selected : CTRL + SHIFT + F

~
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Copy: CTRL+ C

Paste: CTRL +V

Rename: CTRL + R

Delete: DEL

Remove Unused Materials: CTRL + U
Optimize Materials: CTRL + O
Optimize Textures: CTRL + SHIFT+ O
Lock: CTRL+L

Unlock: CTRL + SHIFT + L

» Material Editor Views The Material Editor comes with 3 columns. The left col-

P

v

14

umn contains two views, which can be configured to show “Materials”, “Li-
braries” or “Tags” using the drop down menu at the top of each view. The
middle column shows the preview area, these can be viewed as Icon or List.
The right column contains a large material preview at the top and the material
specific settings.

Materials: The Materials View lists all materials in the current scene. The
materials can also be arranged in groups. The list can be filtered using the
search field at the top or the filter button which allows to find a certain type
of material. Selected Tags also work like a filter but they apply only to the
Preview area. The top of the Preview area also shows filter symbols to indicate
an active filter. Click with the right mouse button in the Materials View to open
the following menu:

e Create Material: Creates a new TruelightMaterial.

e Create OpenGL Material: Creates a new OpenGLMaterial.

e Edit: Offers a few options to edit materials:
- Copy: Copies the currently selected material(s) into the memory.
- Paste: Pastes the material(s) from memory as a clone.



- Duplicate: Directly duplicates the selected material(s)
- Delete: Deletes the selected material(s).

- Lock: Locks the selected material(s). No changes can be made to the
settings of the material(s).

- Unlock: Unlocks the previously locked material(s). Changes can be
made again.

e Convert:

- To TruelightMaterial: Allows you to convert the selected material into
another TrueLightMaterial.

- All to Phong Truelight Material: All ChunkMaterials in the scene are
automatically converted into a default Phong Truelight material.

- To Skylight: Each selected Sphere Environment material will be replaced
by a new Skylight material. Parameters that can be set for both Sphere
Environment and Skylight (Color Corrections and Transformations) are
copied.

- To Sphere Environment: Converts the selected Skylight into a Sphere
Environment whose environment map is set to the current procedural
sky environment map. The sun will be rasterized in the environment
texture.

e Create Group: Creates a new group. Groups are perfect for sorting mate-
rials by their structural dependencies.

e Create Group from Selection: This feature takes the currently selected ma-
terials and puts them into a new group.

e Select Nodes: Selects the geometry which is assigned to the currently se-
lected material(s).

e Add Nodes to Selection: This feature extends the selection in the scene-
graph with the nodes that are assigned to the currently selected mate-
rial(s).
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e Apply to Selected Nodes: Applies the currently selected material to the
selected nodes.

e Apply Environment to All Materials: Applies the Environment and its light-
ing and reflection behavior to all materials in the scene.

Libraries: This view contains a list of material libraries found in the Materi-
alLibraryPaths (Preferences). By clicking on a library it will be loaded and the
containing materials are shown in the Preview area. Click with the right mouse
button in the Libraries View to access the following menu:

e Create Group: Creates a library group. All library materials can be grouped
and sorted comfortably. This makes it easier for the user to quickly find
specific materials.

e Remove: Deletes selected library or library group.
e Save: Saves selected library or library group.

e Apply to Scene: All materials in the scene are replaced by same-named
materials from the library.

e Create Library: Creates a new library. Library groups can be added to the
library. All created libraries will be available on startup.

e Import Library: Imports an external library.

Tags: This view lists all tags found in the scene materials. By clicking a Tag,
the preview will be filtered by that tag. By selecting multiple Tags the Preview
shows only materials containing all selected tags (AND logic). Materials can be
dropped onto a Tag to assign the Tag to the material. Also, the Tag (or multiple)
can be dropped on a Material to assign them. Dropping a Group on a tag will
assign the tag to all materials in that group. Click with the right mouse button
in the Tags View to access the following menu:

New Tag: Create a new tag.
e Add to Selected Materials: Adds this tag to the selected materials.
Remove Tag from Material: The tag is removed from the selected material.

Remove Tag: The tag is removed from all materials and from the list.



Remove All Tags: All tags are removed from all materials. Note that all
materials will allways have the tag “Scene”.

» Preview: Shows icons or a list of materials. The shown materials depend on
the selection in the Materials View or Library View. If you click somewhere in
the Materials View, the Scene Materials will be shown. By clicking the Library
the Libraries Materials are shown. The top line of the Preview area identifies
what is currently shown. If a Group is selected only the contents of this group
is shown. To see all materials again, unselect the group by clicking outside of
it in the Materials or Library view.

)

Material Attributes: The Attributes View shows all available settings of the

currently selected material with a big preview image at the top.
Hint: To set the file path of a material’s texture you can also simply drag and
drop an image file from the explorer to the respective texture slot.

» Material Editor Menu

» File:

Import Library: Locate a library file on the filesystem, it will be copied into
VRED's library collection and can be accessed in the “Libraries” view.

Import Library and Apply: After import the library will be applied to the
scene where materials in the scene are replaced by materials with the same
name found in the library. See Library function “Apply to Scene”.

Reload Library: The VRED library collection will be checked for changes
and the Material Libraries will be updated.

Save Selected Materials...: Locate a directory on the filesystem, where the
selected materials will be saved. For each selected material an OSB file will
be created.

Load Materials...: Locate the material files (saved with the above function)
and add them to the scene.

Render Preview Images: Create the preview image for each material. The
previews are usually created when needed, which can result in delays while
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» Edit:

scrolling through the preview list. Creating the previews explicitly takes a
bit of time and avoids these delays.

Statistics: Opens a dialog box listing a brief scene materials summery.

- Number of materials: Displays the amount of materials used in the
scene.

- Number of textures: Displays the amount of textures used in the scene.

- Texture memory: Displays the amount of memory used for all textures.

Copy: Caches the selected material or chunk.
Paste: Pastes the currently cached material or chunk.

Delete: Deletes the selected node. Only nodes which are unused (not
assigned to any object) can be deleted.

Duplicate: Duplicates the selected material or chunk.

Merge Duplicated Materials: Deletes all duplicated materials, not assigned
to any object or connected to any material bin.

Remove Unused Materials: Deletes all unused materials, not assigned to
any object or connected to any material bin.

Reference Unused Materials: Creates a MaterialGroup node (in the Scene-
graph) for each unused material. Afterwards there are no unreferenced
materials in the scene any more.

Optimize Materials: Deletes all unused materials, references unused ma-
terials und optimizes textures.

Optimize Textures: Converts all RGB textures where only grayscale textures
are needed to grayscale textures.

Remove All Groups: Removes the material group structure. All materials
will appear as a flat list.

Scroll to Selected: Scrolls to the selected material in the Materials View.



e Lock: Lock selected material settings.

Unlock: Unlocks selected material settings.

Compress Textures: Compresses all loaded textures.
Uncompress Textures: Uncompresses all loaded textures.

» Create/Convert:

e 'Create Material’, 'Create OpenGL Material’, ‘Create Group’, ‘Create Group
from Selection’, "Convert’: Please refer to the Materials view context menu
described above.

» Scene:

e Select Nodes: Selects the geometry which is assigned to the currently se-
lected material(s).

e Add Nodes to Selection: This feature extends the selection in the scene-
graph with the nodes that are assigned to the currently selected mate-
rial(s).

e Apply to Selected Nodes: Applies the currently selected material to the
selected nodes.

e Apply Environment to All Materials: Applies the Environment and its light-
ing and reflection behavior to all materials in the scene.

» Window:

e Groups, Library, Tags: Shows or hides the left column of the editor con-
taining Materials, Libraries and Tags views.

e Preview: Shows or hides the preview area with material preview icons in
the middle of the editor.

e Attributes: Shows or hides the right column containing the settings of the
currently selected material.

» Filter The 'Materials’ and the ‘Libraries’ views have a search field and a filter but-
ton. Both can be used to find specific materials in the scene or in the library.
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Whether a filter is active is indicated by the filter button icon state and also as
an icon on top of the preview area. Clicking these icons will turn the filter off.

Type filter: The filter button allows the selection of a material type. Only ma-
terials with the selected type will be shown in the views.

Search: When entering text in the search field the search filter will become
active and only materials with names matching the search will be shown. To
turn off the search filter delete the text or click the search symbol.

Tag filter: When clicking a Tag in the tag view, the previews will be filtered by
that tag. When selecting multiple Tags the preview area only shows materials
containing all selected tags (AND logic). The tag filter is indicated by the tag
symbol in the top of the preview area, clicking it will deactivate this filter.



6.1.4 Texture Editor

Scene » Texture Editor

In the Texture Editor textures can be positioned on selected objects. By default VRED
uses the UV layout any imported object already has. Caution: Changes made in the
Texture Editor induce a full replacement of the previous UV layout by the selected
projection. Textures and the assigned attributes of a selected material are listed in
the texture window.

» Edit Texture Projection Enables the texture projection feature.
» Mode Offers planar or cylindrical texture projection.

» Apply Projection Uses the projection mode that is defined in “Mode” with the
entered settings and adds them to the selected geometry.

» Instant Mapping [f instant mapping is enabled, changes to the texture projection
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settings will be interactively visible in the Viewport as the texture projection will
be instantly applied to the selected objects.

» Show Support Geometry Shows a support geometry which is a transparent plane
textured with the currently selected texture for planar projection. For cylindrical
projection it is a transparent textured cylinder.

» Visibility Sets the visibility of the support geometry.

» Distance Sets distance of the planar projection plane to the 3D projection center.

» Place Texture 3D

» Projection Center: Offers two ways for defining the projection center. You can
either pick the center manually in the scene or set it to the center of the selected
object(s). To pick the center in the scene, activate the picking mode with the
“Pick” button, then hold Shift and left-click in the render window.

» Center (x,y,2): Sets custom coordinates for the center of the projection.

» Rotation: Sets the texture’s orientation. The rotation value defines the angle
the texture is rotated away from the projection plane orientation.

» Place Texture 2D
» Keep Aspect Ratio: Keeps the aspect ratio of the texture when projecting.
» Scale Mode: Offers two scaling modes.
e Fit Scale Only
e Fit Scale and Center
» Repeat: Sets the texture repetition on x- and y-axis.

» Offset: Sets the texture offset value. The offset X(Y and Z) defines how far the
texture is shifted from the projection center position on the x-, y- or z-axis.

» Rotation: Sets the texture orientation. The rotation value defines the angle the
texture is rotated away from the projection plane orientation.

I~
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6.1 Scene

6.1.5 Ambient Occlusion

Scene » AmbientOcclusion

» Ambient Occlusion Ambient Occlusion simulates soft global illumination by com-
puting shadows resulting from light coming from all directions. These shadows
are similar to shadows cast from an overcast sky. This has the effect of dark-
ening cracks, creases, corners and points of contact.

Ambient Occlusion is a specific not-physically-accurate rendering trick. It ba-
sically samples a hemisphere around each point on the face, sees what pro-
portion of a hemisphere is occluded by other geometry and shades the pixel
accordingly. It has nothing to do with light, it is purely a rendering trick that
looks nice and increases a geometry’s realism. That is because in real life sur-
faces that are close together (like small cracks) are darker due to dirt, shadows
or the like than surfaces that are not occluded by other things. The Ambient
Occlusion process though is approximating this result, it does not simulate light
bouncing around or goes through things. This is why Ambient Occlusion still
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works without lights in the scene.

The Ambient Occlusion calculation is a preprocess and takes place during data
preparation. Calculated Ambient Occlusion results are baked on the geome-
try’s vertices. The smoothness of the Ambient Occlusion depends on the detail
level of a geometry. Therefore VRED offers several ways to increase the quality
on low level geometries, like subdividing triangles and predefined quality pre-
sets.

» Settings

»

»

»

»

Save Current: Saves the current setting.

Load from Node: Loads the ambient occlusion settings from the selected ge-
ometry node. Using this method, you can retrieve the settings with which the
ambient occlusion was calculated.

Load Settings: Provides a list with the saved settings to select one of them.
Delet Settings: Provides a list with the saved settings to delete one of them.

» Direct Illumination

»

»
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Shadow Quality: Defines the direct shadow quality of the Ambient Occlusion.
6 Presets are available:

e Preview Quality: 8x8 hemisphere samples (per vertex)
e Low Quality: 16x16 hemisphere samples

e Medium Quality: 32x32 hemisphere samples

e High Quality: 48x48 hemisphere samples

e Highest Quality: 64x64 hemisphere samples

e Ultra High Quality: 128x 128 hemisphere samples

Minimum Distance: Sets the minimum distance of objects to be taken into
account for the Ambient Occlusion calculation. This value defines totally black
areas where full occlusion takes place.



»

»

»

Maximum Distance: Sets the maximum distance of objects to be taken into
account or the Ambient Occlusion calculation. This value defines totally white
areas where no occlusion takes place. This value can also be seen as the max-
imum expansion of the virtual hemisphere.

Clear All: Deletes the Ambient Occlusion calculation of the whole scene.

Clear Active: Deletes the Ambient Occlusion on the selected geometry. A/l
numeric values represent mm as units. Important: The total calculation time
depends on the complexity of the scene and of the chosen Shadow Quality
Preset.

» Indirect lllumination The Indirect lllumination checkbox enables an additional

»

»

»

»

calculation of indirect light bounces which increases the quality of the final
result.

Enable: Enables/disables the indirect illumination mode.

Quality: Sets the quality of indirection. The higher the values, the better the
results.

e Preview Quality: 8x8 samples
e Low Quality: 16x 16 samples
e Medium Quality: 24x24 samples
e High Quality: 32x32 samples
e Highest Quality: 48x48 samples

Indirections: The number of indirections defines the number of calculated light
bounces. The default value is one - so only one light bounce is calculated.
Important: Higher values induce better quality but increase the calculation
time.

Enable Color Bleeding: Color bleeding enables the transfer of color between
near-by objects, caused by the colored reflection of the indirect illumination
option. Color bleeding causes a white wall close to a red wall to appear pink
because it receives red light from the red wall.
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» Override Material Color: Overrides the material color of the occlusion.

» Color: Deletes the Indirect lllumination on the selected geometry.

» Clear All: Deletes the Indirect lllumination calculation of the whole scene.
» Clear Active: Deletes the Indirect lllumination on the selected geometry.

» Subdivision Subdivides geometry to calculate the ambient occlusion more pre-
cisely.

» Enable: Enables/disables the subdivision mode.

T
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Quality: Enabling the subdivision checkbox causes geometries to be refined
during the Ambient Occlusion calculation process. Additional vertices are in-
serted into the meshes. Thus it is possible to get much more smooth results on
the geometry. 3 Presets are available:

e Low Quality: Subdivide up to 2 times if the difference in intensities be-
tween the vertices of an edge is above the intensity threshold

e Medium Quality: Subdivide up to 2 times if the difference in intensities
between the vertices of an edge or the edge midpoint of the triangle edge
is above the intensity threshold

e High Quality: Subdivide up to 4 times if the difference in intensities be-
tween the vertices of an edge or the edge midpoint is above the intensity
threshold

Minimum edge length: Defines the threshold of the subdivision. If the length
of an edge between two vertices is below the defined value, it won’t be sub-
divided and no additional vertices will be added.

v
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Intensity threshold: Sets the threshold of intensity values of two vertices, to
force a subdivision of the triangle edge.

Caution: Enabling this feature increases calculation time and also increases
the polygon count of the scene.

» Calculate ALL Calculates the ambient occlusion for all visible and selected nodes
and their childNodes.
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6.1 Scene

» Calculate Missing Calculates the ambient occlusion for all missing visible and se-
lected nodes and their childNodes

» Cancel Cancles the calculation.

e
L LS
{ Example 1

Shadow Quality: Preview Quality

Min. distance: 1

Max. distance: 1000

Indirect lllumination: No

Indirect lllumination Quality: /
Number of indirections: /

Color bleeding: /
Subdivision: No
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Example 2

Shadow Quality: Highest Quality
Min. distance: 1

Max. distance: 1000

Indirect lllumination: No
Indirect lllumination Quality: /
Number of indirections: /

Color bleeding: /

Subdivision: No

Example 3
Shadow Quality: Highest Quality
Min. distance: 1

Max. distance: 1000

Indirect llluminatijon:. Yes

Indirect lllumination'Quality: Highest
Number of indirections: 3

Color bleeding: Yes

Subdivision: No

’

e
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6.1 Scene

6.1.6 Geometry Editor

Scene » Geometry Editor
This chapter provides all information about the Geometry Editor. The Geometry Editor
window offers two tabs:

» Normals The Normals Tab contains all functionalities to modify and correct ge-
ometries’ face and vertex normals.
» Normal Calculations:

e Crease Angle: The Crease Angle sets the smoothness of all vertex normals
of an object. The lowerd the degree angle entered, the harder the vertex
normals are set. A value of O degrees lets a geometry appear facetted. A
value of 45 degrees let a geometry appear smooth.

e Length: Normalizes the length of face and vertex normals to a value of 1.
This represents the length of the unit vector.
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e Normal Consistency: Sometimes the geometries’ face and vertex normals
are facing to different directions. This button sets face and vertex normals
to one direction.

e Flip Normals:

- Face/Surface: Flips the direction of face/surface normals of the selected
geometry.

- Vertex: Flips the direction of vertex normals of the selected geometry.

- Face and Vertex: Flips the direction of vertex and face normals of the
selected geometry.

e Mirrored Flip Normals:
- Flip Mirrored: Flips the face- and vertex normals of instanced geometry.

- Flip Non-Mirrored: Flips the face- and vertex normals of non-instanced
geometry.

p)
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Adjacency Selection: The crease angle value defines the maximum degree of
face normals of a triangle. With this function, all triangles will be selected,
which have a less tolerance to their neighbor triangles lower than the entered
degree value. This function can be used to seperate multiple merged compo-
nent parts of one mesh.

e Crease Angle: Sets the crease angle for the selection.
e Select: Selects all geometry depending on the entered crease angle.

P
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Separate Objects:

e Separation Angle: Defines the angle between the vertex normals. Needed
in case of merged objects for example.

p)
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Graphical explanation of the color scheme:



6.1 Scene

N

== o - Green
Face and vertex normals are consistent and facing to-
" | I I " wards the camera direction.

Face and vertex normals are consistent and facing
away from the camera direction.
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6 MODULES

Face and vertex normals are inconsistent. The vertex
normal faces towards the camera direction while the
face normal faces away from the camera direction.

Face and vertex normals are inconsistent. The face
normal faces towards the camera direction while the
vertex normal faces away from the camera direction.
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» Tangents / Binormal: These functions calculate tangents and binormals based
on the source and save them in the given texture coordinates.

e Source: Defines the texture coordinate slot, which should be used for
calculating of the Tangents/Binormal.

e Tangent: Defines the texture coordinate slot, in which the tangents should
be saved.

e Binormal: Defines the texture coordinate slot, in which the binormals
should be saved.

» Geometry

» Tesselation: The Tessellation Tab provides the functionality for retessellation of
surface (NURBS) data in the Scene.

e Tolerance: The tolerance value defines the maximum approximation for
smoothness of tessellated geometry. The lower the vaule, the smoother
the result and the higher the polygon count.

e Convert to Convex: Converts non-convex primitives to convex primitives.

» Decore: The decore function removes redundant geometries inside other ge-
ometries, like scews and mountings inside a door covering. A virtual camera
flies around the selected object, takes screenshots and removes any non visible
geometry.

e Quality Resolution: The resolution defines the resolution of the taken screen-
shots. The higher the value, the more precise the result.

e Quality steps: The steps define the number of screenshots. The higher the
value, the more precise the result.

e Correct wrong Normals: Corrects wrong normals. Faulty normals are cor-
rected.

e Removal:
- Disabled: Nothing will be removed.
- Object Level: Hidden objects will be completely removed.
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- Polygon Level: Hidden polygons will be completely removed.
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6.1 Scene

6.1.7 Node Editor

Scene » Node Editor

The Node Editor provides all information about any node type in a scene. It offers
the possibility to view detailed information about selected nodes, changing values
and attach custom attributes to nodes.
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6.1.8 Variants

Scene » Variants

The variant module allows the user to create different variants of one model by stor-
ing the states of switch-nodes and switch-materials. This stored information then can
be quickly and easily accessed for fast switching between different variants either by
using the GUI, hotkeys or by Python scripts.

There are three different types of variants: geometry variants, material variants and
light variants. A geometry variant is linked to a node in the scene graph, with either
is a normal node which can be enabled or disabled or which is a switch node which
selects only one child for rendering at a time. In the same manner a switch mate-
rial is a container for one or more materials, and only one of these is active during
rendering. A light variant is connected to a light source which can be activated or
deactivated via the variants module.

To assign a hotkey to a specific state of the variant click on the right column in the
list of all possible states. A small popup will appear for selecting the desired key
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combination.

» Geometry Variants To create a Geometry Variant drag a node or a geometry

»
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switch from the Scenegraph into the empty left area of the Geometry Vari-
ants tab.

Once the variant is created, you can select the variant and see all possible states
the node offers in the right pane of the geometry variant tab. The default state
is highlighted by a colored background and the current state is displayed using
bold letters. You can activate any state by double-clicking on the specific entry.
Note that if there are more than one node in the scenegraph with the same
name, then all these nodes will be controlled by the variant.

IAIl: Shows all available objects in the GeometrySwitch in the Renderview.
INext: Jumps to the next item in the GeometrySwitch until the last item.

INext(Loop): Jumps to the next item in the GeometrySwitch. After the last item
it jumps back to the first item.

INone: Hides all of the available nodes.
IPrevious: Jumps to the previous item in the GeometrySwitch until the first item.

IPrevious(Loop): Jumps to the previous item in the GeometrySwitch. After the
first item it jumps back to the last item.

Name of the Node: Direct click on the name shows the geometry in the Ren-
derview.

Right mouse button click on a variant offers the following options:

e Right mouse context menu, Create all: Puts all available GeometrySwitches
into the Geometry Variants.

e Ctrl + R/ Right mouse context menu, Rename: Renames a Geometry Vari-
ant.

e Del/Right mouse context menu, Delete: Deletes selected Geometry Vari-
ant.

e Right mouse context menu, Clear: Deletes all Geometry Variants
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e Right mouse context menu, Show geometry: Shows activated geometry
in Renderview.

e Right mouse context menu, Hide geometry: Hides selected geometry in
the Renderview.

e Right mouse context menu, Select Switch Nodes: Selects the switch node
in the Scenegraph.

e Right mouse context menu, Select Nodes: Selects nodes in the Scene-
graph.

» Material Variants You can create a material variant by dragging any material from
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the Material Editor into the list in the left area of the Material Variants. If the
material is already a switch material, all states will be displayed. In the case that
the material is of any other type, a switch material will be created automatically
and the original material will be replaced in the scene. Then you can add any
material to the newly created switch material by dragging additional items from
the material editor into the right state list.

INext: Jumps to the next item in the material switch until the last item.

INext(Loop): Jumps to the next item in the material switch. After the last item
it jumps back to the first item.

IPrevious: Jumps to the previous item in the material switch until the first item.

Previous(Loop): Jumps to the previous item in the material switch. After the
first item it jumps back to the last item.

Name of the Node: Direct click on the name activates the material on the
geometry.

Right mouse button click on a variant offers the following options:

e Right mouse context menu, Create All: Puts all available material switches
into the Material Variants.

e Ctrl+R/Right mouse context menu, Rename: Renames a Material Variant.
e Del/Right mouse context menu, Delete: Deletes selected Material Variant.



e Right mouse context menu, Clear: Deletes all Material Variants.

e Right mouse context menu, Show geometry: Shows assigned geometry
in the Renderview.

e Right mouse context menu, Hide geometry: Hides assigned geometry in
the Renderview.

» Light Variants To create a Light Variant, drag a light source from the Scenegraph
into the empty left area of the Light Variants.
» IDisable: Disables the selected light.
» IEnable: Enables the selected light.

~

» 1Toggle: Toggles between the available lights.
» Right mouse button click on a variant offers the following options:

e Right mouse context menu, Create All: Puts all available lights into the
Lights Variants.

e Ctrl + R /Right mouse context menu, Rename: Renames a Light Variant.
e Del / Right mouse context menu, Delete: Deletes selected light.

e Right mouse context menu, Clear: Deletes all lights.

139



6.1.9 Variant Sets

Scene » Variant Sets

VRED provides the possibility to set up different scenarios by using the Variant Sets
Module. In many cases, the functionality provided by the Variant module is not
enough for managing complex models, where many different switch nodes are needed
in order to represent a specific version of the model loaded. Here the variant set mod-
ule provides additional functionality allowing the user to create sets of variants for
activating them simultaneously. For configurators logical connections can be gener-
ated.

» Variant Sets list Lists all Variant Sets and Variant Set groups. Right click offers
you the following options:

» New Set: Creates a new Variant Set. The tab view on the right then displays
all information for the currently selected Variant Set.

» New Group: In order to support the user at organizing all variant sets, groups
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can be created which behave like folders. You can drag a Variant Set in any
group or you can remove a Variant Set from a group by dragging it on its parent
folder. Note that it is not possible to recursively store folders within folders.

» Select: Activates a Variant Set.
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Select defaults: Activates a Variant Set by using its defaults.

P

Duplicate: Creates a duplicate of a Variant Set.

» Rename: Renames a Variant Set.

v

» Delete: Deletes selected Variant Set.
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Clear: Removes all Variant Sets and groups.
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Dissection Mode: Disables rendering and switches to analyzing mode.
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Create Preview: Renders a preview that is automatically assigned to the se-
lected Variant Set as an icon.
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Dissection Mode: The so called Dissection Mode is a special mode of opera-
tion in VRED used for creating screenshots only of specific parts of the loaded
model. When entering the Dissection Mode, all geometry will be disabled, thus
your screen will be empty at first. Then you can gradually enable geometry ei-
ther using the Show functionality of the scenegraph or using some pre-defined
Show/Hide-lists in the Variant Set module. When the desired geometry is vis-
ible, you can create a screenshot using the corresponding button either in the
Variant Set module or in the toolbar of VRED. When leaving the Dissection
Mode (again by using the context menu), the previous state of all nodes and
switches will be restored.

» Verify All: Possibility to load a csv file with embedded logics.

» Verify Maya: Verify imported maya variants.

» General tab

» Hotkey: For each Variant Set a hotkey can be assigned. This is done by selecting
the desired key combination in the two drop-down boxes. Alternatively each
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variant set can be activated by double-clicking on it or by using the context-
menu.

» Comment: Adds a custom comment to each Variant Set.
» Screenshot: Creates a screenshot of the current scene.

» Geometry tab Multiple Geometry Variants can be combined together in one Ge-
ometry Variant Set by dragging the desired Geometry Variants from the Variants
Tab to the Geometry Tab of the Variant Sets. Make sure that at least one Vari-
ant Set is created. Each Geometry Variant can have different states. They will
be activated by double clicking on the Variant Set.

» Material tab Multiple Material Variants can be combined together in one Material
Variant Set, by dragging the desired Material Variants from the Variants Tab to
the Material Tab of the Variant Sets. Make sure, that at least one Variant Set is
created. Each Material Variant can have different states. They will be activated
by double clicking on the Variant Set.

» Light tab Multiple Light Variants can be combined together in one Light Variant
Set, by dragging the desired Light Variants from the Variants Tab into the Lights
Tab of the Variant Sets. Make sure that at least one Variant Set is created. Each
Light Variant Set can have different states. They will be activated by double
clicking on the Variant Set.

» View tab Multiple viewpoints can be added in this tab. You can make one of the
viewpoints the default one by using the context menu. The default viewpoint
will be activated whenever the variant set gets activated.

» Animation tab Multiple initial animations can be added in this tab. If “Sequential
Animation” is not activated (default) all added animations will be executed at
once. Otherwise the first animation will be executed with the first activation
of the variant set, the next animation with the next activation, and so on.

» Analyzer tab Some Clipping Plane settings can be configured. For more informa-
tion please refer to the Clipping module description.
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6.1 Scene

» Script tab For advanced users each variant set can contain a Python script that
will be executed automatically each time the variant set is activated, be it via
the variant set module, via a hotkey or via another script.

» Values tab If you want to process the exported Variants XML data yourself (see
Import and Export below), you can also add generic key/value pairs to any
variant set. On the left side is the list of all keys and on the right side you can
change the value belonging to the currently selected key. You can create and
delete keys by using the context menu. This data is not processed by VRED in
any way, it is only available in the exported Variants XML data.

» Show/Hide tab Primarily used in the dissection mode (explained above) this tab
contains a list of scenegraph nodes that will be shown/hidden when using the
menu entries “Show Geometry” or ‘"Hide Geometry” in the context menu of a
Variant Set in the Variant Sets list. This is especially useful for making screen-
shots of isolated parts of your model that belong to a specific variant set. You
can simply add nodes by dragging them from the scenegraph into the list and
you can remove nodes by using the context menu in the nodes list.

» Import and Export You can save and load all variants and variant sets by choosing
File » Export » Variants... or File » Import » Variants.... All definitions will also
be saved within a VRED project file.

» lcon bar A few icons depict commonly used functions:
» Create variant: Creates a new Variant Set.
» Duplicate variant: Duplicates the selected Variant Set.
» Delete: Deletes the selected Variant Set.
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6.1.10 Optimize

Scene » Optimize

The Optimize module helps to optimize the scene and thereby raise the render per-
formance. All optimization processes will be applied to the selected nodes and their
children.

» Filter

» Remove Points: Removes all points.

T

» Remove Lines: Removes all lines.

v

v

Remove LODs (Keep Best Quality): Removes all DistanceLOD nodes and keeps
the first child.

Remove LODs (Keep Lowest Quality): Removes all DistanceLOD nodes and
keeps the last child.

v

Remove Switches: Removes all Switch Nodes.

T

Remove Vertex Normals: Removes all vertex normals.

v

» Remove Vertex Color #1: Removes all first vertex color information.

v

» Remove Vertex Color #2: Removes all second vertex color information.

v

p)

T

Remove Texture Coordinates #1 - #8: Up to eight texture UV sets can be as-
signed to each object node. Each of them can be deleted separately from each
other.

)

4

Remove MaterialGroup Nodes with No Children: Removes empty Material Group
nodes.

)

4

Remove Empty Geometry nodes: Deletes empty Geometry nodes.

p)

4

Remove Identity Transforms: Removes identity Transform nodes.

» Remove Invalid Texture Coordinates: Deletes invalid texture coordinates.

4

)

v

Remove Degenerated Polygons: Removes all polygon nodes which cannot be
drawn.
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»

Remove Animations: Removes all existing animations in the selected node and
its subnodes.

» Flush/Unflush

P

P

v

)

P

\/

P

v

P

Flush Transformation Nodes (Adjust Face Normals): Converts Transform nodes
to group nodes and adjusts the face normals appropriately.

Flush Transform Nodes: Converts Transform nodes to group nodes.

Flush MaterialGroup Nodes: Deletes Material group nodes. The material of a
MaterialGroup is assigned to its child nodes.

Unflush MaterialGroup Nodes: A MaterialGroup node is added as parent to
each geometry node.

Flush Texgens: Applies TexGenChunks with object linear texture generation
function to the texture coordinates and removes the TexGenChunks afterwards.

Flush Textransformations: Applies TextureTransformChunks to the texture co-
ordinates and removes the TextureTransformChunks afterwards.

» Share

»

»

»

»

»

Geometries: References duplicated and mirrored geometries.
Geometry Properties: References duplicated geometry properties.
Materials: References duplicated materials.

Textures: References duplicated textures.

Blend Chunks: References duplicated Blend Chunks.

» Optimization

»

»

Triangulate: Triangulates all polygon meshes. Faces with four and more edges
are split in the appropriate number of triangles.

TriangulateRelndex: Triangulates all polygon meshes. Splits faces with four
and more edges to the appropriate number of triangles. Vertex indices will be
reassigned.
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»

»

»

»

»

»

»

»

»

Octree: Creates an octree structure for selected objects.
Merge Materials: Merges identical materials to one.

Merge Geometry Nodes: Geometries which fulfill all preconditions for merging
will be merged.

Cleanup Group Nodes: Groups which have less than two children will be fil-
tered.

Unify Vertices: Merges identical vertices.
Create Indices: Creates indices for objects if no indices are existing.

Create Strips, Create Fans, Create Stitches: Connects triangles to strips and/or
fans.

Optimize Indices: Tries to improve vertex cache efficiency by reordering triangle
indices.

Sort Indices: Sorts object’s indices.

» Reduction

»

16 bit Lengths, 16 bit Indices: Changes the lengths and/or indices of a geometry
to a 16 bit data type.

» Optimize Executes the optimize process with the current optimize settings.
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6.2 Animation

6.2 Animation

6.2.1 Curve Editor

Animation » Curve Editor
The Curve Editor allows the user to create and modify animations. Select the object
to be animated. Whe scrubbing through the Curve Editor’s timeline the Renderview
will render the playback settings defined in advanced in the Curve Editor, including
Motion Blur settings, FOV and others.
» Edit

» Rename: Renames selected node.

» Delete: Deletes selected node.

» Copy: Copies selected node and temporarily stores the block structures in the
cache.
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»

»

»

»

»

»

»

»

Cut: Cuts selected node and temporarily stores the node structures in the
cache.

Paste: Pastes the currently in the cache stored block to selected position.
Paste Clone: Pastes the currently in the cache stored node to selected position.
Clone: Creates a reference of the selceted node.

Duplicate: Creates a new node with the same attributes of the selected node.

Unshare: Removes a referenced connection. Referenced objects are indicated
by an underline.

Group Selection: Groups selected objects. A new group node will be created
and all selected objects will be attached as children to the new node.

Select Node: Selects the marked animation in the Scenegraph.

Information...:Opens the information window. This window contains serveral
information about the node’s attributes.

» View

»

»

Frame: Shows the current frame of the selected keyframe. Changing the values
moves the keyframe to a new position.

Lock Objects: Locks/Unlocks selected attribute.

» Curve
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»

»

Pre Infinity Mode: Defines the behavior before the first keyframe has been
reached.

Post infinity Mode: Defines the behavior after the last keyframe has been
reached. Values for both options are:

e Constant: Runs the curve one time. Continues the curve constant with
the last key frame of the curve.

e Loop: Loops the curve endlessly.

e Loop with Offset: Loops the curve endlessly. Beginning of the new curve
is the last keyframe of the old curve



»

»

»

»

»

e Oscillate: Runs the curve forwards and backwards alternately in an endless
mode.

e Linear: The curve will continue linear to the basis of the keyframe’s tan-
gent.

Key All Channels: Creates a key at the current frame for all object attributes
listed in the Curve Editor's Scenegraph.

Key All Selected Channels Types: When selecting several objects, all objects can
be edited for the same channels at the same time.

Key Selected Channels: Creates a key at the current frame for the selected
attributes in the Curve Editor’s Scenegraph.

Create Block: A Block is a bin which can store animations. The animation can
be accessed and edited at any later time. Blocks can be used in the ClipEditor
to arrange more complex animations. Objects may have an unlimited amount
of Blocks. Each Block’s length is individually starting from the first keyframe
position to the last keyframe position. When a Block is selected, the keyed
animation curves will be drawn. To create an Animation Block press the Block
button.

Snap to Grid Options:
e Time: Allows to snap to the time (x-)axis by an integer step.

e Value: Allows to snap to the value (y-)axis by an integer step.

» Tangents Tangents describe the entry and exit of a key's curve segments. This

»

»

menu operates on the shape of curve segments around selected keys.

Constant: Specifying a stepped tangent creates an animation curve whose out
tangent is a flat curve. The curve segment is flat (horizontal), so the value
changes at the key without gradation.

Linear: Specifying a linear tangent creates an animation curve as a straight line
joining two keys. A linear in and out tangent results in a straight line bfeore
and behind the curve segment.
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» Flat: Sets in and out tangents of the key to horizontal with a slope of 0 degrees.
(Scenario: When a ball reaches its ascent, it hangs in the air for a brief time
before start-ing its descent. You can create this effect by using a flat tangent).

)

x

Hermite: Specifying a hermite tangent creates a smooth animation curve be-
tween the key before and the key after the selected key. The tangents of then
curve are co-linear (both with the same angle). This ensures that the animation
curve smoothly enters and exits the key.

)

x

Following: Specify a flow tangent to create an animation curve that is smooth
between the key before and the key after the selected key. The tangents of the
curve are co-linear (both at the same angle). This ensures that the animation
curvesmoothly enters and exits the key.

» Break: Breaks the in and out tangent linking.
» Search Enter the name of animation you want to find.
» Update Animation tree Updates the animation tree.

» Frame Shows the current frame of the selected keyframe. Changing the values
moves the keyframe to a new position.

» Value Shows the current value of the selected keyframe. Changing the values
moves the keyframe to a new position.

» Quick Access Bar You will find the descriptions for the icons int the section obove

» Right click on a node to see the submenu You can find all informations about
the options in the Edit menu above, except for the following:

» Play: Plays the animation.
» Stopp: Resets the animation.

» Motion Blur: Enables motion blur.
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» Hotkeys
» select: left mouse click.
» zoom: right mouse click.
» pan: middle mouse click.
» focus: double right click.
» multi selection: STRG + SHIFT + left mouse click.
» deselect: STRG + SHIFT + right mouse click.
» move: SHIFT + left mouse click.
» zoom horizontal: X + right mouse click.
» zoom veertical: Y + right mouse click.

» center: F

» icon bar
» (™ Key all channels.
» sas Key selected channels.
» i Create an animation block element.
» .I” Constant tangents
» [\ Linear tangents
» /L Flat tangents.
» ¢¥ Hermite tangents.
» “L Following tangents.
» ' Break tangents.
» U Horizontal grid snapping.
» St Vertical grid snapping.
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6.2.2 Timeline

- - A A A A A A a

9 8 76543121

» 1 Sets the timesilder to the end frame position.
» 2 Sets the timeslider to the next keyframe. A key frame saves the state of different
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6.2 Animation

attributes at a specific time. Key frames are the basis for non-linear animations
in VRED.

» 3 Plays the selected animation forward.

» 4 Stops the selected animation.

» 5 Plays the selected clip backwards.

» 6 Sets the timeslider to the previous keyframe.
» 7 Sets the timeslider to the start frame position.
» 8 Defines the current frame.

» 9 Gives visual feedback about used keyframes.
» 10 Sets the start frame of full timeline range.

» 11 Sets the start frame of the detailed timeline.
» 12 Slider for detailed timeline.

» 13 End value for detailed timeline range.

» 14 Sets the end frame of the full timeline range.

» 15 Sets a keyframe for the selected object and all its animated attributes. This has
the same effect as the function “Key All" in the Curve Editor.

» 16 Activates /deactivates the local evaluation of the shown curves in the Curve
Editor instead of all active animations in the scene.

» 17 Closes the timeline.

» 18 Opens the Animation Tab in the Preferences Modul.
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6.2.3 Clip Maker

Animation » Clip Maker
The Clip Maker allows to rearrange, retime and group Animation Blocks to set up
more complex animations. Moving the slider through the Clip Maker's timeline, the
Renderview renders the playback settings defined in the Clip Maker including motion
blur settings, FOV and others.
» Menu bar

» Edit:

e New Clip: Creates a new clip. Animation blocks can be dragged into the
clip.

e Rename: Renames a clip.
e Delete: Deletes the selected clip.
e Copy: Copies a clip into memory.
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e Paste: Pastes a clip from memory.

e Duplicate: Duplicates a clip.

e Information: Displays information about the selected clip.
» View:

e Frame: Frames the timeline for a better overview.

e Lock objects: Allows you to lock all objects. Locked objects cannot be
moved.

e Unlock objects: Allows you to unlock all objects.

» Clip library
» Play: Plays the selected clip.
» Reset: Resets the clip frame selector to frame 0.
» All the other options are explained in the Menu bar description.

» Composition window
» Middle mouse button + drag: Pan view
» Right mouse button + drag up and down: Zoom
» Double right mouse button click: Set focus center
» Left mouse button drag: Move clip

» Search bar Type into the search bar to find specific items.
» Clip scaling Select a clip in the composition window. You have the following op-
tions:
» Start: Sets the start frame of the selected clip.

» Duration: Sets the duration of the selected clip.

» Cycles: Without having to duplicate the selected clip, you can define how many
times it shall be repeated in sequence. The duration of the following cycles
depends on the the duration of the main clip.
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» lcon bar
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»

»
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D

Create clip: Creates a new clip.

Add Sequence: Allows to add a sequence to the current clip.
Horizontal Grid Snapping: Turns horizontal grid snapping on or off.
Frame objects in view: Frames the whole clip in the view.

Delete clip: Deletes the selected clip.



6.2.4 SAnimation

Animation » SAnimation

The SAnimation module lists and executes imported Deltagen animations.

» Play Plays an animation
» Reverse Play Reverse plays an animation.

» Pause Pause the playback of an animation.
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6.2.5 Animation

Animation » Animation

The Animation Module lists all animations imported via VRML file format. They can
be executed initially, adjusted and connected to sensors or scripts. Sensor nodes
connect animations to other nodes. Using sensors, animations can be executed by
selecting a node connected with the sensor in Renderview. Animations created in
FBX-data are files that are maintained in animation blocks during import, so that

they can be arranged directly in the Clip Maker. Copy and paste of animation blocks
onto different objects is possible.

» Animation Menu Right mouse button click offers the following options:

» Start: Starts selected animation. Animations can also be executed by a double
click on the animation’s name.

» PauseContinue: Pauses or continues selected animation.
» Reset: Resets selected animation to its start position.
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» Select Nodes: Selects all nodes connected to the animation.
» Delete: Deletes animation.
» Refresh: Refreshes the Animation Module’s Scenegraph.

» Clear: Clears the Animation Module’s Scenegraph.

» Properties
» Comment: Offers the possibility to enter a comment for the selected animation.
» Hotkeys When working with WRL animations, you can define shortcuts to play
and stop them.
» Start: Starts the animation

» Pause, Unpause: Pauses the animation.

» Animation
» Cycle interval: Sets the animation cycle interval in seconds.

» Keyframe: Controls animations from vrml files. When selecting a VRML-animation
and stopping it using the right mouse button, you can now move the slider
manually and examine the animation frame per frame.
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6.3 Interaction

6.3.1 Transform

Interaction » Transform

Often it is necessary to alter the position of objects within the scene. You can trans-
form selected objects in two ways, interactively with the transform manipulator in
the toolbar or by entering the transformation values into the transform module. You
can move geometry, resize it, rotate it and redefine its pivot.

When transforming multiple objects at once, the transform module always shows the
transformation properties of the last selected object, and the transform manipulator
is connected to the last selected object. Transformation values that differ among the
selected objects are highlighted by a yellow background in the respective input field.
When entering a certain value, it is applied to all selected objects. With the wheel
control next to the input field, you can increase or decrease the respective values of
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all selected objects at once.

» Basic
» Translation

e Coordinate System: Defines whether the translation values are presented
based on world space or on object space. In world space, the translation
defines the object’s global position within the world. In object space, the
translation defines the object’s offset from its origin.

Example: A parent node is translated by «0, 0, 10» (TX TY T2) in world
space. If the child node is translated by «0, 0, 5» in local space, its trans-
lation values in world space will be «0, 0, 15».

e Translate(x,y,z): Moves the object on the x-, y- or z-axis.
e Move to Camera: Moves the object to the location of the camera.
e Move to Origin: Moves the object to its origin.
» Rotation
e Rotate(x,y,z): Rotates the object on the x-, y- or z-axis.

e Rotation Order: Euler rotations are not clear. The rotation order defines
the order in which the rotations around the 3 axes will be realized.

e You can define the rotation axis of the object by picking one in the 3D
scene. The rotation pivot will be automatically positioned and aligned
according to the picked axis.

- Pick Axis (x,y,2): Defines whether x-, y- or z-axis of the rotation pivot will
be aligned to the picked axis.

- Show Axis: Displays the picked rotation axis.

- Pick Mode: Allows to select two or three points for defining the rotation
axis. With two points you directly define the axis in 3D space. With
three points you define a triangle in 3D whose normal vector will be the
picked axis.
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» Scaling
e Scale (x,y,2): Scales the object on x-, y- or z-axis.

e Uniform Scaling: Connects x-, y- and z-axis and keys the same value to all
of them. To scale an object in only one direction or unequally in different
directions deactivate this option.

» Rotation Pivot

e Coordinate System: The rotation pivot can be defined in world space or
related to the object.

Example: An object is positioned at «10,10,10» in world space. The ro-
tation pivot of the object is positioned at «0,0,0» in object space and at
«10,10,10» in the world coordinate system.

e Position (x,y,2): Moves the rotation pivot point on the x-, y- or z-axis.
e Orientation (x,y,z): Rotates the rotation pivot point on the x-, y- or z-axis.

e Move To Object Center: Moves the rotation pivot point to the center of
the object’s bounding box.

e Move To World Center: Moves the rotation pivot point to the center of
the world.

» Scaling Pivot

e Coordinate System: The scale pivot can be defined in world space or re-
lated to the object.

Example: An object is positioned at «10,10,10» in world space. The scale
pivot of the object is positioned at «0,0,0» in object space and at «10,10,10»
in the world coordinate system.

e Position (x,y,z): Moves the scaling pivot point on the x-, y- or z-axis.

e Move To Object Center: Moves the scaling pivot point to the center of the
object’s bounding box.

e Move To World Center: Moves the scaling pivot point to the center of the
world.
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» Advanced
» Bounding Box: Bounding box calculation options:

e Bounding Box Center: Returns the coordinates of this object’s bounding
box center.

e Create Bounding Box Center Transform: Creates a transform node with
transform of the selected bounding box center.

e Create Bounding Box Center Inverse Transform: Creates a transform node
with inverse transform of the selected bounding box center.

» Shearing: Shearing transformation options:
e Shear XY: Shears the object on the x- and y-axis.
e Shear XZ: Shears the object on the x- and z-axis.
e Shear YZ: Shears the object on the y- and z-axis.
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6.3.2 Annotation

Interaction » Annotation

The annotation module allows the user to place virtual text markers into the scene in
order to augment a given model with textual documentation. The annotations will
be saved within a project file, or they can also be saved as an XML file for further
processing in other applications. The annotation list gives an overview of all used
annotations in the scene. Right mouse click to open the list menu.

» Add Creates a new annotation. The newly created annotation will be immediately
displayed on the screen. You can choose the desired position in the scene by
holding down the shift key and clicking with the mouse. As long as you hold
down the mouse, the exact position will be displayed and you are still able to
change the location.

» Remove Removes the selected annotation.

164



» Pick position Allows to pick a new position for the annotation.
» Zoom in Zoomes to the annotation.

» Load annotations Loads an external annotations xml file.

» Save annotations Saves all annotations in an xml file.

» Remove all Removes all created annotations.

» Descriptions For any existing annotation, its description can be changed by en-
tering an appropriate text in the panel below the list of all annotations.
» Appearance
» Show annotations: Turns on/off the annotations in the scene.

» Label color: Defines the label color of the annotations. Values are: Orange,
red, green and blue.

» Label size: Defines the label size. Values are: Large, medium and small.
» Scaling: Sets the automatic scaling mode to: Off, near or far.
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6.3.3 Clipping

Interaction » Clipping

With the Clipping Module, objects can be clipped for construction evaluation pur-
poses. You can think of a clipping plane as a magic wall that lets you look into solid
bodies.

» Clipping Plane

» Enable Clipping: By clicking the Enable Clipping check box, the clipping plane
is activated and some helper geometries like a plane visualization, a grid, the
clipping contour and some handles to move the clipping plane will be displayed.

» Position x/y/z: Shows the current position of the clipping plane.

» Pick Position: Allows to pick a new position for the clipping plane.

» Center Position: Positions the manipulator in the center of the screen.
» Align Position: Aligns the clipping plane parallel to the camera.
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»

»

Direction x/y/z: Defines the direction of the clipping plane

Toggle x/y/z: Sets the direction of the clipping plane to the chosen axis.
Invert direction: Inverts the direction.

Show manipulator: Shows/hides the manipulator.

Hide scene: Hides the whole scene. Shows only the contours of the clipped
objects on the clipping plane.

Show plane: Shows the ClipPlane.

» Visualisation The clipping modules provides different visualizations and helpers

»

»

»

»

»

»

»

»

for supporting the user at his task. The following utilities can be enabled or
disabled:

Show Clipping Plane: Shows/hides the clipping plane.
Plane Color: Defines the color of the clipping plane.

Show Grid: A grid for measurements can be enabled or disabled. The scale
will be automatically adopted to the viewers distance from the origin of the

clipping plane.
Grid Color: Defines the color of the grid.

Show Contour: Shows/hides the contours. Note that the contour has to be
calculated in real time, this can result in degraded performance for big models.
The contour can also be used for measurements.

Contour Color: Defines the color of the contour.
Contour Width: Defindes the thickness of the contours.
Clone Contour: Clones the contour.

» Genuine Clipping The clipping module also contains a special mode called gen-

uine clipping, which moves the clipping plane along predefined paths. A path
can either be a line geometry contained in the original model or a continu-
ous part of the clipping plane itself. In order to activate genuine clipping, you
first have to select a path along which the plane should move. This is done
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MODULES

by clicking on the Pick Clipping Path button and then picking a line geometry
within the scene (including any displayed clipping contour). After a path has
been selected, the clipping plane can be moved along that path by using the
mouse wheel while holding down the SHIFT key. Note that as soon as the user
repositions the clipping plane by other means, the clipping path is lost.

» Pick Clipping Path: Select a path along which the plane should move.

» Speed: Speed of the moving clipping plane.
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6.3.4 Measurement

Interaction » Measurement

The measurement module provides a collection of different distance measurement
tools. It also provides a ruler that can be enabled using the corresponding icon in the
global tool bar. While the ruler is active, it can be placed at any position by holding
down the shift key and pressing the left mouse button.

The main GUI of the measurement module is divided into three parts; the upper
section contains a list of all measurements and is also used to manage these, while
the middle section displays additional information for the currently selected measure-
ment. The lowest section contains some general options affecting all measurements
including the active color scheme or hiding all measurements in the render window.

The simplest measurements include point-to-point, point-to-object and object-
to-object measurements. Each of these can be created using the context menu
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of the measurement list. You will be prompted to select the first point (or object)
followed by the second point (or object), then the according distance will be calcu-
lated. After the measurement has been created, some parameters can be adjusted,
including the picked points or the hierarchy level used to calculate a minimum object
distance.

A special measurement for judging gaps is a line-to-object measurement, which
can be used if the original model already contains according line geometry. For cre-
ating a line-to-object measurement, the first object has to be a line geometry, while
the second may be either any other geometry. The measurement then will create
sample points along the line and for each point the minimum distance to the second
object will be calculated. The result will be displayed in the render window using a
special visualization of all distances: The distances will be displayed as lines both in
the 3D scene and in a 2D diagram at the lower left corner of the render window.
Hovering with the mouse over the diagram highlights a particular distance in the 3D
view and shows its exact value on top of the diagram.

The most complex measurement is the gap measurement which is a useful sub-
stitute of the line-object-measurement in the case no appropriate line geometry is
available. The gap measurement is calculated along the line segment between two
picked points on two distinct objects. The viewer will try to find multiple minimum
distances between the two objects, where each distance calculation is restricted to
be on a plane perpendicular to the line segment. The result will be displayed in the
render window using a special visualization of all distances, as for line-to-object mea-
surements.

Note that measurements starting and/or ending on objects identify these objects

by their name. Ensure that your measured objects have a unique name within the
scenegraph structure when saving and loading measurements.

» Right click context menu
» Add Point to Point Measurement: Calculates the distance between two explic-
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»

»

»

»

»

»

»

»

»

»

itly picked points.

Add Point to Object Measurement: Calculates the minimum distance between
one point and another object.

Add Object to Object Measurement: Calculates the minimum distance between
two objects.

Add Line to Object Measurement: Calculates minimum distances between mul-
tiple points contained on a line and another common object.

Add Gap Measurement: Calculates multiple minimum distances between two
objects. Used to judge gaps.

Remove Measurement: Removes a measurement.

Update Measurement: Updates a measurement (e.g. after moving an object).
Zoom in: Zooms in to a specific measurement.

Load Measurements: Loads measurements from a specified xml file.

Save Measurements: Saves measurements in an xml file.

Remove All Measurements: Removes all measurements.

» Properties Shows different properties depending on the selected measurement.

»

»

»

Point to Point

e Distance: The distance beween two points.

e First position: Shows the coordinates of the first position.

e Second position: Shows the coordinates of the second position.
Point to Object

e Distance: Shows the minimum distance beween the point and the object
below.

e First position: Shows the coordinates of the first position.
e Second node: Shows the second selected node.
Object to Object
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e Distance: Shows the minimum distance beween two objects.
e First node: Shows the first selected node.
e Second node: Shows the second selected node.
» Line to Object
e Line: Shows the selected line.

Object: Shows the second selected node.

Avg. Dist.: Calculates the average distance.
e Min. Dist.: Shows the minimum distance.
e Max. Dist.: Shows the maximum distance.
» Gap
e 1st Object: Shows the first selected node.

2nd Object: Shows the second selected node.

Avg. Dist.: Calculates the average distance.
e Min. Dist.: Shows the minimum distance.

e Max. Dist.: Shows the maximum distance.

» Visualisation
» Show Measurements: Enables/Disables the measurements in the scene.

» Color Scheme: Defines the display color of the measurements.

Orange
e Red
e Green
e Blue

» Measurement Precision: Sets the decimal measurement precision.
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6.3 Interaction

6.3.5 Sequencer

Interaction » Sequencer
The Sequencer Module allows to set up command sequences. The sequences are
executed in a batch process from top to bottom. They can be executed initially by
the user, or by other actions in the application which can be set by the user. All
entries are case sensitive. Right mouse button click offers the following options:
» Menu

» Create Sequence: Creates a sequence in which actions can be queued.

» Create Action: Actions are function sets, which can be used to activate and
edit settings in VRED.

» Duplicate: Duplicates the selected sequence or action.
» Select All: Selects all sequences and actions.
» Rename: Renames the selected sequence or sets the selected action parameter
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value. Actions cannot be renamed but you can enter a comment for each
action.

» Delete: Deletes the selected sequence or action.

» Active: Toggles the active state of the selected sequences and actions. Acti-
vated actions and sequences can be executed.

» Move Up: Shifts the selected sequences or actions one step up in the process
queue.

» Move Down: Shifts the selected sequences or actions one step down in the
process queue.

» Run: Executes selected sequences and actions. Inactive actions are not exe-
cuted.

» Run All: Executes all sequences, that have an active state.
» Slider Use the slider at the bottom of the module to expand or collapse all se-
guences and actions at once.
» Actions
» setEnvironmentVariable: Sets an environment variable.
e name: Sets the variable’s name.
e value: Sets the variable’s value.

» enableSimulation: Sets the simulation state. The simulation state defines whether
animation can be executed or not.

e state: true/false

» updateRender: Enforces a rendering refresh.
e force: true/false

» selectCamera: Selects a camera.
e name: Sets the name of the camera.

p)

4

showilnitialView: Activates the InitialView position.
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» jumpViewPoint: Sets the camera to a Viewpoint's position. This function im-
mediately jumps to the viewpoint (no interpolation). Viewpoints can be set in
the Camera Module.

e name: Sets the Viewpoint's name.

» enableViewPointsAnimation: Starts (true) or stops (false) the viewpoint anima-
tion. Deprecated.

e state: true/false

» setActiveSnapshotMovieRenderPasses: Activates render passes for image ren-
dering.

e beauty_pass: true/false

o diffuse_ibl_pass: true/false
e diffuse_light_pass: true/false
e glossy_ibl_pass: true/false

e glossy_light_pass: true/false
e specular_ibl_pass: true/false

e specular_light_pass: true/false. This parameter is deprecated, the specular
light pass no longer exists, therefore the parameter will be ignored.

e incandescence_pass: true/false
e diffuse_indirect_pass: true/false
e glossy_indirect_pass: true/false
e occlusion_pass: true/false

e normal_pass: true/false

e depth_pass: true/false

e material_id_pass: true/false

» resetActiveSnapshotMovieRenderPasses: Deactivates rendering the image with
render-passes.
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» setSnapshotICCProfile: Sets the ICC profile to be used for the rendered image.

profilelD: Sets the ID of the used profile.

- 0 uses the current settings from the render settings module
-1 uses sRGB encoding

- 2 uses Adobe RGB 98 encoding

- 3 uses the specified Monitor ICC Profile

- 4 uses the specified Image ICC Profile

» createSnapshot: Renders a single image.

filename: Sets the target directory and the image filename.
width: Sets the image width resolution in pixel.

height: Sets the image height resolution in pixels.
supersampling: Sets the sampling quality.

- 0 disables supersampling.

- 1 uses Y4 of the set image samples.

- 2 uses Y2 of the set image samples.

- 3 uses the set image samples.

alpha: Sets the state of alpha rendering.

- true: renders alpha channel. The resulting image will have a transparent
background including correct alpha values for transparent materials.

- false: does not render alpha channel.

alpha RED/GREEN/BLUE: Sets the alpha color. This defines the red, green
and blue component of the background color.

dpi: Sets the dots per inch resolution embedded in the rendered image.
overwrite: Allows to overwrite an existing file with the same name.
- true



- false

showlmage: Opens the image file after rendering is completed.
- true
- false

alpha premultiply: Multiplies the alpha and the color channel in the result-
ing image.

- true
- false

tonemap hdr: Applies tone mapping to the high dynamic image rendering.
As a result, the 32 bit renderings look the same in the compositing tool as
set in VRED. However, the values of the image will be compressed by the
chosen tone mapper to values between 0 and 1. In doing so, the dynamic
range will be lost. Therefore, effects like glow will be hard to calculate in
the compositing tool afterwards.

» createMovie: Settings for exporting a movie.

filename: Sets the target directory and the movie filename.
width: Sets the movie width resolution in pixel.

height: Sets the movie height resolution in pixels.

fps: Sets the frames to be rendered per each movie second.
startFrame: Sets the movie's start frame.

stopFrame: Sets the movie's end frame.

supersampling: Sets the sampling quality.

- 0 disables supersampling.

- 1 uses 1/4th of the set image samples.

- 2 uses half of the set image samples.

- 3 uses the set image samples.
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e alpha: Sets the state of alpha rendering.
- true: renders alpha channel.
- false: does not render alpha channel.
e alpha RED/GREEN/BLUE: Sets the alpha color.
e overwrite: Allows to overwrite an existing file with the same name.
- true
- false

e alpha premultiply: Multiplies the alpha and the color channel in the result-
ing image.

- true
- false

e frame step: Defines the frame offset for the rendering of image sequences.
Example: Step 3 renders only every third frame (0, 3, 6, 9, ...).

e tonemap hdr: Applies tone mapping to the high dynamicimage rendering.
As a result, the 32 bit renderings look the same in the compositing tool as
set in VRED. However, the values of the image will be compressed by the
chosen tone mapper to values between 0 and 1. In doing so, the dynamic
range will be lost. Therefore, effects like glow will be hard to calculate in
the compositing tool afterwards.

- true
- false
» createCubelmages: Exports an environment image.

e node_name: Specify the name of the node that will be used for the camera
position.

e type: Defines the type, as which the cube image will be created. 6 images
will be rendered and processed based on the chosen type.

- 0 = separate images
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-1 = vertical cross
- 2 = horizontal cross
- 3 = spherical map
e resolution: Sets the quadratic resolution in pixels.
e supersampling: Defines the level of antialiasing.
e filename: Filename of the image(s).
setSwitchMaterialChoice: Changes the choice of a switch material.
e name: Sets the Switch Material’s name.
e choice: Sets the Switch Material’s choice.
setMateriallmage: Helps to change a material’s textures.
e materialName: Sets the name of the material whose texture should be set.
o fieldName: Defines the field name of the texture slot to be set.
e imageFilename: Sets the path to the image.
setBackplate: Activates/deactivates a backplate.
e state: true/false
createBackplate: Creates a new backplate from the file provided.
e filename: Sets the backplate name to be created.
deleteBackplate: Deletes the backplate.

selectVariantSet: Activates a Variant Set. The variant set will activate all states
of its defined node and material variants.

e name: Sets the Variant Set’s name to be activated.
startAnimation: Starts an animation node in the Animation Module.
e name: Sets the animation name to be started.
stopAnimation: Stops an animation node in the Animation Module.

e name: Sets the animation name to be stopped.
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pauseAnimation: Pauses an animation node in the Animation Module.
e name: Sets the animation name to pause.

» continueAnimation: Continues an animation node in the Animation Module.

4

e name: Sets the animation name to continue.

» resetAnimation: Resets an animation node in the Animation Module.

T

e name: Sets the animation name to be reset.

» startSAnimation: Starts an animation node in the SAnimation Module.

4

startReverseSAnimation: Reverse an animation node in the SAnimation Mod-
ule.

p)

T

e name: Sets the animation name to be reversed.

p)

T

playCAnimation: Starts an animation clip.
e name: Sets the animation clip’s name to be executed.
e startFrame: Sets the start frame of the animation.
e endFrame: Sets the end frame of the animation.

)

x

pauseCAnimation: Pauses an animation clip.
e name: Sets the animation clip’s name to be paused.
e value: true/false

)

v

resetCAnimation: Resets an animation clip.
e name: Sets the animation clip’s name to be reset.

setVRMLViewpointsEnable: Activates or deactivates VRML Viewpoints. VRML
Viewpoints are camera animations imported via a vrml file from third party
software.

T

e state: true/false

p)

4

setVRMLcurrentViewpoint: Sets the VRML Viewpoint to be activated.
e name: Sets the VRML viewpoint name to activate.
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resetRenderLayers: Resets all Render Layer settings.
activateRenderLayer: Activates a Render Layer.

e name: Sets the name of the Render Layer to be activated.
setStillDOF: Activates or deactivates depth of field rendering.

e state: true/false

e radius: Sets the DOF blur amount

e focal distance: Sets the focus distance in millimeters

setRenderQuality: Sets the image render quality and image render mode. Avail-
able modes are:

e VR_QUALITY_ANALYTIC_HIGH
o VR_QUALITY_ANALYTIC_LOW
VR_QUALITY_REALISTIC_HIGH
VR_QUALITY_REALISTIC_LOW
VR_QUALITY_RAYTRACING

setRaytracinglmageSamples: Sets the amount of antialiasing samples for Ray-
tracing rendering.

e samples: The total number of image samples for Raytracing rendering.

setRaytracingAAAdaptiveSamples: Sets the minimum amount of adaptive sam-
ples for Raytracing rendering. This function is deprecated.

e samples: Sets the minimum amount of samples for Raytracing rendering.

setRaytracingAAThresholdQuality: Sets the raytracing attributes threshold qual-
ity.

setRaytracingAAlmageFilter: Sets the image filter algorithm for Raytracing ren-
dering.

e filterid: 0 = Box, 1 = Triangle, 2 = Gaussian, 3 = Mitchell Netravali, 4 =
Lanczos, 5 = BSpline, 6 = Catmull Rom, 7 = Sharp Triangle, 8 = Sharp
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Gauss, 9 = Sharp BSpline. For more information on the different filter
types see Pixel Filter in Modules » Rendering » Render Settings.

loadCluster: Loads a cluster configuration.

filename: The name of the XML-file with the cluster configuration cluster
configuration.

startCluster: Starts a cluster.

stopCluster: Stops a cluster.

computeMissingAmbientOcclusion: Calculates the ambient occlusion for all vis-
ible and selected nodes and their child nodes that do not have valid ambient
occlusion values assigned yet.

quality: The quality level (value from 0 to 5) for the ambient occlusion
calculation.

minDistance: The minimum distance of objects to be taken into account
for the ambient occlusion calculation.

maxDistance: The maximum distance of objects to be taken into account
or the ambient occlusion calculation.

indirectlllumination: Turns indirect illumination on or off.
colorBleeding: Turns color bleeding on or off.

gatherQuality: The quality level (value from 0O to 4) for the indirect illumi-
nation gathering passes.

numindiretions: The number of bounces (gathering passes) for the indirect
illumination.

subdivide: Turns geometry subdivision on or off.

minEdgeLength: Sets the minimum length an edge may have after subdi-
vision.

intensityThreshold: Sets the intensity threshold for a subdivision.

overrideMaterialColor: Turns material color override on or off.



6.3 Interaction

e materialColorR: Red component of the material override color.
e materialColorG: Green component of the material override color.

e materialColorB: Blue component of the material override color.
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6.3.6 Touch Sensor

Interaction » Touch Sensor

The Touch Sensor allows you to switch variants or play animations with a single click
on a node in the 3D scene. You can define a new touch sensor by simply dragging
a node from the Scenegraph into the Touch Sensor module. Please note that nodes
added to the Touch Sensor module have to be uniquely named within the scene. The
second step is to assign any existing Variant Set to this node by dragging it from the
Variant Sets module onto the respective node in the Touch Sensor module.

Instead of using drag and drop you can also add nodes and variant sets by using
the module toolbar:

» Create Node Allows to add a node to the Touch Sensor by entering its name.

» Create Variant Allows to add a variant set to a node defined in the Touch Sensor
by entering the set name. Prior to this, the node must be selected.
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6.3 Interaction

» Remove Removes a node or variant set from the Touch Sensor.
Right mouse button click offers the following options:

» Delete Deletes the selected item.
» Delete All Deletes all defined touchsensors.

» Select Nodes Selects the selected node in the scenegraph.
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6.3.7 Tracking

Interaction » Tracking

The tracking module is responsible for connecting an external tracking system to
VRED by communicating to one or more VRPN (Virtual Reality Peripheral Network)
servers. VRPN is an open source standard library for accessing many different tracking
systems with a unified approach.

» Devices The first and most important tab of the tracking module within VRED is
dedicated to the tracking devices and their sensors.
Each tracking device represents a complete tracking system consisting of a
tracking space, a coordinate system and one or more sensors.
This tab allows you to define VPRN devices. VRPN provides the connection
support between the application and all kinds of devices using the appropriate
class-of-service for each type of device sharing this link. These devices may be
tracker, button devices, haptic devices, analog inputs or sound. Right click in
the window to see the submenu:

P

v

Add device: Adds a new VRPN device. Type in a resource in URI notation.

» Remove device: Removes the selected VRPN device.

v

» Reset device: Resets the selected device to its initial state.

v

Edit calibration: Edits the calibration matrix of the selected device. The calibra-
tion matrix is a measurement mapping of the real space to the virtual space.
The following options appear:

p)

v

e Clear Translations: Clears any translation (offset) in the matrix.
e Matrix Transformation mode:
- Reset: Resets the matrix to its initial state.

- Z-Up to Y-Up: Retransforms the matrix so that the up-vector is now
represented by the y axis.

- Y-Up to Z-Up: Retransforms the matrix so that the up-vector is now
represented by the z axis.
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e Rotation: Sets the rotation of the projection for x, y and z-axis.
Reset calibration: Resets the calibration data to standard values.
Calibrate: Calibrates the selected device.

Clear Config: Clears the complete configuration.
Caution: All presets will be deleted!

Load Config: Loads configuration data from an xml-file.
Save Config: Saves configuration data to an xmi-file.

You can add a new tracking system by using the context menu in the device
list. You have to enter its name (in the form trackername@computername)
and then a connection to that VRPN server will be established. Then you can
start or stop the complete tracking process by clicking on the checkbox Enable
Tracking left of the device list.

By using the last two columns in the device list you can rotate the coordinate
system (Z-Up) and enable or disable the complete device (On).You can also cali-
brate the coordinate system as described above. A calibration needs one sensor
that describes the new coordinate systems, both its new origin and its new ori-
entation. You can also edit the calibration matrix directly, but it is discouraged
to use this method. When a device is created and selected, sensors can be
added to the device.

Unfortunetaly, VRPN does not tell which sensors are connected, so you have
to enter them manually in the sensor list. You can also name each sensor for
accessing these via Python-scripts - the name has no other function. The fol-
lowing sensor types are supported:

Buttons: Buttons are simple trigger buttons that have a unique identifier and
target. Buttons do not need to be calibrated.

Analogs: Analogs are to be understood as analog pointing devices, such as a
joystick. Each movement axis must be mapped by adding an “analog” sensor.

Dials: This type of sensor is capable of detecting states on rotary dials such as
a volume control on a stereo system.
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Bodies: Bodies probably are the most interesting sensor, as these are the only
sensors that have a position and orientation in space. Thus these are also the
only sensors that can be calibrated or connected to a node.

Connecting a body to a node is an important task that will update a transform
nodes matrix with the values coming from the corresponding sensor.

In order to connect a sensor with a node (only transform nodes are supported),
simply enter the name of the node in the field Target of the sensor. There are
three special targets that connect a sensor to the camera instead of a node.
These are as follows:

Powerwall: This special target enables headtracking as needed for powerwall
projections. In order to make this mode work, you either have to use a render
cluster or enable the powerwall viewing mode from the main menu bar in
VRED.

HMD: The HMD mode is for head mounted displays.

Camera: The camera mode is a very special mode that simply tracks the position
of a sensor but does not track its orientation.

In addition to these special targets you can also enable or disable the absolute
tracking mode as described above by clicking the checkbox in the last column
of the sensor list. Unchecking the absolute tracking mode will enable a tracking
mode that transforms the target relativ to the camera position.

Using the context menu you can also calibrate any sensor of type body, as
described above. The calibration will reset the position and orientation of the
node that is connected to the body.

» Servers The second tab of the tracking module contains a list of VRPN servers

which are controlled by the cluster service. You can add new servers by using
the context menu and entering their network adress. All servers in this list can
be started and stopped using the context menu. Note that the cluster service
must be running on the remote machine to be useable with this list. Right click
in the window to see submenu:

» Add server: Adds a new tracking device.
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» Remove server: Removes the selected tracking server.
» Start server: Starts the selected tracking server
» Stop server: Stops the selected tracking server.
» Refresh servers: Refreshes all tracking servers defined.

» Navigation Requires the availability of a fly stick (ART).
» Navigation Type:
e None: No navigation type is selected.

e Scene Move: Moves the scene when moving the tracking body as long as
you press the button.

e Point Fly: Flies forward/backward according to flystick orientation, or en-
ables to rotate around flystick axis.

e Calibrated Cart: This is used in the special automotive "Sitzkisten” sce-
nario.

» Navigation Configuration:
e Navigation Tracker: Please select a navigation tracker device.
e Navigation Button: Please select a navigation button device.

e Horizontal Analog: Please select a sensor for the horizontal navigation
tracker device. These sensors can be defined using the “>Devices”< tab.

e Vertical Analog: Please select a sensor for the vertical analog navigation
tracker device. These sensors can be defined using the “>Devices”< tab.

» Cart Calibration
» Calibration Tracker: Select the Calibration Tracker from the dropdown menu.
» Offset Transform Node: Sets the offset transform node.

» Use Cart Calibration: Please check whether you want to use cart calibration or
not.
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6.4 Rendering

6.4.1 Render Settings

Rendering » Render Settings

» File Output
» Image:

e Camera: Sets the camera for the rendering. The default setting is Perspec-
tive camera.

e Filename: Sets the path and name of the image file to save the rendering
to.

e Use Time Stamp: Appends a timestamp to the filename.
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Image Size Presets: Sets image or printing size from a preset.

Image Size: Sets the image width and height in pixels.

Printing Size: Sets width and height of the resulting print in centimeters.
Resolution: Sets the printing resolution in dots per inch.

Region Render: Restrict rendering to the rectangular region specified by
the coordinates below.

- Upper Left Corner: Defines the X and the Y coordinate for the upper
left corner of the region frame.

- Lower Right Corner: Defines the X and the Y coordinate for the lower
right corner of the region frame.

- Use Current Render Window Region: Sets the upper left and lower right
corner according to the rectangle that has been selected in the render
window viewport as region in region rendering mode. If the button is
activated, upper left and lower right corner are updated automatically
with any change of the region in the viewport.

Render Mode: Sets the illumination mode to apply for rendering the image
to file. Caution: This value automatically changes the still frame illumina-
tion mode in the Raytracing Quality tab.

Render Quality: Sets the number of image samples which will be used
for rendering. Caution: This value automatically changes the Antialiasing
Image Samples value of the General Settings tab.

Supersampling: Activates/Deactivates supersampling for the rendering.
The default setting is On.

Background Color: Sets the background color when rendering a file with
raytracing.

Tonemap HDR: Applies tone mapping to the high dynamic image render-
ing. As a result, the 32 bit renderings look the same in the compositing
tool as set in VRED. However, the values of the image will be compressed
by the chosen tone mapper to values between 0 and 1. In doing so, the
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dynamic range will be lost. Therefore, effects like glow will be hard to
calculate in the compositing tool afterwards.

e Export Alpha Channel: Activates alpha channel rendering. The alpha chan-
nel will be embedded into the resulting image, if the file type supports
alpha channels. The background color mentioned above is seen through
transparent objects.

e Premultiply Alpha: Renders the alpha channel premultiplied.

e ICC Profile: Sets the ICC Profile for the rendering. The default setting is
Current Settings.

» Meta Data: Choose to embed certain scene settings in your rendering. This
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option is only available for JPG, PNG and TIF files. Later, you can import the
rendering (its meta data) into VRED via File Menu » Import » Rendering Meta
Data. The settings that have been saved in the meta data are then applied to
the currently loaded scene, for example the camera is set to the state of the
rendering.

e Render Settings: Embed current render settings as meta data of the ren-
dering, for example rendering resolution, images samples, pixel filter and
raytracing quality settings.

e Camera: Embed the settings of the currently active camera as meta data.
e Scenegraph:

- Node Visibilities: Embed the visibility states of all scenegraph nodes as
meta data.

- Switch Node States: Embed all switch node choice states as meta data.

e Switch Material States: Embed all switch material choice states as meta
data.

Saving and restoring node visibilities and switch node states relies on a consis-
tent naming scheme of the nodes within the scenegraph hierarchy, as defined
below. The same applies for switch materials within the hierarchy of the ma-
terials in the material editor group view. As the meta data does not contain



information on nodes/materials that are added or renamed since the rendering,
their states remain unchanged when importing the rendering meta data. Also,
if there are inconsistencies some states may not be reconstructed. All nodes
and materials whose state could not be reconstructed will be displayed in a
import results dialog after the import has finished.

e Consistency of visibility states:

In the meta data, a node is identified by its node path which is a con-
catenation of the names of its ancestors and itself. If all nodes with the
same node path have the same visibility, the node path is considered to
be consistent and it is stored with this visibility on meta data export. If
nodes with the same node path have different visibilities, this node path
is considered to be inconsistent and it is not stored. The visibility state of
those inconsistent nodes cannot be reconstructed on import and remains
unchanged.

To ensure that all visibilities are exported and can be reconstructed on im-
port, either make sure that all nodes with the same path have the same
visibility, or create an unambiguous node path by renaming the respective
nodes.

e Consistency of switch states:

- In the meta data, the state of a switch node/material is defined by the
name of the node/material selected by the choice (called “choice name”
in the following). The choice is considered to be consistent if the choice
names of all switches with the same node/material path are identical.
To ensure that all switch states are exported and can be reconstructed
on import, either make sure that all switches with the same path have
the same choice, or rename the respective switches.

- When importing switch states, a state of a switch in the scene cannot
be restored if the switch has several children called “choice name”. In
this case, the switch is displayed in the import results dialog with its
proposed choice name.

Your switches should not have multiple choices with the same name.
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» Renderpasses:

Export Renderpasses: Activates rendering with render passes. All acti-
vated Renderpasses will be rendered and saved at a time. NOTE: To re-
construct the beauty pass image using the other renderpasses it is nec-
essary to render to EXR/HDR/Floating Point TIFF image format without
“Tonemap HDR" activated. Tonemapping changes the linearity of values
and therefore needs to be done after the renderpasses are combined to the
final image. To reconstruct the beauty pass, the Diffuse IBL/Light/Indirect,
Glossy IBL/Light/Indirect, Specular Reflection, Translucency and Incandes-
cence Passes need to be layered using a linear add operation in your com-
positing tool.

» Animation:

Render Animation: Enables to render an animation.
Type: Sets the type of animation.
Animation Clip: Selects the clip which will be rendered

Format: Choose whether to save the rendered animation as image se-
guence or movie.

Use Clip Range: Enables to use the range of the selected clip. Sets auto-
matically the start and stop frame of the clip.

Start Frame: Sets the start frame of the sequence to be rendered.
Stop Frame: Sets the end frame of the sequence to be rendered.

Frame Step: Skips a predefined amount of frames between rendered frames,
e.g.: Frame Step 3, Start O would result in rendering frames 0, 3, 6, 9...

Frames Per Second: Sets the frame rate for the image sequence.

» Cluster:
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Enable Cluster: Enables the cluster.

Hostname: Defines the clustering slaves. Hostnames as well as IPs can be
used to access the slaves.



» General Settings

» Antialiasing: The Antialiasing settings control the number of samples taken
during stillframe antialiasing. These are the primary controls that influence the
quality of the rendered image.

e Image Samples: Sets the number of samples taken during stillframe an-
tialiasing. Higher values produce a cleaner result while lower values reduce
the render time. A value of 128 is recommended as starting point in gen-
eral but may be too low for interieur scenes with full global illumination.

e Adaptive Sampling: Adaptive sampling allows the raytracer to skip regions
that are already smooth and focus the processing power on regions that
are still noisy. The various quality settings control a threshold for a region
to be considered as smooth. Setting the control to “Highest Quality” dis-
ables adaptive antialiasing and always samples each pixel with the number
of image samples specified. While this gives the highest render quality it
may waste processing power on regions that are already smooth.

- Preview Quality: Sets the sampling quality to a very low level, resulting
in preview render quality and very short render times.

- Low Quality: Sets the sampling quality to low level, resulting in average
render quality and short render times.

- Medium Quality: Sets the sampling quality to medium level, resulting in
good render quality and medium render times.

- High Quality: Sets the sampling quality to high quality level.
- Ultra High Quality: Sets sampling quality to a production quality level.

e Use Clamping: Sometimes sampling may result in single very bright pix-
els that are hard to antialiase. There are two options to get rid of these
samples:

- Tracing many more image samples: Casting more image samples would
sample these bright pixels softer, but results in higher calculation times.
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- Clamping the image values to a specified maximum value. Be aware

that the results may look dull if the clamping value is set too high.
Caution: Activating clamping and reducing the value will reduce the
maximum resulting image color range.

» Pixel Filter: A pixel filter weights the image samples taken per pixel and there-
fore controls the antialiasing quality of the rendering. High image filter sizes
may result in blurry image results.

e Filter: There are 10 different pixel filter available in VRED:

- Triangle Filter: The triangle filter linearly distributes the samples be-

tween the various pixels. It gives decent results and is therefore the
default pixel filter in VRED. It should be used with a size of 1.0 indepen-
dent of screen resolution.

- Box Filter: The box filter is the simplest pixel filter. It weights each image

sample equally. A size of 0.5 should be used for this pixel filter.

- Gaussian Filter: The gaussian filter uses a gaussian function to weight

the samples. Samples near the center of a pixel receive a larger weight
compared to samples that are further away from the pixel center. It
gives slightly better results compared to the triangle filter in some situ-
ations. A size of 1.0 to 1.2 is recommended.

- Mitchell Netravali: The mitchell netravali filter prevents blurring that may

occur when using box, triangle, gaussian, or bspline filter by sharpening
the image. It gives the highest quality result but may suffer from ringing
on hard contrast edges. A size of 2.2 is recommended.

- Lanczos Filter: The lanczos filter is a sinc-based filter that does an op-

timal reconstruction of the image. It delivers very sharp high quality
results but may suffer from ringing. A size of 2.5 is recommended.

- Bspline Filter: The bspline filter uses a bspline function to weight the

samples. It gives results comparable to gaussian filtering but suffers
less from blurring. A value of 1.3 to 1.5 is recommended.



- Catmull Rom: The catmull rom filter creates sharp images but may suffer
from ringing, just like the lanczos and mitchell netravalli filter. A size of
2.5 is recommended.

- Sharp Triangle Filter: In this triangle filter variant one sample effects only
one pixel. This way the first impression of the image looks sharper and
the image noise is high frequent.

- Sharp Gauss Filter: In this Gauss filter variant one sample effects only
one pixel. This way the first impression of the image looks sharper and
the image noise is high frequent.

- Sharp BSpline Filter: In this BSpline filter variant one sample effects only
one pixel. This way the first impression of the image looks sharper and
the image noise is high frequent.

e Size: The pixel filter size defines the number of neighboring pixels will be
taken in account to for sampling.

» Options: You may enable or disable certain rendering features globally.

e Enable Photometric Parameters: Activates the photometrically consistent
rendering pipeline to generate images containing realistic and reliable lu-
minance information. The process chain includes photometric input val-
ues for light sources, environment maps, materials, cameras, clamping
threshold and the display luminance. Spectral data for light sources and
incandescence are photometrically consistent and physically implausible
parameters are removed from the user interface. This mode provides the
means to reproduce the rendering results with realistic luminance infor-
mation on the display. Therefore, it is necessary to set up the dispay lumi-
nance parameter to match the current display, preferably using measured
data. Also, the clamping threshold and the tone mapping parameters of
the cameras are to be adjusted accordingly.

e Enable Spectral Rendering: Activates the spectral rendering pipeline for
raytracing. The lighting simulation calculation will use spectral distribu-
tions for all the colors instead of conventional tristimulus RGB values. The
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spectral information for the color channels of materials and light sources
can be provided and edited by opening the respective color dialogs. In
the color dialog, activate the “Spectrum” tab to gain access to the spec-
tral data. To enable spectral input data for a color channel, activate the
“Use Spectrum” checkbox. The plot area displays the spectral distribution
depending on the settings to the right.

- Spectrum:

- File: Allows loading and saving a spectral distribution to a file based
on the settings in this window.

- Red/Green/Blue: Allows computing spectral data from RGB input
values.

- Scale: Rescales the photometric value of a spectrum by changing
the value V of a spectrum while keeping the hue H and saturation
S constant.

- Edit Sample Distribution: Allows setting the number and distribution of
spectral samples in the spectral domain. Note: Changing the sample
distribution will only take effect after pressing “Apply”.

- Presets: Choose from a collection of predefined settings suitable
for most use cases. Sampling spectra between 380 and 730 nm is
widely considered sufficient to capture the perception of light by
human observers.

- Allow Non-Uniform Sample Distribution: Allows editing the sample
wavelengths of the spectral samples individually.

- Start: The wavelength of the first spectral sample of the distribution.
- Delta: The distance between the samples to be created.
- Number: The number of samples to be created.

e Optimize for Many Light Sources: In scenes with many light sources or
geometry light sources rendering may slow down. Activating this flag
allows the renderer to optimize the light calculation by reducing the quality
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slightly which significantly increases the rendering performance. While
you don’t recognize the quality loss in most situations, there may be scenes
that may suffer from heavy noise when this feature is turned on. In such
scenes you may need to disable the optimization to get a clean render
result.

e BRDF Behaviour: The new BRDF model conserves energy better. The
weighting of the diffuse/glossy/specular layers should take into account
the glossy/specular colors additionally to the fresnel reflectivity so that the
result does not show dark edges when the glossy color to black, but in-
stead displays a purely diffuse material. This does also allow better fine-
tuning of the specular reflections. For compatibility reasons, the old BRDF
model can still be chosen from the following list.

- Ver. 2014 and above
- Ver. 6.0x and below

e Number of CPU Cores: Sometimes you may want to limit the number of
raytracing cores VRED uses to have some processing power left for other
applications. This settings is a runtime only setting and it does not influ-
ence any cluster machines.

» Raytracing Quality

» Illumination Mode: VRED has various illumination modes for rendering in ray-
tracing. You may choose different illumination modes for interactive rendering
and still frame rendering. This allows to work in a precomputed mode for fast
interaction with the scene and automatically switching to full global illumina-
tion for still frame rendering. Four modes are available:

e CPU Rasterization: While the render product is OpenGL-like, the CPU Ras-
terization feature allows to import and visualize huge datasets. CPU Ras-
terization does not compute direct reflection, nor does it compute refrac-
tion or any other sophisticated visual effect.

e Precomputed Illumination: The precomputed illumination mode is com-
parable to VRED OpenGL rendering mode. It uses precomputed ambient
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occlusion and indirect illumination for rendering and calculates specular
reflections and refractions and correct shadows from lightsources.

e Precomputed + Shadows: The Precomputed + Shadows Mode uses pre-
computed image based lighting and indirect illumination but doesn’t use
precomputed Ambient Occlusion values. Instead it calculates shadows
based on the active environment.

e Precomputed + IBL: The new Precomputed + IBL Mode uses precomputed
indirect illumination and samples the environment. It replaces the old Fast
Global lllumination mode.

e Full Global Illumination: The Full Global lllumination Mode doesn’t use
any precomputed values but accurately samples everything in a physically
based approach. Note that other features like Photon Mapping require
the rendermode to be set to Full Global lllumination.

» Photon Tracing: Photon Tracing provides an approach to calculate the global
illumination in a scene. The default full global illumination mode in VRED pro-
vides high quality results but may require longer calculation times. Photon Trac-
ing can reduce the time required to render a clean image by a larger margin,
especially in indoor scenarios like car interieurs or architectural indoor scenes.

e Mode: VRED provides different Photon mapping modes.

- Off: Disables Photon Tracing and uses the default full global illumination
algorithm in VRED.

- Indirect Only: Uses photon tracing to calculate the indirect illumination
in a scene. This is the most common mode.

- Caustics + Indirect: Uses Photon Tracing to calculate indirect illumina-
tion and caustics due to specular materials in a scene.

e Trace Depth: Sets the trace depth of the photon tracer.

e Interactive and still frame count: The two photon count values specify
the number of photons being sent into the scene for each image sample.
Specifying a photon count of 100000 photons while having set the image
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samples set to 256 will result in 25.600.000 photons send into the scene
for a frame. More photons result in smoother results.

Use Automatic Photon Radius: A preprocess is doing a lookup of the 16
closest photons for each photon in the scene and calculates two times the
average lookup radius. This feature works for most situations.

Photon Radius: The Photon Radius specifies the radius around a scenes’s
hitpoint used by the raytracer to find photons around the hitpoint. A larger
radius allows the raytracer to find more photons but may result in slower
lookup times.

Final Gather Quality: There are two ways to use the photon map. The first
approach is always used for caustic photons. It gathers photons around a
hitpoint to calculate the incoming illumination. This approach gives very
fast interactive performance and is capable to calculate all light pathes in
a scene, but it may require a very high photon count to get a clean im-
age. The other approach is to use final gathering. In final gathering a
one bounce indirect illumination is performed before evaluating the Pho-
ton Maps. This is the default Photon Tracing approach in VRED since it
generates high quality images in a very short time.Setting the final gather
quality to 0 enables the first approach while setting it to any other value
uses the second approach.

Final Gather Radius: Sets the lookup radius used to find the nearest fi-
nal gather point during raytracing. Using a smaller radius will increase
performance but it requires more photons to avoid dark regions. Tip: To
evaluate the final gather points use the “Indirect lllumination Rendering”
with photon mapping and final gathering turned on. For a good quality
result the final gather points should have very few black regions where
no photons are stored.

Final Gather Refresh: Setting the Final Gather Quality to 1 or higher, the
update frequency of the Photon Map may be set. By default the Photon
Maps are updated for each image sample, sending a large number of pho-
tons into the scene. While this is necessary if final gather quality is set to
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0 it is often sufficient to update the Photon Map only once per frame and
use it for each image sample to reduce the render times.

- On Each Sample: This updates the Photon Map for each image sample.
This is the default setting since it also works for scenes with animated
objects that may cause flickering otherwise.

- On Scene Change: The Photon Map is updated once per frame only
unless motion blur is activated. Since caustics require many photons,
the Caustic Map will still be updated for each sample while the indirect
illumination Photon Map will only be updated once. This setting often
results in the best rendering performance but requires a much higher
photon count to receive artefact-free results, particularly when render-
ing scenes with animated objects, the result may flicker in regions with
a low photon count. This is why this mode should only be used for
scenes with static geometry and materials.

e Use Final Gather For Glossy Reflections: If activated, glossy reflections are
not evaluated by path tracing but use the final gather map instead. This
reduces the rendertime but results in less accurate reflections.

» Lightsource Sampling Quality Settings:
e Interactive: Sets the interactive lightsource sampling quality.
e Still Frame: Sets the still frame lightsource sampling quality.
» Reflection/Refraction Sampling Quality Settings:

e Interactive: Sets the interactive sampling quality of reflections and refrac-
tions.

e Still Frame: Sets the still frame sampling quality of reflections and refrac-
tions.

» Trace Depth Settings:

e Max Trace Depth: Sets the maximum amount of reflection and refraction
each ray may encounter.

e Max Shadow Depth: Sets the maximum amount of shadow samples.



» Photon Tracing Notes and Tips Photon Tracing has its main advantages in in-
terior scenes. In exterior scenes most of the light illuminates the scene directly,
the default full global illumination mode in VRED shows the best performance
in this case.

Be aware that the number of photons emitted doesn’t resemble the number
ofphotons actually stored. If a photon misses the scene it will not be stored. A
photon bouncing several times in a scene might be stored more than once.To
keep the number of emitted photons as low as possible, place any light emit-
ters in a way that most photons will hit the scene.

When using Final Gathering scenes may suffer from light leaks if the photon
radius is set too large. Light leaks mainly result from bad geometry in architec-
tural scene. An example would be an interior of a room illuminated through
a window, the walls being modelled as simple planes. Any geometry near the
wall would get light from outside the room since there is no actual thickness
of the wall. The solution would be to actually model the outer walls as well.
Reducing the lookup radius may also fix the problem but may require shooting
more photons into the scene.

Final gathering may also show problems in scenes with very strong indirec-
tions where the scene is primarly illuminated by light resulting from reflections
of a wall. In these situations disabling final gathering may give you a cleaner
result.
» Display Output
» Color:
e Monitor Colorspace:
- Simple Gamma
- SRGB IEC 61966-21
- A.RGB98
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- Monitor ICC Profile

Improve Color Depth: Enables dithering to hide banding artefacts caused
by the limited precision of 8-Bit displays.

Dynamic Tonemapping: Turns on/off dynamic tonemapping in the post
processing procedure.

» Histogram: The histogram shows the relative color distribution of the rendered
image. This tool is very useful to detect overbright areas of light. Different
modes are available. Logarithmic and linear display scale.

Show Histogram: Each color distribution can be viewed separately
Red: Shows histogram of red image channel.

Green: Shows histogram of green image channel.

Blue: Shows histogram of blue image channel.

Logarithmic Scale: Uses a logarithmic scale for the histogram values.
Greyscale: Shows the luminance histogram of the rendered image.

» Visual Support:

Show Snapshot Frame: Draws a yellow frame into Renderview, indicating
the target image to be rendered.

Show Region Render Frame: Draws a green frame into the Renderview
dependent on the values of the region start XY and region end XY input
fields.

Show Rule of Thirds Guide: Draws orange guide lines into Renderview,
allowing to use the rule of thirds.

Show Inner Frame: Draws an orange frame into Renderview, indicating
the area where text or graphics show neatly.

Unit: Defines the distance unit of the inner frame.
Left - Right: Sets the distance of the left and right side.
Top - Bottom: Sets the distance of the top and bottom side.



6.4.2 Cluster

Rendering » Cluster
Provides all information about the clustering capabilities in VRED Professional.

» Projection Defines the way to project the scene. Depending on what entry in
"Cluster Mode" you choose, one of the following options may appear:
» Powerwall Settings:

e Servers: Defines the servers to be used to render the scene. (Default:
"localhost”)

e Columns: Defines the amount of colums of the powerwall.
e Rows: Defines the amount of rows of the powerwall.
e Stereo Mode: Defines whether to render in stereo mode or not. Values:

- Mono
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- Passive Stereo
- Active Stereo

- Passive Stereo (dual port)

Pipe Resolution: Defines the resolution of one pipe (e.g. one display).

Pipe Cverlap: Defines the overlap of one pipe to another.

Pipe Offset: Defines the offset of one pipe.

Camera Aspect: Distorts the camera. Works in stereo mode only.

» Custom Projection Settings: You can define separate pipes for the scene. We
recommend using the wizard to create new pipes and viewports.

e Add Pipe: Adds a new pipe.

e Delete Pipe: Deletes the selected object.

e Clear All Pipes: Clears all pipes and viewports.
e Add Viewport: Adds a new viewport.

e Clone Viewport: Clones the selected viewport.
e Number of rows: Specifies the number of rows.

e Wizard: Starts the wizard which guides you through the process of defin-
ing a new pipe.
» Raytracing Cluster Settings:
e Servers: Here you define your clustering slaves. Hostnames as well as IPs
can be used to access the slaves./mportant: All slaves need the same VRED
version to work together properly. After connecting to the renderslaves

please use the “License check” feature to make sure all slaves have the
same version installed.

e Compression: Turns on/off compression mode of the data stream between
all slaves.

e Mosaic Tile Size: Defines the mosaic tile size in pixels.
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e Parallel Channels: Number of parallel channels available to send back im-
age data. ldeally, the number of channels corresponds with the number
of the cluster computers.

e Switch to OpenGL on Cluter Exit: Switches to the OpenGL rendering mode
after cluter exit.

e Advanced:
- Parallel Receive: Used to debug internally.

- Upload to Graphic Card] When disabling this function, the received im-
age will not be uploaded to graphics card. The monitor will appear
black. The function helps to find out how much time a picture needs to
be uploaded to the graphics card.

- Debug Output: Gives information about the tile distribution. You have
to execute with the -console option to get a extra console window.

- Check License: Checks if all defined cluster slaves have a compatible
VRED version installed.

» Network Settings: Some settings are highly specialized and should rarely be
touched. If you need further information, please contact Autodesk.

e Connection Type: Defines the connection type. Values are: Unicast, pipeline,
multicast

e Connection Params: Defines specific connection parameters. Default is
"TTL=8"

e Service Address: If you have more than one network card enter here your
ip address with the last number replaced by 255 e.g. “192.168.0.255".

e Multicast Group: Ip address of the multicast group.

e Network Card IP: Add your ip address here if you have more than one
network card in your computer.

e Direct Connection: Defines the port you may want to connect to.
e Network Test: Starts the network connection test
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Get Network Host IDs: Collects all Network HostIDs.

» Render Options: Some settings are highly specialized and should rarely be
touched. If you need further information, please contact Autodesk.

Eye Separation: Defines the eye separation in millimeters.

Zero Parallax Distance: Specifies the distance from viewer to the surface
of the display.

Antialiasing Mode: Unsupported feature
Hardware Sync: Unsupported feature

Enable Edge Blending: Turns on/off edge blending. Please define the val-
ues comma separated like the following: (Gamma)r, g, b

Gamma (r, g, b): Unsupported feature
Hide Taskbar: Hides the taskbar.
Create Desktop: Unsupported feature

» Add Settings Adds a new clustering preset to the scene.

» Load Settings Loads your presets for clustering from an xml-file.

» Save Settings Saves the current definitions into an xml-file.

» Start Settings Starts the clustering service.

» Stop Settings Stops the clustering service.

» Servers The servers are started via the special clusterService daemon. You should
install this daemon as a service on windows and as a daemon on unix.

» Cluster Server Autostart: The clusterServer is auto startet via the clusterService.

» Show Daemon State: Shows the state of the clusterService daemon.

» Terminate Cluster Server: Tries to terminate all running clusterServer's.

» icon bar
» Start Cluster
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6.4 Rendering

6.4.3 Render Layer

e ————

[
&

Rendering » Render Layer

The Render Layer Module enables you to define how single geometries should be dis-
played. Please note that this feature is only available in Raytracing mode. Once you
have created a layer you can assign geometries to this layer by dragging nodes from
the Scenegraph to it. In order to see any changes you have made to layer attributes
you need to activate the layer with the context menu or by using the icon in the tool
bar. Please note: The order in which render layers are activated is important. In case
of doubt, reset and then activate the render layers in the correct order.

For each render layer the following attributes can be activated (On) or deactivated
(Off). You can change between On and Off by double left-clicking. If you do not
want to double-click each single setting of the nodes of a layer, you can change all
settings of one layer at once: Right-click on the layer and choose “Apply Attributes
to Selected...".
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6 MODULES

» Visible Sets the attributes for Color and Alpha Channel. Setting this attribute to
OFF objects will not be rendered at all.

» VisiblelnAlpha Sets attributes for the Alpha Channel. Setting this attribute to OFF
objects will not be rendered in the Alpha Channel. This is the way to produce
cutouts.

» PrimaryVisibility Sets the attribute for the Color Channel. Setting this attribute
to OFF objects will not be rendered in the Color Channel but they will still cast
shadows and can bee seen in the reflections.

» VisibleInReflections Sets the attributes for reflection. Setting this attribute to OFF
objects will not be visible in reflections.

» VisibleInRefractions Sets the attribute for refractions. Setting this attribute to
OFF objects will not be visible in refractions.

» CastShadows Sets the attribute for casting shadows. Setting this attribute to OFF
objects will not cast shadows.

» ReceiveShadows Sets the attribute for receiving shadows. Setting this attribute
to OFF objects will not receive shadows of any other object.

» DoubleSided Renders the side of an object not showing to the camera. When
switching OFF the double side mode, the side not showing to the camera will
not be rendered.

» VisibleForPhotons \When set to OFF, photon algorithms will ignore the objects of
this layer.

» Context Menu
» Create Layer: Creates a new empty Render Layer.
» Rename: Renames a Render Layer.
» Delete: Deletes a Render Layer.
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Duplicate Layer: Duplicates the selected Render Layer.
Move Up: Moves a Render Layer one position up in the stack.
Move Down: Moves a Render Layer one position down in the stack.

Apply Attributes to Selected: Sets Render Layer attributes for all selected ob-
jects at once in one layer.

Add Selected Nodes: Adds selected objects from the Scenegraph to selected
Render Layer.

Select Nodes: Selects the selected nodes in the Scenegraph.
Cleanup: Removes non existing objects from Render Layers.
Activate Layer: Activates the layer.

Reset Layer: Deactivates all layers.
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6 MODULES

6.4.4 Surface Analysis

il

Rendering » Surface Analysis

The Surface Analysis module allows to analyze the quality of a surface. The user
can examine the continuity of different types of virtual lines like isophotes that are
displayed on the objects in the scene. By this means, discontinuities on surfaces can
be detected. The module can be used for analyzing polygonal as well as NURBS data.

» Analysis Mode

» Activate Surface Analysis: Enables / disables the Surface Analysis rendering
mode. You can also activate this rendering mode by selecting it in the Visu-
alization Menu.

» Analysis Mode: Selects the analysis mode.

e Isophotes: With isophotes it is possible to determine whether a surface is
continuous in position, tangency or curvature. Isophotes are lines which
mark spots of same brightness on the surface. The surface is assumed to
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be perfectly diffuse reflecting. It is lit from both sides by a directional light
emitting parallel light beams. The user can set the direction of the light
source. The isophote lines are view-independent meaning that the lines
do not change when moving the camera (except when using the option
“Use Camera View Vector” explained below).

e Highlight Lines: Highlight lines mark spots on a surface whose extended
surface normals intersect light lines (defined below). Highlight lines are
view-independent as well.

e Reflection Lines: Reflection lines are reflections of light lines. This analysis
mode is view-dependent.

» Both Highlight Lines and Reflection Lines need light lines to be defined as a kind
of virtual light source. You can choose between two different basic shapes on
which the light lines appear:

e Longitudinal Lines on a Sphere: The lines are meridians on a sphere (lines
from pole to pole) which encloses the scene and is of infinite size. The
user can set the axis of the sphere.

e Parallel Linear Lines on a Plane: The lines are parallel straights on a plane.
The user can set their position and rotation.

» Define Light Source Depending on the chosen Analysis Mode the GUI changes
in frame “Define Light Source”.

» For Isophotes:

e Show Light Direction: Shows an arrow in the render view for the picked
direction. It can be modified by using the rotation manipulator to rotate
the arrow (does change the direction) and the translation manipulator to
move it (does not change the direction). Please note: The translation does
not change the direction of the light and therefore has no influence on
the isophotes.

e Direction: Offers the opportunity to enter values manually. Caution: The
entered values are automatically normalized if the direction manipulator
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is enabled via “Show Light Direction”. If you want to enter X,Y,Z manually
without normalization, please disable the manipulator.

Normalize: Normalizes the manually entered direction vector to length 1.
Set to Axis: Sets the direction to X (1, 0, 0), Y (0, 1, 0) or Z (0, O, 1).

Pick Surface Normal: This button enables a tool to select surface normals
as light direction. SHIFT + left mouse button allows to select a normal of
an object. Click the button again to disable the tool.

Use Camera View Vector: To reproduce the Discontinuity rendering mode
from previous VRED versions select Isophotes as Analysis Mode and enable
“Use Camera View Vector”. This updates the direction depending on the
camera viewing direction.

» For Highlight/Reflection Lines with Logitudinal Lines on a Sphere:

e Show Sphere with Light Lines: Shows the currently set spherical light lines

on the sphere together with a transform manipulator that allows you to
rotate the sphere.

e Sphere Rotation: Offers the opportunity to enter values manually.
e Set to Axis: Sets the sphere axis to X (1, 0, 0), Y (0, 1, 0) or Z (0, 0O, 1).

e Pick Surface Normal: This button enables a tool to select surface normals

as sphere axis. SHIFT + left mouse button allows to select a normal of an
object. Click the button again to disable the tool.

» For Highlight/Reflection Lines with Parallel Linear Lines on a Plane:
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e Show Plane with Light Lines: Shows the light lines together with a trans-

parent representation of the plane in the render view and a transformation
handle for translating and rotating the plane.

e Light Plane Origin: Sets the origin of the plane.
e Light Plane Rotation: Sets the rotation of the plane.

e Lines Spacing: Defines the distance between the lines on the plane.



e Limited Lines Length: Per default all lines are infinitely long. If “Limited
Lines Length” is activated the length of the lines can be defined via slider.

e Pick Surface Normal: This button enables a tool to select surface normals
as plane normal. SHIFT + left mouse button allows to select a normal of
an object. Click the button again to disable the tool.

» Lines / Stripes The following settings allow to define the visual appearance of the
lines on the surfaces.

» Type: Defines the style that is used to display the analysis lines on the object
surfaces.

e Thin Lines: Uses thin sharp lines.
e Stripes: Uses stripes that can be modified in their sharpness and thickness.
e Zebra: Uses a classical zebra pattern.

» Count: Defines the number of lines.

» Color: Defines the color of the lines.

» Surface These settings allow to define the visual appearance of the surfaces.

» Lighting: Sets the lighting situation for the surfaces. For Isophotes, the sur-
faces are lit by the defined directional light. For Highlight/Reflection Lines, the
surfaces are lit by a headlight.

e Ambient: The surfaces are displayed single-colored. The color is defined
by Base Color.

e Diffuse: The surfaces are assumed to be diffuse. Set the diffuse reflection
color via Base Color.

e Phong: The surfaces are lit with the phong lighting model. You can set
the diffuse reflection color via Base Color, the glossy reflection color via
Glossy Color and the roughness.

e NURBS UV: Show the parameterization of nurbs surfaces. Triangle meshes
are displayed in Ambient mode.
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6 MODULES

6.5 Scripting

6.5.1 Terminal

View » Terminal

The Terminal Module offers an input line and gives feedback about errors and warn-
ings. It is also possible to directly enter Python commands. To access the terminal
window select View » Terminal. With the context menu (press right mouse button)
you can save the terminal output to a file. For more information on the python script-
ing environment, please refer to the Python Documentation found in VRED under
Help » Python Documentation.

216



6.5 Scripting

6.5.2 Script Editor

Edit » Script Editor

The Script Editor is a module in which Python Scripts can be written and executed.
To access the Script Editor select Edit » Script... For more information on the python
scripting environment, please refer to the Python Documentation found in VRED un-
der Help » Python Documentation.
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7.1 Truelight Materials

7.1.1 General Truelight Material Settings

Many truelight materials used in VRED share the same properties. These attributes
are explained below.

» Incandescence Settings The incandescence defines the shader’s self-illumination
behavior.
» Color: Sets the self-illumination colour.
» Intensity: Sets the self-illumination intensity.

» Use Texture: Loads an image texture, which defines the self-illumination area
and intensity.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture will be repeated.
e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy (OpenGL Only): Sets the texture filter quality for the image
texture. Value 1 is lowest quality. Value 16 is highest quality.

e Use as Light Source (Raytracing Only): If this option is turned on, geometry
with the shader applied will act like a geometry light source.
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llluminate Shadow Material: If turned on, the geometry light will illumi-
nate shadow materials. You will also need to set the Reflection Mode of
the shadow material to Diffuse, Glossy or Diffuse + Glossy.

Cast Shadow on Shadow Material: You may disable shadows cast by the
geometry light onto shadow materials.

Shadow Intensity: Sets the intensity of shadows cast by the geometry light.

Interactive Quality: Sets the light sampling quality during interactive ren-
dering.

Still Frame Quality: Sets the light sampling quality during still-frame ren-
dering.

» Transparency Settings The transparency settings define the shader’s opacity.

» See Through: Renders the shader transparent.

» Use Texture: Loads an image texture, which defines the self-illumination area
and intensity.
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Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture will be repeated.
Repeat UV: Sets the number of repetitions for the Uvs.

Offset UV: Sets the offset for the UVs.

Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. Value 1 is
lowest quality. Value 16 is highest quality.

Invert Texture: Inverts the texture.



7.1 Truelight Materials

» Subsurface Scattering

Translucency and subsurface scattering are two completely different methods
of calculating light passing through the back of an object into the observer’s
‘eye’. While translucency requires far less calculation power, subsurface scat-
tering does offer more possibilities and greater flexibility.

P

v

Translucency: The translucency algorithm allows to collect light from the averted
side of an object. It then calculates the distance between the entrance and exit
of the ray path and determines the intensity of the translucency. These effects
can be controlled. There are two modes when operating with translucency,
depending on what objects to project:

e Thin Walled Translucency: This mode is suitable for one-sided objects. It
requires more calculation time than the solid translucency mode, but when
in doubt, use this mode.

e Solid Translucency: The solid translucency is used for solid objects. Please
note that unpredictable problems can occur when using this mode on
one-sided objects.
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e Color: Determines the color of the scattering/translucent light.

e Roughness: Defines the amount of diffusion that is applied to translucent
light.

e Use Texture: Loads an image texture for the diffuse color channel. Uses
the image as pattern on the surfaces.

- Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and
y-axis with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

- Link repeat modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

- Repeat UV: Sets the number of repetitions for the Uvs.
- Offset UV: Sets the offset for the UVs.
- Rotate: Rotates the UVs.

- Anisotropy: Sets the texture filter quality for the image texture. 1 is the
lowest quality. 16 is the highest quality.

» Subsurface Scattering: Incoming light on the averted side of an object is re-
fracted in all directions. With this feature it is possible to simulate the behavior
of wax or other translucent materials. There are two modes available:

e Single Scattering: The single scattering mode allows light to bounce once
inside a material before it is reflected to the outside. This mode is less
accurate but requires less calculation time than multiple scattering.

e Multiple Scattering: The multiple scattering mode allows light to bounce
several times inside a material before it is reflected to the outside. This
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mode is more accurate but requires more calculation time than single scat-
tering.

Attenuation: The distance that the light travels inside the medium is de-
pending on the attenuation value. The higher the value, the more light is
absorbed inside the medium.

Asymmetry: This value describes the directional characteristic of incoming
light, and its weighted behavior. The value -1 defines that light is com-
pletely distributed to the averted side along the incoming light path. The
value 1 defines that light is completely distributed along the incoming light
path. The value 0 describes a homogeneous distribution of light inside the
medium.

Select Medium: The medium presets offer you a large collection of com-
mon index of refraction values to choose from.

Index of refraction: The refraction index defines the "optical density’ and
therefore the way light is refracted when passing differently dense mate-
rials.

Use Texture: Loads an image texture for the diffuse color channel. Uses
the image as pattern on the surfaces.

- Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and
y-axis with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

- Link repeat modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

- Repeat UV: Sets the number of repetitions for the Uvs.
- Offset UV: Sets the offset for the UVs.
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7 MATERIALS REFERENCE

- Rotate: Rotates the UVs.

- Anisotropy: Sets the texture filter quality for the image texture. 1 is the
lowest quality. 16 is the highest quality.
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7.1 Truelight Materials

» Displacement

Displacement maps are detailed maps, which are interpreted as height infor-
mation. Using displacement maps you can create highly detailed structures
from rather simple geometry by just using a plain image. Each point on the
geometry is displaced along the interpolated vertex normals using the height
information of the map, resulting in a realistic silhouette and producing cor-
rect shadows and reflections. Accuracy is only limited by the resolution of the
texture image and memory requirements are very low. To avoid cracks in the
displaced surfaces the vertex normals should be smooth and consistent. Using
a higher tesselated bases mesh can improve performance a lot.
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Displacement Height: Defines the height of the displacement.

)

v

Use Accurate Silhouettes in OpenGL: Off by default, this feature allows to cal-
culate the displacement in OpenGL like in raytracing mode. Turning it on may
drastically reduce the performance.
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Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.
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Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

» Raytracing Settings These settings take effect in Raytracing rendering mode only.

»

»

)

»
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Material ID: Sets the material id.

Line Tube Radius: Sets the radius of the tube when the shader is applied to a
line geometry.

Use Local Environment: If activated, diffuse and glossy reflections are calculated
from the environment that is assigned to this material in all illumination modes.
Specular reflections are still determined by the environment that is present in
the scene.

Override Trace Depth: If enabled, the setting overrides the global set maximum
raytrace depths.

Max Interactive Depth: Sets how often a ray may get refracted or reflected
during interactive rendering.

Max Still Frame Depth: Sets how often a ray may get refracted or reflected
during still-frame rendering.



» Override lllumination Mode: If enabled, the setting overrides the global set
illumination modes for interactive or still frame rendering.

e Interactive Mode: Sets the render quality mode and render quality level
during Renderview interaction.

- Precomputed lllumination: The Precomputed Illumination Mode is com-
parable to VRED OpenGL rendering mode. It uses precomputed Am-
bient Occlusion and indirect illumination for rendering and calculates
specular reflections and refractions and correct shadows from light-
sources.

- Precomputed + Shadows: The Precomputed + Shadows Mode uses pre-
computed image based lighting and indirect illumination but doesn’t
use precomputed Ambient Occlusion values. Instead it calculates shad-
ows based on the active environment.

- Precomputed + IBL: The new Precomputed + IBL Mode uses precom-
puted indirect illumination and samples the environment. It replaces
the old Fast Global lllumination mode.

- Full Global lllumination: The Full Global lllumination Mode doesn’t use
any precomputed values but accurately samples everything in a phys-
ically based approach. Note that other features like Photon Mapping
require the rendermode to be set to Full Global Illumination.

e Still Frame Mode: Sets the render quality mode and render quality level
during still frame rendering.

- Precomputed lllumination: The Precomputed lllumination Mode is com-
parable to VRED OpenGL rendering mode. It uses precomputed Am-
bient Occlusion and indirect illumination for rendering and calculates
specular reflections and refractions and correct shadows from light-
sources.

- Precomputed + Shadows: The Precomputed + Shadows Mode uses pre-
computed image based lighting and indirect illumination but doesn’t
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use precomputed Ambient Occlusion values. Instead it calculates shad-
ows based on the active environment.

- Precomputed + IBL: The new Precomputed + IBL Mode uses precom-
puted indirect illumination and samples the environment. It replaces
the old Fast Global lllumination mode.

- Full Global lllumination: The Full Global lllumination Mode doesn’t use
any precomputed values but accurately samples everything in a phys-
ically based approach. Note that other features like Photon Mapping
require the rendermode to be set to Full Global lllumination.

» Override Reflection Sampling Quality: If enabled, the setting overrides the
global sampling quality for reflections/refractions.

e Interactive Quality: Sets the reflection/refraction sampling quality during
interactive rendering.

e Still Frame Quality: Sets the reflection/refraction sampling quality during
still-frame rendering.

» Override IBL Sampling Quality: If enabled, the setting overrides the global IBL
Sampling quality for sampling the environment map.
e Interactive Quality: Sets the IBL sampling quality during interactive render-
ing
e Still Frame Quality: Sets the IBL sampling quality during still-frame render-
ing

» Common The common settings define material settings that are present in all
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BRDF materials.

» Occlusion Color: Sets the shader’s pre-calculated ambient occlusion color.

» Occlusion Intensity: Sets the shader’s pre-calculated ambient occlusion inten-
sity

» Compress Textures (OpenGL): Compresses all used textures to reduce memory
usage.



» Sort Key (OpenGL): Controls the order of drawing transparent surfaces.

» Environment: Click Right Mouse Button to select the HDR-Image to be used as
light source. See Sphere Environment material.

» Lighting Mode: The Lighting Mode menu sets the light model to be used for
the shader. There are five different lighting models.

IBL + Indirect + Direct Lights: The shader will be affected by the HDR-
Image, by the pre-calculated or interactive Global lllumination rendering
and by the direct light sources placed in the scene.

IBL + Indirect: The shader will be affected by the HDR-Image and by the
pre-calculated or interactive Global Illumination rendering.

IBL + Direct Lights: The shader will be affected by the HDR-Image and the
direct light sources placed in the scene.

IBL: Only the HDR-Image affects the shader.
Direct Lights: Only direct light sources placed in the scene affect the shader.
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7.1.2 Brushed Metal

The TrueLight Brushed Metal material simulates any type of metal surfaces.

» Brushed Metal Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.
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Glossy Color: Sets the shader’s color for glossy reflection. Reflection behavior
is described by the law of reflection which states that the direction of incoming
light (incident ray) and the direction of outgoing light reflected (reflected ray)
form the same angle with respect to the surface normal. Since a surface usually
is not perfectly smooth, the orientation of the normals varies, thus creating a
glossy reflection.
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Roughness UV: The roughness parameter defines the amount of diffuse reflec-
tion and its complement specular reflection. The higher the roughness value,
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the more diffuse reflection will be rendered.

On metallic surfaces the roughness can vary against the surface direction. Espe-
cially when the surface is finished. Due to this the roughness can be separately
setin U and V direction.

» Metal Type: The Metal Type attributes allows to choose between a wide range
of metal material presets.

» Reflectivity: Sets the Brushed Metal’s reflective intensity.
» Clearcoat Settings Sets the clearcoat color. The clearcoat is a transparent, strongly
reflective paint layer on the base metal layer.

» Clearcoat Type: The Fresnel Term describes the intensity of a reflection based
on the viewing angle. Its intensity at normal incidence is set by the material’s
reflectivity.

e Off: Turns off the clearcoat.
e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.

» Clearcoat color: Sets the clearcoat color.

» Reflectivity: Sets the clearcoat reflective intensity.

» Brush Orientation

» Brush Mapping: Allows to choose between a range of possible brush orienta-
tions, e.g. metal brushed in one direction or metal with radial brushes. For ex-
ample, Brush Mapping ‘Radial XY’ simulates radial brushes within the xy-plane.
The projection planes are defined relative to the object coordinate system of
the object the material is assigned to.

e Size U: Defines the brush'’s size on the U-axis.
e Size V: Defines the brush'’s size on the V-axis.

» The properties of the chosen Brush Mapping can be further modified.
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e Planar Mapping (Brush Mappings ‘Planar XY’, ‘Planar XZ', ‘Planar YZ')
- Orientation X/Y/Z: Sets the projection plane’s orientation.
e Radial Mapping (Brush Mappings ‘Radial XY’, ‘Radial XZ', ‘Radial YZ')
- Center X/Y/Z: Sets the projection plane’s center of the radial brushes.

- Orientation X/Y/Z: Sets the projection plane’s orientation of the radial
brushes.

e Triplanar Mapping (Brush Mapping ‘Triplanar’)
- X/Y/Z Rotate: Sets the projection plane’s rotation on the X/Y/Z-axis.

» Diffuse Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

e Repeat UV: Sets the number of repetitions for the Uvs.
o Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Input Gamma: Sets the texture image gamma correction.
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Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sRGB.

» Glossy Texture

» Use Texture: Loads an image texture for the glossy color channel. Uses the
image as pattern on the surfaces.

Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

Input Gamma: Sets the texture image gamma correction.

Use ICC Profile: If turned on, the texture’s colors will be interpreted based

on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sSRGB.

» Roughness Texture

» Use Texture: Loads an image texture for the roughness channel. Uses the image
as pattern on the surfaces.
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e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Minimum Roughness U: Sets the minimum roughness for U which is de-
termined by the red color channel of the roughness texture.

e Maximum Roughness U: Sets the maximum roughness for U which is de-
termined by the red color channel of the roughness texture.

e Minimum Roughness V: Sets the minimum roughness for V which is de-
termined by the green color channel of the roughness texture.

e Maximum Roughness V: Sets the maximum roughness for V which is de-
termined by the green color channel of the roughness texture.

» Bump Texture

» Use Structure: Uses a procedural structure generated by VRED to simulate a
rugged surface.

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.
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e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture.
e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Affects Clearcoat: Allows the structure or bump texture to affect
the clearcoat reflections.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Displacement, Raytracing, Incandescence, Common
and Transparency settings please refer to the "General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.3 Carbon

The TrueLight Carbon material is a procedural material that simulates carbon surfaces.
It offers a special triplanar texturing mode which is useful for objects that do not have
an appropriate UV mapping.

» Triplanar Carbon Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.
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Glossy Color: Sets the shader’s colour for glossy reflections. Glossy reflections
result from irregularities of a surface at a microscopic level. Reflection behavior
is described by the law of reflection which states that the direction of incoming
light (incident ray) and the direction of outgoing light reflected (reflected ray)
form the same angle with respect to the surface normal, thus the angle of
incidence equals the angle of reflection. Since a surface is usually not perfectly
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smooth, the orientation of the normals varies, thus creating a glossy reflection.

» Roughness: The roughness parameter defines the microscopic roughness of a
surface. The higher the roughness value, the more diffuse the glossy reflections
will be rendered.

» Clearcoat Settings Sets the clearcoat color. The clearcoatis a transparent, strongly
reflective paint layer on the base carbon layer.

» Clearcoat Type: The Fresnel Term describes the intensity of a reflection based
on the viewing angle. Its intensity at normal incidence is set by the material’s
reflectivity.

e Off: Turns off the clearcoat.
e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.

» Clearcoat color: Sets the clearcoat color.

» Reflectivity: Sets the clearcoat reflective intensity.

» Carbon Pattern Settings

» Pattern type: There are several different pattern types, according to the carbon
structures usually sewed.

e 2X2
e 3 X 1 staircase
e 3 X 1 interleave
e 5X1
» Pattern Size: Sets the carbon structure size.
» Pattern intensity: Sets the fissure depth intensity.

» Pattern orientation (Rotate x,y,z): Sets the pattern direction on x, y and z pro-
jection direction.

» Bump Texture
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» Use Structure: Activates a procedural bump structure.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

For further information on the Displacement, Raytracing, Incandescence, Common
and Transparency settings please refer to the “General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.4 Carbon 2D

The Truelight Carbon 2D material is a procedural material that allows to simulate
carbon surfaces. The carbon pattern is mapped to the surface by using the texture
coordinates of the object to which the material is assigned. Therefore, an appropriate
UV mapping is required. Alternatively you can use the CarbonMaterial which offers
a special triplanar texturing mode.

» Carbon Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader takes on, when the light reflection of the surface is spread to many
directions.

» Glossy Color: Sets the shader’s colour for glossy reflections. Glossy reflections
result from irregularities of a surface at a microscopic level. Reflection behavior
is described by the law of reflection which states that the direction of incoming
light (incident ray) and the direction of outgoing light reflected (reflected ray)
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form the same angle with respect to the surface normal, thus the angle of
incidence equals the angle of reflection. Since a surface is usually not perfectly
smooth, the orientation of the normals varies, thus creating a glossy reflection.

» Roughness: The roughness parameter defines the microscopic roughness of a
surface. The higher the roughness value, the more diffuse the glossy reflections
will be rendered.

» Clearcoat Settings Sets the clearcoat color. The clearcoat is a transparent, strongly
reflective paint layer on the base carbon layer.

» Clearcoat Type: The Fresnel Term describes the intensity of a reflection based
on the viewing angle. Its intensity at normal incidence is set by the material’s
reflectivity.

e Off: Turns off the clearcoat.
e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.
» Clearcoat color: Sets the clearcoat color.
» Reflectivity: Sets the clearcoat reflective intensity.

» Carbon Pattern Settings Defines the carbon pattern.

» Pattern Type: There are four different pattern types, according which carbon
structures are usually sewed.

e 2X2

e 3 X 1 staircase

e 3 X 1 interleave

e 5X1
» Pattern Size: Sets the carbon structure size.
» Pattern Intensity: Sets the fissure depth intensity.
» Rotate: Defines the pattern’s rotation value.
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» Bump
» Use Structure: Activates a procedural bump structure.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

For further information on the Displacement, Raytracing, Incandescence, Common
and Transparency settings please refer to the "General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.5 Chrome

With the Chrome material chromic and metallic surface behaviors can be simulated.

» Chrome Material Settings
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Reflection Color: Sets the chrome reflection color. When the chrome reflection
is colored, reflected objects will also be colored.

Smear: Sets the reflection’s blur amount. Only supported in OpenGL rendering
mode.

Contrast: Sets the reflection’s contrast level.
Saturation: Sets the reflection’s saturation level.

Type: Various metal types are available (for example Aluminium, Silver, Gold,
Cobalt, Copper, Chromium, Iron, and many more).

Use Roughness: Activates roughness value.



» Roughness: Sets the roughness of the material. The higher the roughness
value, the blurrier the reflection will be.

» Roughness Texture

» Use Texture: Loads an image texture for the roughness channel. Uses the image
as pattern on the surfaces.

Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

Minimum Roughness: Sets the minimum roughness which is determined
by the red color channel of the roughness texture.

Maximum Roughness: Sets the maximum roughness which is determined
by the red color channel of the roughness texture.

» Bump Texture

» Use structure: Activates a procedural bump structure.

» Use texture: Activates a Texture Menu. Loads an image texture for the bump
channel. Uses the loaded image as a pattern on the surfaces.
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e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture.
e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. Value 1 is
lowest quality. Value 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Displacement, Raytracing, Incandescence, Common
and Transparency settings please refer to the “General Truelight Material Settings”
section at the beginning of the chapter.
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7.1 Truelight Materials

7.1.6 Environment Switch

The Environment Switch is a bin shader, in which environment materials such as
Sphere Environments and Skylights can be stored and selectively addressed. The Envi-
ronment Switch can be assigned as a standard environment material to any TrueLight
Material.

» Use as Default Environment Sets the Environment Switch as default Environment.

» Choice Sets the environment material’s ID to be used. By changing the Environ-

ment Switch’s Choice ID, different environment materials can be connected
instantly to all Truelight materials.
Right Mouse Click and choose “Add Environment...” to list all existing envi-
ronment materials. Then select any environment material to be connected to
the Environment Switch. All connected environment materials are listed in the
Environment Switch material.
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7.1.7 Flipflop

A TrueLight Flipflop material offers a carpaint shading which varies in color under
different viewing angles.
» Flipflop Carpaint Material Settings

» Base Color: Sets the diffuse reflection color of the Flipflop. The shader adopts
this color, when the surface is globally lit.

» Flake Settings Describes the metallic flake's behaviour, which are embedded in
metallic paints. They have a strong specular light reflection and are layered on
top of the base shading color.

» Flake Color 1: Sets the metallic shiny flake’s first color. It gets stronger and
more brilliant the further the normal orientation points away from the camera.

» Flake Color 2: Sets the metallic shiny flake’s second color. It gets stronger and
more brilliant the further the normal orientation points towards the camera.
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»

»

»

»

Blending: Defines the mixture ratio of two colors. Drag the slider to the left
to increase the intensity of color 1. Drag the slider to the right to increase the
intensity of color 2.

Roughness: Defines the amount of diffuse reflection and its complement spec-
ular reflection. The higher the roughness value, the more diffuse reflections
will be rendered.

Flake Size: Sets the flake's size.

Flake Intensity: Sets the flake’s contrast value of each flake’s normal direction.

» Clearcoat Settings Sets the clearcoat color. The clearcoat is a transparent, strongly
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reflective paint layer on the base paint layer.

Clearcoat Type: The Fresnel Term describes the intensity of a reflection based
on the viewing angle. Its intensity at normal incidence is set by the material’s
reflectivity.

e Off: Turns off the clearcoat.
e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.
Clearcoat color: Sets the clearcoat color.
Reflectivity: Sets the clearcoat reflective intensity.
Use orange peel: Activates a noisy bump structure in the shader.
e Orange peel frequency: Sets the bump structure’s noise frequency.

e Orange peel intensity: Sets the bump structure’s intensity.

For further information on the Displacement, Raytracing, Incandescence, Common
and Transparency settings please refer to the “"General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.8 Glass

The TrueLight Glass material simulates glass surface behaviors including frosted glass.

» Glass Material Settings

» Exterior Transparency: Sets the shader’s transparency color. The exterior trans-
parency acts like a color filter for the light coming from behind the surface. A
darker color blocks more light making the surface more opaque.

» Interior Transparency: Sets the shader’s transparency color. The interior trans-
parency acts the same as the exterior transparency. It filters the light coming
from behind the surface. A darker color blocks more light making the surface
more opaque. In OpenGL mode, the interior transparency sets the color of the
glass when the surface normal is facing away from the viewer while the exte-
rior transparency sets the color when the normal is facing towards the viewer.
Raytracing ignores this attribute.

» Reflection Color: Sets the shader’s colour for reflections.
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»

»

»

»

»

»

Select Medium: Offers a wide selection of refraction indices based on materials
existing in reality.

Index of Refraction: Sets the material’s refraction index. Only supported in
Raytracing rendering mode.

Use Reflectivity: Sets the material’s reflectivity intensity.

Fresnel Term Quality: The Fresnel Term describes the intensity of a reflection
based on the viewing angle. Its intensity at normal incidence is set by the
material’s reflectivity.

e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.

Solid Shadows (Cast Photon Caustics): If turned on, the Glass will cast a solid
(black) shadow if a rendermode is selected that can calculate caustic effects
due to refractions. Otherwise the color of the shadow will be calculated solely
on the Glass's color.

Use Roughness: If turned on, the Glass will be handled as frosted glass with
glossy reflections and refractions.

Use Material Density: If turned on, ray-travelling through the glass gets atten-
uated based on the distance it travels inside the glass.

» Texture Settings Texture settings define how a texture will be placed on the sur-
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face and how the planar projection will be blended at the edges.

Texture Mode: Defines how a texture will be placed on the surface, whether
uses UV Coordinates or Triplanar projection.

Edge Blend: Sets the range for overlapping areas of the planar projection.
Texture Size X: Defines the textures size on the X-axis.
Texture Size Y: Defines the textures size on the Y-axis.
Uniform Repeat: Synchronizes the repetition value for all projection axes.

X Repeat U, XV, Y/U, Y/V, Z/U, Z/V: Set the repetition value of the U and V-axis
for each projection direction.
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» X Offset U, X/V, Y/U, YNV, Z/U, Z/V: Set the offset value of the U and V-axis for
each projection direction.

» X,Y,Z Rotate: Sets the projection orientation.

» Roughness Texture

» Use Texture: Loads an image texture for the roughness channel. Uses the image
as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Minimum Roughness: Sets the minimum roughness which is determined
by the red color channel of the roughness texture.

e Maximum Roughness: Sets the maximum roughness which is determined
by the red color channel of the roughness texture.

» Bump Texture

» Use Structure: Activates a procedural bump structure.
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» Use Texture: Loads an image texture for the bump channel. Uses the image as
pattern on the surfaces.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

e Repeat UV: Sets the number of repetitions for the Uvs.
o Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Displacement, Raytracing, Common and Transparency
settings please refer to the “General Truelight Material Settings” section at the be-
ginning of the chapter.
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7.1.9 Glow

The Glow allows to apply a glow effect to specific geometry parts.

» Glow Material Settings
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Inner color: Specifies an inner color of the glowing part (e.g. the inner color of
a flame is orange and white).

Outer color: Specifies the outer color of the glowing part (e.g. the outer color
of a flame would be close to white with a reddish touch).

Intensity: Specifies the the glow’s intensity.
Falloff: Specifies the glow’s falloff value.
Sort key: Sets the render priority of the Glow. Only supported in OpenGL mode.



7.1.10 Light Portal

The Portal Light Material attracts Photons and therefore helps to control the position
and the amount of photons in a scene. If a portal light material is assigned to an
object in a scene, most of the photons are moving to this object.

The Portal Light Material should be assigned to helper geometries and should be
placed in a scene above objects which need to get more photons. This way, the Por-
tal Light Material leads to faster render results for scenes with indirect illumination.

Possible usecase: If you want to render an interior that is only lit through one win-
dow, it is useful to create a plane geometry, assign a portal light material to it and
position and scale the plane to fit your window.

The Portal Light Material only works in Full Global Illumination Mode in combina-
tion with Raytracing. By default, objects with a portal Light Material do not affect
the rendering in any other way.

» Visibilty: Sets the visibility of the Geometries to which the Portal Light Material
is assigned. Usually a visibility of 0 is recommended.
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7.1.11 Line Chrome

The TruelLight Line Chrome is especially designed to shade tiny line structures like
windscreen heat-pipes and similar structures.
» Line Chrome Material Settings
» Reflection Color: Sets the chrome reflection color.
» Use roughness: Activates diffuse chrome reflections.
» Line Width: Sets the thickness of the lines drawn.
For further information on the Displacement, Raytracing, Common and Transparency

settings please refer to the "General Truelight Material Settings” section at the be-
ginning of the chapter.
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7.1.12 Measured

The TrueLight Measured material allows to load BTF (bidirectional texture function)
measurement files.

» Measured Material Settings
» Measurement: Loads a BTF measurement file.

» Exposure: Controls the intensity ao the measured colors. It should stay at 1.0.

» Texture Settings

» Texture Mode: Controls how the BTF Material is applied to the object.
e UV Texture Settings:

- Repeat U, Repeat V: Uses the UV texture coordinates to place the mea-
sured data.
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e Triplanar: Generates triplanar texture coodinates to place the measured
data.

- Edge Blend: Sets the range for overlapping areas of the planar projec-
tion.

- Blend Mode: Sets the way how the areas overlap.

- Uniform Repeat: Synchronizes the repetition value for all projection
axes.

- X Repeat U, X/V, Y/U, Y/V, Z/U, Z/V: Sets the repetition value of the U
and V-axis for each projection direction.

- X Rotate, Y Rotate, Z Rotate: Sets the projection orientation.

For further information on the Raytracing, Incandescence, Common and Transparency
settings please refer to the "General Truelight Material Settings” section at the be-
ginning of the chapter.

256



7.1.13 Measured Carpaint

The TrueLight Measured Carpaint material allows to load carpaint measurement files.

» Measured Carpaint Settings
» Measurement: Loads a carpaint measurement file.
» Exposure: Controls the intensity of the measured colors. It should stay at 1.0.

» Fresnel IOR: Controls the refraction index of the clearcoat layer. When loading
a carpaint measurement it is initialized to the refraction index stored in the
measurement file.

» Triplanar Texture Settings
» Uniform Repeat: Synchronizes the repetition value for all projection axes.

» X Repeat U, XV, Y/U, Y/V, Z/U, Z/V: Set the repetition value of the U and V-axis
for each projection direction.
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» X,Y,Z Rotate: Sets the projection orientation.

For further information on the Raytracing, Incandescence, Common and Transparency
settings please refer to the "General Truelight Material Settings” section at the be-
ginning of the chapter.
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7.1.14 Office Color Science (OCS) Material

The Office Color Science (OCS) Material allows to load BRDF files exported from Cl-
Navigator. The Cl-Navigator is a software system by Office Color Science Co., Ltd.
that calculates metallic and pearlescent paint formulations from measurements of
given target paint samples. The BRDFs of those measurements and simulations can
be exported by Cl-Navigator in a VRED compatible BRDF file format (*.pbrdf).

» Office Color Science Material Settings
» OCS BRDF: Loads a BRDF file.

» Automatic Reload: Enable Automatic Reload to let VRED check whether the
BRDF file specified above has been updated by Cl-Navigator. This is the case
when the BRDF export from Cl-Navigator overwrites the file. VRED detects this
modification and reloads the file. Please note that only one OCS Material can
be monitored at the same time.

» Exposure: Controls the intensity of the material. It should stay at 1.0.

259



» Clearcoat The clearcoat is a transparent, strongly reflective layer on top of the
base paint layer.

» Clearcoat color: Sets the clearcoat color.

» Fresnel Term Quality: The Fresnel Term describes the intensity of a reflection
based on the viewing angle. Its intensity at normal incidence is controlled by
the clearcoat reflectivity or fresnel IOR parameter, depending on the chosen
Fresnel Term Quality mode.

e Off: Turns off the clearcoat.

e Fast: Uses a fast but less accurate approximation to the Fresnel Term.

Accurate: Uses a physically accurate evaluation of the Fresnel Term that is
controlled by setting the reflectivity parameter.

Use Fresnel IOR: Uses a physically accurate evaluation of the Fresnel Term
that is controlled by setting the refraction index of the clearcoat layer.

For further information on the Raytracing, Incandescence, Common and Transparency
settings please refer to the "General Truelight Material Settings” section at the be-
ginning of the chapter.
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7.1.15 Metallic Paint

The Metallic Paint offers a shading model suited for metallic painted surfaces like
metallic car paint.
» Metallic Carpaint Material Settings

» Base Color: Sets the diffuse reflection color of the UnicolorPaintMaterial. The
shader adopts this color, when the surface is globally lit.

» Flake Settings Describes the metallic flake's behaviour, which are embedded in
metallic paints. They have a strong specular light reflection and are layered on
top of the base shading color.

» Flake Color: Sets the metallic shiny flake’s base color.

» Roughness: Defines the amount of diffuse reflection and its complement spec-
ular reflection. The higher the roughness value, the more diffuse reflections
will be rendered.
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» Flake Size: Sets the flake's size.
» Flake Intensity: Sets the flake's contrast value of each flake’s normal direction.
» Clearcoat Settings Sets the clearcoat color. The clearcoat is a transparent, strongly

reflective paint layer on the base paint layer.

P

v

Clearcoat Type: The Fresnel Term describes the intensity of a reflection based
on the viewing angle. Its intensity at normal incidence is set by the material’s
reflectivity.

e Off: Turns off the clearcoat.

e Fast: Uses a fast but less accurate approximation to the Fresnel Term.

e Accurate: Uses a physically accurate evaluation of the Fresnel Term.
» Clearcoat color: Sets the clearcoat color.

)

v

Reflectivity: Sets the clearcoat reflective intensity.
» Use orange peel: Activates a noisy bump structure in the shader.
e Orange peel frequency: Sets the bump structure’s noise frequency.
e Orange peel intensity: Sets the bump structure’s intensity.
For further information on the Displacement, Raytracing, Incandescence, Common

and Transparency settings please refer to the “General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.16 Multi Pass

The Multi Pass material allows to layer TrueLight materials. The first material in the
list is the first rendered and the following shaders are rendered according to their
position in list from top to bottom.

» Sort key Sets the render priority of the Multi Pass material. Only supported in
OpenGL mode.
» Transparency mode Offers three different transparency modes.

» Auto Detection: Set automatically the material order according to their trans-
parency.

» Force Transparent: Draws all transparent materials at last so that all transparent
materials in the stack lays about the opaque materials.

» Force Opaque: Draws all opaque materials at last so that all opaque materials
in the stack lays about the transparent materials.

263



7 MATERIALS REFERENCE

7.1.17 Phong

The Phong material uses the Phong illumination algorithm which is an empirical
model of local illumination. It describes the way a surface reflects light as a com-
bination of the diffuse reflection of rough surfaces with the glossy reflection of shiny
surfaces. It is based on the fact that shiny surfaces have small intense glossy high-
lights, while dull surfaces have large highlights that fall off more gradually.

» Phong Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the colour the
shader adopts, when light reflections of the surface are spread to many direc-
tions.

» Glossy Color: Sets the shader’s colour for glossy reflections. Glossy reflections
result from irregularities of a surface at a microscopic level. Reflection behavior
is described by the law of reflection which states that the direction of incoming
light (incident ray) and the direction of outgoing light reflected (reflected ray)
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form the same angle with respect to the surface normal, thus the angle of
incidence equals the angle of reflection. Since a surface is usually not perfectly
smooth, the orientation of the normals varies, thus creating a glossy reflection.

» Roughness: The roughness parameter defines the microscopic roughness of a
surface. The higher the roughness value, the more diffuse the glossy reflections
will be rendered.

» Diffuse Backscattering: Defines the roughness of the material’s diffuse compo-
nent. A value of 0.0 means smooth (Lambertian surface), a value of 1.0 means
very rough (e.g. concrete).

» Diffuse Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Use Alpha: Uses an alpha channel of the image texture if it has an alpha
channel embedded.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirror: Repeats and mirrors the texture on the x- and y-axis with every
repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture will be repeated.
e Repeat UV: Sets the number of repetitions for the UVs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Input Gamma: Sets the texture image gamma correction.
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e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sSRGB.

» Glossy Texture

» Use Texture: Loads an image texture for the glossy color channel. Uses the
image as a pattern on the surfaces.

e Repeat mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture.
e Repeat UV: Sets the number of repetitions for the UVs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. Value 1 is
lowest quality. Value 16 is highest quality.

e Input gamma: Sets the texture image gamma correction.

e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in SRGB.

» Roughness Texture Use a roughness texture for varying roughness values on the
surfaces. If a roughness texture is active the simple roughness slider loses its
function. Instead you define how the texture values are mapped to roughness
values via @ minimum and a maximum roughness value.

266



» Use Texture: Activates the roughness texture settings. Load an image texture
for the roughness channel. Using a greyscale image is recommended, for color
images the red channel is used.

e Repeat mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture.
e Repeat UV: Sets the number of repetitions for the UVs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. Value 1 is
lowest quality. Value 16 is highest quality.

e Minimum Roughness: Defines the roughness value to which a texture
value of 0 is mapped.

e Maximum Roughness: Defines the roughness value to which a texture
value of 1 is mapped.
» Bump Texture
» Use Structure: Activates a procedural bump structure.

» Use Texture: Activates the bump texture settings. Loads an image texture for
the bump channel. Uses the loaded image as a pattern on the surfaces.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions.
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- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture.
Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.

Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. Value 1 is
lowest quality. Value 16 is highest quality.

Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

Structure Size: Sets the structure size when the procedural bump structure
is activated.

Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the "General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.18 Plastic

The Plastic material is designed to simulate diffuse plastic or leather surfaces.

» Plastic Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.
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Glossy Color: Sets the shader’s colour for glossy reflections. Glossy reflections
result from irregularities of a surface at a microscopic level. Reflection behavior
is described by the law of reflection which states that the direction of incoming
light (incident ray) and the direction of outgoing light reflected (reflected ray)
form the same angle with respect to the surface normal, thus the angle of
incidence equals the angle of reflection. Since a surface is usually not perfectly
smooth, the orientation of the normals varies, thus creating a glossy reflection.

» Roughness: The roughness parameter defines the microscopic roughness of a
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surface. The higher the roughness value, the more diffuse the glossy reflections
will be rendered.

» Reflectivity: Sets the clearcoat reflection intensity.

» Diffuse Texture Settings

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

» Use alpha: Uses the transparency information from the texture.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link repeat modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Input Gamma: Sets the texture image gamma correction.

e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in SRGB.

» Glossy Texture Settings
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» Use Texture: Loads an image texture for the glossy color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link repeat modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Repeat UV: Sets the number of repetitions for the Uvs.
o Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is the
lowest quality. 16 is the highest quality.

e Input Gamma: Sets the texture image gamma correction.

e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in SRGB.

» Roughness Texture Settings

» Use Texture: Loads an image texture for the roughness channel. Uses the image
as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.
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- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link repeat modes: Links the values to each other. When changing one
value, the other one adapts it.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Minimum Roughness: Sets the minimum roughness which is determined
by the red color channel of the roughness texture.

e Maximum Roughness: Sets the maximum roughness which is determined
by the red color channel of the roughness texture.

» Bump Texture Settings

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link repeat modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.
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e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the “General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.19 Reflective Plastic

The Reflective Plastic is suitable to simulate shiny or glossy plastic surfaces that are
finished with a clearcoat.

» Reflective Plastic Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.

» Specular Color: Sets the shader’s color for specular reflections. Specular reflec-
tions result from completely smooth surfaces and are described by the law of
reflection which states that the direction of incoming light (incident ray) and the
direction of outgoing light reflected (reflected ray) form the same angle with
respect to the surface normal, thus the angle of incidence equals the angle of
reflection.

» Reflectivity: Sets the specular reflection intensity when the surface normal is
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directly facing the viewer. The intensity of the reflection increases based on
the fresnel term when the angle between the viewer and the surface normal
increases.

» Fresnel Term Quality: The Fresnel Term describes the intensity of a reflection
based on the viewing angle. Its intensity at normal incidence is set by the
material’s reflectivity.

Fast: Uses a fast but less accurate approximation to the Fresnel Term.

Accurate: Uses a physically accurate evaluation of the Fresnel Term.

» Diffuse Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

Input Gamma: Sets the texture image gamma correction.
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e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sSRGB.

» Specular Texture

» Use Texture: Loads an image texture for the specular color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.
e Input Gamma: Sets the texture image gamma correction.

e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sSRGB.

» Bump Texture

» Use Texture: Loads an image texture for the bump channel. Uses the image as
pattern on the surfaces.
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e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Affects Specular Reflections: Allows the bump texture to affect the
specular reflections.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the “General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.20 Reflective Triplanar

A TrueLight Reflective Triplanar material simulates shiny and glossy plastic and com-
parable surfaces while offering a special triplanar texturing mode for objects that do
not have an appropriate UV mapping. All surfaces finished with a clearcoat can be
perfectly visualized with this shader.

» Reflective Triplanar Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.

» Specular Color: Sets the shader’s color for specular reflections. Specular reflec-
tions result from completely smooth surfaces and are described by the law of
reflection which states that the direction of incoming light (incident ray) and the
direction of outgoing light reflected (reflected ray) form the same angle with
respect to the surface normal, thus the angle of incidence equals the angle of
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reflection.

» Reflectivity: Sets the specular reflection intensity when the surface normal is
directly facing the viewer. The intensity of the reflection increases based on
the fresnel term when the angle between the viewer and the surface normal
increases.

» Fresnel Term Quality: The Fresnel Term describes the intensity of a reflection
based on the viewing angle. Its intensity at normal incidence is set by the
material’s reflectivity.

e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.
» Triplanar Settings Triplanar settings define how a texture will be placed on the
surface and how the planar projection will be blended at the edges.

)

Edge blend: Sets the range for overlapping areas of the planar projection.

)

\/

Texture Size X, Y: Defines the textures size on the X-/Y-axis.

)

Uniform Repeat: Synchronizes the repetition value for all projection axes.

X Repeat U, X/V, Y/U, Y/, Z/U, Z/V: Set the repetition value of the U and V-axis
for each projection direction.

X Offset U, X/V, Y/U, Y/V, Z/U, Z/V: Set the offset value of the U and V-axis for
each projection direction.

)

v

P

\/

)

X/Y/Z Rotate: Sets the projection orientation.

» Diffuse Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.
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- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Input Gamma: Sets the texture image gamma correction.

e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sSRGB.

» Specular Texture

» Use Texture: Loads an image texture for the specular color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Input Gamma: Sets the texture image gamma correction.
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e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sRGB.

» Bump Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Bump Affects Specular Reflections: Allows the bump texture to affect the
specular reflections.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the “General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.21 Shadow

The Shadow material is a transparent material by default. It will only be shaded
in areas of pre-calculated ambient occlusion shadows, shadows calculated by linear
lights sources or global illumination light sources. It is also capable of receiving diffuse
and glossy reflections to simulate wet or mirroring surfaces.

» Shadow Material Settings Define the color and intensity of the shaded areas.

» Occlusion Color: Sets the color of the pre-calculated ambient occlusion or en-
vironment shadows.

» Occlusion Color: Sets the intensity of the pre-calculated ambient occlusion or
environment shadows.

» Shadow Color: Sets the shadow color of all light sources.
» Opacity Mode Settings:

e Transparent: Renders the Shadow transparent by default.
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e Solid: Renders the Shadow white by default.

» Sort key: Sets the render priority of the Shadow. Only supported in OpenGL
mode.

Reflection Settings:
» Reflection Mode: Offers three different reflection modes:
e Diffuse only: Shows only the diffuse reflections.
e Glossy only: Shows only the glossy reflections.
e Diffuse + Glossy: Shows the diffuse and glossy reflections.

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader takes on, when the light reflection of the surface is spread to many
directions.

» Glossy Color: Sets the shader’s colour for glossy reflections.

Glossy reflections result from irregularities of a surface at a microscopic level.
Reflection behavior is described by the law of reflection which states that the
direction of incoming light (incident ray) and the direction of outgoing light re-
flected (reflected ray) form the same angle with respect to the surface normal,
thus the angle of incidence equals the angle of reflection. Since a surface is usu-
ally not perfectly smooth, the orientation of the normals varies, thus creating
a glossy reflection.

P

v

Reflectivity: Sets the material’s reflectivity intensity.

» Roughness: The roughness parameter defines the amount of diffuse reflection
and its complement specular reflection. The higher the roughness value, the
more diffuse reflections will be rendered

For further information on the Raytracing settings please refer to the “General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.22 Skylight

A Skylight can be used as environment for lighting the scene by a sun and a sky.
Skylights are procedurally generated Sphere Environment materials.

» Preview Image The Skylight provides an interactive preview image that allows
you to quickly change the sun position. The yellow curve within the preview
image depicts the sun path from sunrise to sunset at the currently set date and
location. You can set the sun position represented by a circle by clicking on the
sun path. The preview image includes labels of the four cardinal directions (N =
North, E = East, S = South, W = West). If the current location is on the nothern
hemisphere, ‘South’ is the centered direction; for locations on the southern
hemisphere "North’ is the centered direction.

» Skylight Material Settings

» Resolution: Sets the resolution of the procedural environment texture. A higher
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»

»

»

»

»

quality yields higher generation times for the environment but might be neces-
sary in precomputed illumination mode with animated sun.

Flip Inside Out: Flips the normals of the object this material is assigned to.

Emit Caustics; Activates/deactivates Emit Caustics. Allows the HDR to emit
caustics. Only supported in FullGl illumination mode with caustics.

Is Visible: Sets the light source to on by default.

Use as Lightsource: Uses the HDR as light source. Only supported in FullGl
illumination mode.

Use as Default Environment: Selects current environment as default for newly
created TruelLight materials (see materials’ Common Settings).

Show Compass: Displays a compass in the render window for the currently se-
lected skylight material. The compass is positioned at the environment'’s center
and oriented according to the environment rotation (see Transformation).

» Sky and Sun

)

v

)

)

v

»

»

Sky Model: Choose between two different sky models: ‘Realistic’ and "Artistic’.
The artistic sky model produces more reddish and colorful skies, especially for
sunrise/sunsets.

Exposure: Sets the HDR-Image's exposure level. The higher the exposure level,
the longer will be the series of shutter cycles which will be used to calculate
the image’s light intensity.

Sky Turbidity: Controls the amount of haze in the atmosphere. Low values
correspond to a clear sky. The default value of 3.0 is a clear sky in a temperate
climate. The maximum value of 10.0 yields a hazy sky.

Sun Scale: Controls the size of the sun. The default value 1.0 corresponds to
the real size of the sun, seen from the earth. The sun is drawn as a filled circle
within the sky environment. Increase the sun scale to get softer shadows with
ray tracing.

Sun Visible in Specular Reflections: Defines whether the sun of this skylight
material is visible in all specular reflections in the scene, e.g. on clear coat.
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» Use Mirrored Sky as Ground: The mirrored upper hemisphere (sky without sun)
is used as lower hemisphere (ground).

» Ground Color: Sets the color for the single-colored ground in the lower hemi-
sphere if "Use Mirrored Sky as Ground’ is not enabled. Note: When using the
‘Realistic” sky model, the ground color serves as a ground albedo which influ-
ences the tint of the sky.

» Date and Time

» Date: The date determines the sun path. The sun position is computed from
Local Time, Date and Location. The "Today’ button sets the date to the current
operation system date.

» Local Time: Controls the sun position at the current date. The sun position is
computed from Local Time, Date and Location. The "Now' button sets the date
to the current operation system local time.

» Location

p)

v

Longitude/Latitude: Sets the location to these geographic coordinates in deci-
mal degrees.

)

x

Time Zone: The time zone is expressed as time difference to UTC (Coordinated
Universal Time). It is automatically estimated from the given geographic coor-
dinates.

)

v

DST: Enables/disables daylight saving time. Please specify whether there is day-
light saving time at the current location on the current date because this infor-
mation is not retrieved automatically.

)

v

Closest City: The City (Country) information names the city that is closest to the
given geographic coordinates. The current time zone is this city’s time zone.

v

Location Search: Retrieve longitude/latitude data from a database of over 22,000
cities. You may also enter a country name and choose a city from the popup
list.

» Color Correction
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»

»

»

»

»

Whitebalance: Sets the whitepoint value in kelvin.

Hue-Shift: Shifts all colors in the HDR-Image uniformly through the hue color
range.

Contrast: Separates the light and dark color values further from each other.
Brightness: Raises the color value of the whole HDR-Image.
Saturation: Sets the HDR-Image's saturation.

Reflected Saturation: Sets the HDR-Image's saturation for reflections of the
HDR-Image in any surface.

» Transformation With transformation parameters the source of spherical projec-

»

»

»

»

»

tion of the Skylight can be set.

Environment Size: Sets the radius of the projection sphere. The projection
sphere must enclose all objects using a material having this Skylight as envi-
ronment shader assigned. All objects that are outside of the projection sphere
using a Truelight Material with this Skylight as input channel, will not be ren-
dered properly.

Center: Defines the projection sphere’s center position.

Get from Object: Sets the projection sphere’s center. To center the projec-
tion pivot automatically, select an object and press “Get Center”. The selected
object’s center will now be used as projection sphere’s pivot.

Rotate X, Y, Z: Sets the Skylight’s orientation.

Scale X, Y, Z: Sets the Skylight's size. With the scale value the image projection
can be stretched and squashed on any axis.

» Raytracing Settings These settings take effect in Raytracing Mode only.

»

»

Material ID: Sets the id of the material.

lllumination:
e Upper Hemisphere: Emits light only from the top half of the sphere.
e Full Sphere: Emits light from the whole sphere.
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e Override IBL Sampling Quality: If enabled, the setting overrides the global
IBL Sampling quality for sampling the environment map.
- Interactive Quality: Sets the IBL sampling quality during interactive ren-
dering.
- Still Frame Quality: Sets the IBL sampling quality during Still Frame ren-
dering.
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7.1 Truelight Materials

7.1.23 Sphere Environment

Environments enable to add realistic reflections and lightsources to the scene. Sphere
Environments are required by every Truelight Material. They deliver the precomputed
image based lighting (IBL) for any Truelight Material they are assigned to. The lighting
of a Truelight Material can be adjusted with the settings of the Sphere Environment.
Each Sphere Environment can be assigned as an input node of each Truelight Material
in the Material Editor (see General Truelight Material Settings » Common » Environ-
ment). The Sphere Environment is a single sided shader in OpenGL rendering mode.

» Sphere Environment Material Settings

» Environment: Loads the HDR image to be used as light source. The HDR image
will also be used as environment, which will be reflected on reflective surfaces
in OpenGL rendering. In raytraced rendering the 3D space will be reflected in
the surfaces.

» Create Light Sources: Creates light sources according to light spots in the HDR-
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»

»

»

»

Image. The light sources will be positioned inside the projection sphere of the
Sphere Environment Material. They will be orientated to its center position.
The light sources will be created based on the HDR image examination. The
brightest pixel’s intensity, color, orientation and position are evaluated to create
new light sources.

Flip Inside Out: Flips the normals of the Environment Sphere.

Emit Caustics: Activates/deactivates Emit Caustics. Allows the HDR to emit
caustics. Only supported in FullGl illumination mode with caustics.

Is Visible: Sets the light source to on by default.

Use as Lightsource: Uses the HDR als light source. Only supported in FullGl
illumination mode.

Use as Default Environment: Selects current environment as default for newly
created TrueLight materials (see materials’ Common Settings).

» HDR Light Studio The HDR image of a Sphere Environment can be interactively
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created using HDR Light Studio by Lightmap LTD. This part of the GUI will be
only visible if a demo or full version of HDR Light Studio is detected by VRED
on startup.

Edit & Load Settings: Opens HDR Light Studio and tries to load a project that
has been saved for this material. If no project has been previously saved for
this material you will start with a blank canvas. Please note, that the current
HDR image will be replaced. All changes made on the HDR Light Studio can-
vas are immediately applied to the HDR image of the connected VRED Sphere
Environment.

Save Settings: Internally saves the HDR Light Studio project for the Sphere
Environment that you are currently editing.

LightPaint: This feature is available since HDR Light Studio version 4.0. The
integration of LightPaint within VRED allows you to directly click in the VRED
render window to position your light sources in the HDR image such that, for
example, the current light source will reflect in that position. Please refer to



the HDR Light Studio manual for detailed information on the different painting
modes. Choosing one of the three painting modes activates the paint tool in
the VRED render window. Hold SHIFT and left-click in the scene to place the
light source that is currently selected in the HDR Light Studio canvas. Hold
SHIFT and right-click in the scene to select a light source. The active painting
mode will be used to determine the light node in the HDR map.

» Color Correction

»

»

»

»

»

»

»

»

»

Exposure: Sets the HDR-Image's exposure level. The higher the exposure level,
the longer will be the series of shutter cycles which will be used to calculate
the image’s light intensity.

Whitepoint: Defines the exact value between displaying white color and light-
emissive image data.

Whitebalance: Sets the whitepoint value in kelvin.

Gamma: Encodes the linear luminance values into digital image file values.
Gamma encoding helps to map data (both analog and digital) into a more
perceptually uniform domain.

Hue-Shift: Shifts all colors in the HDR-Image uniformly through the hue color
range.

Contrast: Separates the light and dark color values further from each other.
Brightness: Raises the color value of the whole HDR-Image.
Saturation: Sets the HDR-Image's saturation.

Reflected Saturation: Sets the HDR-Image's saturation when the HDR-Image
reflects in any surface.

» Transformation With transformation parameters the source of spherical projec-

»

tion of the Sphere Environment Material can be set.

Environment Size: Sets the radius of the Sphere Environment Material’s pro-
jection sphere. The projection sphere must enclose all objects using a material
having this Sphere Environment Material as environment shader assigned. All
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objects that are outside of the projection sphere using a Truelight Material with
this Sphere Environment Material as input channel, will not be rendered prop-
erly.

)

v

Center X, Y, Z: Defines the projection sphere’s center position.

)

v

Get from Object: Sets the projection sphere’s center. To center the projec-
tion pivot automatically, select an object and press “Get Center”. The selected
object’s center will now be used as projection sphere’s pivot.

)

v

Rotate X, Y, Z: Sets the Spher eEnvironment Material’s orientation.

P
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Scale X, Y, Z: Sets the Sphere Environment Material’s size. With the scale value
the image projection can be stretched and squashed on any axis.

» Raytracing Settings These settings take effect in Raytracing Mode only.
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» Material ID: Sets the id of the material.

» lllumination:
e Upper Hemisphere: Emits light only from the top half of the sphere.
e Full Sphere: Emits light from the whole sphere.

e Override IBL Sampling Quality: If enabled, the setting overrides the global
IBL Sampling quality for sampling the environment map.

- Interactive Quality: Sets the IBL sampling quality during interactive ren-
dering.

- Still Frame Quiality: Sets the IBL sampling quality during Still Frame ren-
dering.



7.1 Truelight Materials

7.1.24 Switch

The Switch is a bin shader, in which TrueLight Materials can be stored and selectively
addressed.

» Choice Sets the material’s ID to be used. By dragging and dropping materials onto
a Switch in the Materials View or with the Material Editor's copy and paste
function Truelight Materials can be added to the Switch.
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7.1.25 Tire

The Tire material allows you to quickly texture tires and give them a rubber shading.

» Tire Material Settings

» Diffuse Color: Sets the shaders diffuse reflection color. This is the color the
shader takes on, when the light reflection of the surface is spread to many
directions.

» Glossy Color: Sets the shader’s colour for glossy reflections. Glossy reflection
behavior is described by the law of reflection which states that the direction
of incoming light (incident ray) and the direction of outgoing light reflected
(reflected ray) form the same angle with respect to the surface normal, thus
the angle of incidence equals the angle of reflection.

Roughness: The roughness parameter defines the microscopic roughness of a
surface. The higher the roughness value, the more diffuse the glossy reflections
will be rendered.
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» Reflectivity: Sets the material’s reflectivity intensity.

» Diffuse Texture

» Use Marking: Loads an image texture to be applied to the tire’s sides for the
diffuse color channel. The image will be used as a pattern on the surface’s
sides.

» Use Profile: Loads an image texture to be applied as the tire's profile for the
diffuse color channel. The image will be used as a pattern on the surface’s
middle.

» Input Gamma: Sets the texture image gamma correction.

» Use ICC Profile: If turned on, the texture’s colors will be interpreted based on
an embedded color profile if present. If a color profile is missing, it is assumed
that the colors are stored in SRGB.

» Glossy Texture

» Use Marking: Loads an image texture to be applied to the tire’s sides for the
glossy channel. The image will be used as a glossy pattern on the surface’s
sides.

» Use Profile: Loads an image texture which will be applied as the tire’s profile
for the glossy channel. The image will be used as a pattern on the surface’s
middle.

» Input Gamma: Sets the texture image gamma correction.

» Use ICC Profile: If turned on, the texture’s colors will be interpreted based on
an embedded color profile if present. If a color profile is missing, it is assumed
that the colors are stored in sRGB.

» Bump Texture

» Use Marking: Loads an image texture to be applied to the tire’s sides for the
bump structure. The image will be used as a bump pattern on the surface’s
sides.

295



»

»

»

Use Profile: Loads an image texture which will be applied as the tire's profile

for the bump structure. The image will be used as a pattern on the surface’s

middle.
Bump Intensity: Sets the bump intensity interpretation of the bump image tex-

ture.

Parallax Intensity: Sets the parallax shift interpretation of the bump image tex-

ture.

» Texture Settings Sets the texture projection position of the used textures.

»

»

»

)

v

P

v

p)

4

Rotation Axis: Select the rotation axis.

Center: Sets the brush projection center. To center the projection pivot auto-
matically, select an object and press “Get From Object”. The selected object’s
center will now be used as projection pivot.

Repeat Profile U/V: Sets the U and v repetition of the profile texture.
Scale Markings: Sets the texture’s scale value for the marking texture.
Blend Position: Sets the marking and profile texture blendposition.

Anisotropy: Sets the texture filter quality for the image texture. Value 1 is
lowest quality. Value 16 is highest quality.

For further information on the Displacement, Raytracing, Incandescence, Common
and Transparency settings please refer to the "General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.26 Triplanar

The TrueLight Triplanar material simulates diffuse plastic or leather surfaces while
offering a special triplanar texturing mode for objects that do not have an appropriate
UV mapping. With the bump and texture channel many diffuse surface structures can
be simulated.

» Triplanar Material

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.

» Glossy Color: Sets the shader’s colour for glossy reflections. Glossy reflections
result from irregularities of a surface at a microscopic level. Reflection behavior
is described by the law of reflection which states that the direction of incoming
light (incident ray) and the direction of outgoing light reflected (reflected ray)
form the same angle with respect to the surface normal, thus the angle of
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incidence equals the angle of reflection. Since a surface is usually not perfectly
smooth, the orientation of the normals varies, thus creating a glossy reflection.

» Roughness: The roughness parameter defines the microscopic roughness of a
surface. The higher the roughness value, the more diffuse the glossy reflections
will be rendered.

» Reflectivity: Sets the clearcoat reflection intensity.
» Triplanar Settings Triplanar settings define how a texture will be placed on the
surface and how the planar projection will be blended at the edges.

» Edge blend: Sets the range for overlapping areas of the planar projection.

v

» Texture Size X, Y: Defines the textures size on the X-/Y-axis.

4

Uniform Repeat: Synchronizes the repetition value for all projection axes.
X Repeat U, XV, Y/U, Y/, Z/U, Z/V: Set the repetition value of the U and V-axis
for each projection direction.

X Offset U, X/V, Y/U, Y/V, Z/U, Z/V: Set the offset value of the U and V-axis for
each projection direction.

v
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X/Y/Z Rotate: Sets the projection orientation.

» Diffuse Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture will be repeated.
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Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

Input Gamma: Sets the texture image gamma correction.

Use ICC Profile: If turned on, the texture’s colors will be interpreted based

on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in SRGB.

» Glossy Texture

» Use Texture: Loads an image texture for the glossy color channel. Uses the
image as pattern on the surfaces.

Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

Input Gamma: Sets the texture image gamma correction.

Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in SRGB.
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» Roughness Texture The Roughness texture allows you to control the material’s
roughness. If the roughness texture is enabled the default roughness slider
loses his functionality. Instead, you can define a minimum and maximum
roughness. The minimum roughness defines the roughness value that is mapped
to the value O of the texture image. The maximum roughness defines the
roughness value that is mapped to the value 1 of the texture image. For
Isotropic materials the red color channel will be interpreted. This allows the
usage of a grayscale image. For anisotropic materials the red color channel will
be used for the roughness in U and the green color channel for the roughness
in V.

P

v

Use Texture: Loads an image texture for the bump color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Minimum Roughtness: Defines the roughness value that is mapped to the
value 0.

e Maximum Roughness: Defines the roughness value that is mapped to the
value 1.

» Bump Texture
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» Use Texture: Loads an image texture for the bump color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the “General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.27 Unicolor Paint

The Unicolor Paint offers a shading model suited for unicolor painted surfaces.

» Unicolor Carpaint Material
» Base Color: Sets the diffuse reflection color of the Unicolor Paint. The shader
adopts this color, when the surface is globally lit.
» Clearcoat Settings Sets the clearcoat color. The clearcoatis a transparent, strongly
reflective paint layer on the base paint layer.
» Clearcoat color: Sets the clearcoat color.
» Reflectivity: Sets the clearcoat reflective intensity.

» Fresnel Term Quality: The Fresnel Term describes the intensity of a reflection
based on the viewing angle. Its intensity at normal incidence is set by the
material’s reflectivity.
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e Fast: Uses a fast but less accurate approximation to the Fresnel Term.
e Accurate: Uses a physically accurate evaluation of the Fresnel Term.
» Use Orange peel: Activates a noisy bump structure in the shader.
e Orange Peel Frequency: Sets the bump structure’s noise frequency.
e Orange Peel Intensity: Sets the bump structure’s intensity.
For further information on the Displacement, Raytracing, Incandescence, Common

and Transparency settings please refer to the “General Truelight Material Settings”
section at the beginning of the chapter.
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7.1.28 Velvet

The Velvet material imitates the behavior of a velvet or satin-like material.

» Velvet Material Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.

» Glossy Color: Sets the shader’s color for glossy reflections. Its appearance is
controlled by the falloff parameter.

» Darkening: Controls the appearance of the diffuse component. A darkening
value of 1.0 corresponds to a perfectly diffuse surface. Higher values than 1.0
darken the material, lower values brighten it up.

» Falloff: Controls the glossy component, which is depending on the viewing
angle and affecting the edges of the objects.
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» Diffuse Texture

» Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

Use Alpha: Uses the alpha channel of the image texture if it has an alpha
channel embedded.

Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat] Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

Input Gamma: Sets the texture image gamma correction.

Use ICC Profile: If turned on, the texture’s colors will be interpreted based

on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in sSRGB.

» Glossy Texture

» Use Texture: Loads an image texture for the glossy color channel. Uses the
image as pattern on the surfaces.
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Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

Repeat: Repeats the texture in all directions.

Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis with
every repetition.

Decal: The texture will not be repeated.

Clamp: Repeats only the last pixel of the texture will be repeated.

p)

T

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for the
u-coordinates.

v

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

p)

4

v
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4

Anisotropy: Sets the texture filter quality for the image texture. 1 is the lowest
quality. 16 is the highest quality.

v

Input Gamma: Sets the texture image gamma correction.

p)

T

Use ICC Profile: If turned on, the texture’s colors will be interpreted based on
an embedded color profile if present. If a color profile is missing, it is assumed
that the colors are stored in SRGB.

» Bump Texture
» Use Structure: Activates a procedural bump structure.

» Use Texture: Loads an image texture for bump mapping.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.
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- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Repeat UV: Sets the number of repetitions for the Uvs.
e Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the “General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.1.29 Woven Cloth

The Woven Cloth material imitates the behavior of a woven material and its weaving
patterns by a procedural bidirectional texture function (BTF).

» Woven Cloth Settings

» Diffuse Color: Sets the shader’s diffuse reflection color. This is the color the
shader adopts when the light reflection of the surface is spread to many direc-
tions.

» Darkening: Controls the appearance of the diffuse component. A darkening
value of 1.0 corresponds to a perfectly diffuse surface. Higher values than 1.0
darken the material, lower values brighten it up.

» Warp Yarn Color: Sets the color of the vertical (warp) yarn. It is best practice
to use similar colors for warp and weft yarn.

» Weft Yarn Color: Sets the color of the horizontal (weft) yarn. It is best practice
to use similar colors for warp and weft yarn.
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Cloth Presets: Choose from a variety of handpicked material presets. These
presets are also available in the VRED Basic Material Library.

Weaving Pattern: The weaving pattern defines how the yarn was woven to
cloth.

Yarn Type: Defines the glossiness of the yarn.

e Staple Yarn: Staple Yarn simulates yarn that is made up of many tiny
threads. Use this type for rough types of clothes such as denim.

e Filament Yarn: Filament Yarn simulates yarn that is made up of one single
untwisted, virtual yarn. Use this type for shiny types of clothes such as silk.

Yarn Twist Angle: The yarn twist angle determines the glossiness of the yarn
and is dependant on the choice made in the yarn type.

Highlight Width: Defines the ‘width" of the glossy highlight on the yarn seg-
ments.

Exposure: Defines the brightness of the glossy component.

Noise Intensity: Sets a natural noise effect for matt surfaces (staple yarn is
recommended).

Moiré Removal: The higher the value, the more effective the moiré pattern is
being softened. If too high, any structure will be softened and surface infor-
mation might get lost.

Advanced Yarn Settings: Allows to define the curvature for weft and warp yarn.

» Procedural Weaving Texture The procedural BTF is highly dependent on how

»

the weaving pattern is mapped onto the object’s surface. The texture mapping
controls size and direction of the yarn and therefore its reflection behaviour.

Texture Mode: Sets the texture projection mode.
e UV Coordinates: Uses the UV information for the texture projection.

e Triplanar: Activates the triplanar projection mode regardless of UV infor-
mation.
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Pattern Repeat: When the texture mode is set to UV Coordinates’, 'Pattern
Repeat’ defines the amount of repetitions of the texture along the UVs.

Pattern Rotate: When the texture mode is set to "UV Coordinates’, 'Pattern
Rotate’ defines rotation angle of the texture along the UVs.

Texture Size X/Y: When set to triplanar projection mode, this value allows to
scale the weaving pattern in mm.

Uniform Repeat: Fills the same value into all 'X/Y/Z Repeat’ fields.
X/Y/Z Repeat UV: Allows to change the repetition rate for all projection axes.

X/Y/Z Rotate: Allows to change the rotation angle for all projection axes.

» Diffuse Texture

»
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Use Texture: Loads an image texture for the diffuse color channel. Uses the
image as pattern on the surfaces.

e Repeat Mode UV: Sets the repeat mode of the texture. There are four
modes, which can be set:

- Repeat: Repeats the texture in all directions.

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.

- Clamp: Repeats only the last pixel of the texture will be repeated.

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.



e Input Gamma: Sets the texture image gamma correction.

e Use ICC Profile: If turned on, the texture’s colors will be interpreted based
on an embedded color profile if present. If a color profile is missing, it is
assumed that the colors are stored in SRGB.

» Yarn Texture Loads an image texture for the yarn. Uses the image as pattern on
the surfaces.

Repeat Mode UV: Sets the repeat mode of the texture. There are four modes,
which can be set:

)

\/

e Repeat: Repeats the texture in all directions. Repeat

e Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis with
every repetition.

e Decal: The texture will not be repeated.
e Clamp: Repeats only the last pixel of the texture will be repeated.

Link Repeat Modes: Uses the same repeat mode for v-coordinates as for the
u-coordinates.

)

v

)

v

Repeat UV: Sets the number of repetitions for the Uvs.
Offset UV: Sets the offset for the UVs.
Rotate: Rotates the UVs.

Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

P

\/
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Input Gamma: Sets the texture image gamma correction.

Use ICC Profile: If turned on, the texture’s colors will be interpreted based on
an embedded color profile if present. If a color profile is missing, it is assumed
that the colors are stored in SRGB.

)

v

» Bump Texture

» Use Structure: Activates a procedural bump structure.
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» Use Texture: Uses an image texture for bump mapping.

e Repeat Mode: Sets the repeat mode of the texture. There are four modes,
which can be set:

- Repeat: Repeats the texture in all directions. Repeat

- Mirrored Repeat: Repeats and mirrors the texture on the x- and y-axis
with every repetition.

- Decal: The texture will not be repeated.
- Clamp: Repeats only the last pixel of the texture will be repeated.

e Link Repeat Modes: Uses the same repeat mode for v-coordinates as for
the u-coordinates.

e Repeat UV: Sets the number of repetitions for the Uvs.
o Offset UV: Sets the offset for the UVs.
e Rotate: Rotates the UVs.

e Anisotropy: Sets the texture filter quality for the image texture. 1 is lowest
quality. 16 is highest quality.

e Parallax Intensity: Sets the parallax shift interpretation of the bump image
texture.

e Bump Intensity: Sets the bump intensity interpretation of the bump image
texture.

e Structure Size: Sets the structure size when the procedural bump structure
is activated.

e Bump Type: Sets the bump type. The bump mapping can be drawn as
bump map or as pixel displacement map wihout selfshadowing.

For further information on the Subsurface Scattering, Displacement, Raytracing, In-
candescence, Common and Transparency settings please refer to the "General Tru-
elight Material Settings” section at the beginning of the chapter.
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7.2 OpenGL Materials

7.2.1 Simple

Creates a simple shading model, which does not support HDRI lighting. It is only
visible when it is lit by standard light sources.

» Ambient Sets the Simple material’s ambient light reflection color.

» Diffuse Sets the shader’s diffuse reflection color. This is the color the shader
adopts, when the light reflection of the surface is spread to many directions.

» Specular Sets the shader’s color for specular reflection. Specular reflection be-
havior is described by the law of reflection which states that the direction of
incoming light (incident ray) and the direction of outgoing light reflected (re-
flected ray) form the same angle with respect to the surface normal, thus the
angle of incidence equals the angle of reflection.
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7 MATERIALS REFERENCE

» Emission Sets the shader’s illumination color and intensity.

» Shininess Sets the surface’s specular spread.

» Transparent Sets the surface’s transparency.

» ColorMat Sets which material’s characteristics influences the color.

» Sort key Sets the time for rendering. This function is important for transparent
materials that are arranged on top of each other. It automatically sets a material
to be transparent or opaque or forces it to be either of them.

» Lit Sets a material to be lit or not.

» Transparency mode Offers a total of three transparency modes. It sets a material
to be transparent or opaque.
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7.2.2 Phong

The Phong material has a simple phong shading model, which does not support any
HDRI lighting. The simple material is only visible, when it is light by standard light
sources.

» Ambient Sets the Phong’s ambient light reflection color.

» Diffuse Sets the shader’s diffuse reflection color. This is the color the shader
adopts, when the light reflection of the surface is spread to many directions.

» Transparent Sets the surface’s transparency.

» Specular Sets the shader’s color for specular reflection. Specular reflection be-
havior is described by the law of reflection which states that the direction of
incoming light (incident ray) and the direction of outgoing light reflected (re-
flected ray) form the same angle with respect to the surface normal, thus the
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7 MATERIALS REFERENCE

angle of incidence equals the angle of reflection.
» Emission Sets the shader’s illumination color and intensity.
» Shininess Sets the surface’s specular spread.
» Color Mat Sets which material’s characteristics influences the color.

» Sort key Sets the time for rendering. This function is important for transparent
materials that are arranged on top of each other. It automatically sets a material
to be transparent or opaque or forces it to be either of them.

» Lit Sets a material to be lit or not.

» Transparency mode Offers a total of three transparency modes. It sets a material
to be transparent or opaque.
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7.2.3 Chunk

Creates a Chunk material node. The Chunk material node is an empty material bin
node, which can be customized by adding additional chunk attributes.

» Sort key Sets the time for rendering. This function is important for transparent
materials that are arranged on top of each other. It automatically sets a material
to be transparent or opaque or forces it to be either of them.

» Transparency mode Offers a total of three transparency modes. It sets a material
to be transparent or opaque.

7.2.4 CGFX
Creates a CGFX node. CGFX scripts can be loaded into the CGFX node.

» Effect Loads a CGFX script.

» Technique Defines the technique to be used, e.g. multipass.

7.2.5 Multi Pass

Creates a bin shader, which can layer TrueLight materials. The first material in the
list is the first rendered and the following shaders are rendered according to their
position in list from top to bottom.

» Sort key Sets the render priority of the Multi Pass. Only supported in OpenGL
mode.

» Transparency mode Offers three different transparency modes.

» Auto Detection: Set automatically the material order according to their trans-
parency.
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» Force Transparent: Draws all transparent materials at last so that all transparent
materials in the stack lays about the opaque materials.

» Force Opaque: Draws all opaque materials at last so that all opaque materials
in the stack lays about the transparent materials.

7.2.6 Merge

The Merge material allows to combine different shaders into one single combined
shader.

7.2.7 Switch
Creates a bin shader, in which materials can be stored and selectively addressed.

» Choice Sets the Switch’s ID to be used. By changing the SwitchMaterial’s choice
ID the user can switch the material assignment instantly.
With the Material Editor’s copy and paste function materials can be added.
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